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1.  

Scripting Tools Guide
AppBuilder includes two tools for scripting for increased productivity and a means to create and enforce corporate standards in development
environments. The AppBuilder installation comes with sample scripts for both tools.

This guide describes the AppBuilder Scripting tools and includes the following topics and sections:

Introduction to Scripting Tools
TurboScripter Object's Model Reference
Starting TurboCycler
Using Default Templates
TurboCycler Tutorial
Using TurboCycler Developer Kit
TurboCycler Template Language
TurboCycler Repository Types and Properties
TurboCycler Window Controls
Build Scripts

Introduction to Scripting Tools
AppBuilder includes two tools for scripting for increased productivity and a means to create and enforce corporate standards in development
environments. The AppBuilder installation comes with sample scripts for both tools.

TurboScripter is non-proprietary software based on an industry standard that provides a repository interface that can be accessed from the
AppBuilder Construction Workbench or from third-party tools that use the Component Object Model (COM). TurboScripter can be used from or
integrated with external tools, including Microsoft Office. TurboScripter uses VBScript or JScript to access the properties and methods in
AppBuilder.

TurboCycler is coupled with the AppBuilder repository-based software and uses a proprietary scripting language to manipulate the AppBuilder
repository objects using less lines of code. Its source compiles to a binary file with a very fast compiler. TurboCycler can provide an easy way to
create object hierarchies in the repository. TurboCycler also comes with a number of templates and a Developer's Kit.

TurboScripter Object's Model Reference

TurboScripter is a non-proprietary software program that is based on industry standard. It is an optional tool that provides a mechanism by which
scripts written in VBScript or JavaScript can be used to access the repository, manipulate repository objects, and access other applications, such
as Microsoft Word, that function through automation. TurboScripter provides a scriptable repository interface that can be accessed from the
AppBuilder Construction Workbench or from other tools through the Component Object Model (COM). Tools within the Construction Workbench
have menu options to invoke TurboScripter and pass repository objects to it.
Details of the TurboScripter object model are covered in this section under .TurboScripter Object Reference

Starting and Using TurboScripter

You can use TurboScripter to automate many of the repetitive tasks in the software development lifecycle. TurboScripter uses VBScript or JScript
to access the properties and methods in AppBuilder.
Auto.vbs is an example of a script that counts all the data in the repository. It is written and stored in a directory that TurboScripter can access. To
start auto.vbs, complete the following steps:

Select  .Start > All Programs > AppBuilder > Construction Workbench

          The Construction Workbench window appears.

      2. Type your username and password in the User Name and Password fields and click  .Connect

      3. Click  .Tools > TurboScripter

          The Script Select window appears.

TurboScripter - Script Select Window



 

     4. In the TurboScripter - Script Select window, select the script file that you want to run and click  .OK

     5. An information window appears telling you the count of all date fields in the repository. Click  to close the message window.OK

     6. In the VBScript dialog, type the application-Word or Excel-to display the date fields and their parent views and click  .OK

TurboScripter VBScript window

     7. An information window appears. Click  to close the message window.OK

     8. In the VBScript dialog, type the filename to save the file and click OK.

TurboScripter VBScript file save window.

Tracing Information about a TurboScripter Session

The Trace file name and path are determined by the Registry settings for Trace_File under the TurboScripter Key. You must select a hierarchy
object to make the TurboScript menu item available. The default trace file is  in the AppBuilder\AD\TSCRIPTS directory. The amount ofts.out



information in this file is dependent on the TRACE LEVEL settings in the TurboScripter Options dialog. If you are debugging a script, you can set
the Trace level to DEBUG; however, performance might be affected.

To trace information about a TurboScripter session

1. Click  .Tools > Workbench Options > Script > TurboScripter

    The TurboScripter set of options appears. See .TurboScripter VBScript window

The TurboScripter set of options in the Workbench Options window

     2. Type the Script Directory or click the button to the right of the field to browse for the correct directory.

     3. Type the directory where you want to save the tracing file.

     4. Select the tracing level and click  .OK

     The following trace levels are available:

None = no tracing
Execution = traces errors only
Debug = traces warnings, errors, and function
All = traces what the program is doing

Accessing the Repository Using VBScript or JavaScript

Scripts in TurboScripter access the repository through the Repo object. Repository objects can be queried (for example, Repo.Query("FIELD",
"RETURN_CODE") or created (for example,: Repo.Create("RULE", "TS_SAMPLE") from a Repo object. These repository objects are returned as
TSEnt objects for entities and TSRel objects for Relations.

The Repository Service Manager module, gresvcnt.exe, must be running before you can connect to a Personal Repository or a
Workgroup Repository using TurboScripter.

Accessing the Properties of an Entity or Relation Object



1.  
2.  

3.  

Use  or  to get and set properties of an object. For example, you could use    or GetProperty SetProperty myObj.GetProperty( Name )
   . The property names used in these methods must be valid property names according to the WorkgroupmyRel.SetProperty( Sequence_Number )

Repository model. You can get a list of entities, relations, and their property names by running the sample script Model.vbs that comes with
TurboScripter, or you can use the  notation to access the properties of an object. For example,Object.Property

objName = myObj.Name   , myRel.Sequence_Number = n .

The object and property names might differ from those in this documentation. TurboScripter uses the exact names defined by
the Workgroup Repository.

Invoking Other Scripts from a Currently Executing Script

Call  creates a new script object and initializes it to the current environment. Once this is done, youHost.CreateScript(ScriptFileName, Language)
can pass repository objects to the script by calling  on the new script object. The new script is run by calling the  method.AddInputObject Run

Manipulating or Creating Windows and Controls within the Windows

Use the CoPanel Object to create, update, read, and delete controls within a window. The CoPanel Object exposes the controls and attributes of
the window stored in a panel file. The sample scripts pnl_read.vbs, pnl_crt.vbs demonstrate access panel objects/files.

Accessing Drawing Files in the Repository

VBScripts or JScripts can read the repository objects stored within a drawing file. This is done through the CoDraw object. The sample script
draw.vbs demonstrates how to access an Entity Relationship Diagram (ERD) and retrieve the repository objects within the drawing. The drawing
file is retrieved from the repository and might not reflect uncommitted changes made to that file in the workbench.

Accessing the Repository from VB

You can access the repository from VB or any other tool that supports COM. You must create the TurboHost object either through the
CreateObject method or by declaring a variable of type TurboHost. To declare a variable you first must add the TSATL library to the references for
the VB project. When the TurboHost object has been successfully created, call RepoInit on this object to establish a repository session. This
method returns the Repo object on success. Now, you can create or query objects from the repository and manipulate just as you would from a
script. The sample project VB_TSRepo that comes with TurboScripter in the same directory as the TurboScript sample scripts demonstrates this.

Accessing Repository Objects Passed from the Construction Workbench

You can access the "InputObject" Dictionary object that contains the list of repository objects passed by the Construction Workbench. This
Dictionary has a 0 based index as its key and TSEnt objects as the items.

The Dictionary Object

The Dictionary Object is a container type created by Microsoft that contains a list of Key Item pairs. In most cases, TurboScripter uses the Key as
a zero-based index, and the item contains the actual value. Further information about the Dictionary object is available at the Microsoft Web site
or in VBScript documentation.
Example:

REM ** Create a Dictionary object to set the properties of an object on creation

Set myProps = CreateObject("Scripting.Dictionary")
REM ** The property name is the KEY and the value is the ITEM
MyProps.Add("Field_Type", "Small Integer or Integer")
MyProps.Add("Fld_Len", "15")
Set myObj = Repo.Create("FIELD", "TS_TEST", MyProps)

Obtaining a Relation Object Between Two Objects

When calling GetChildren or GetParents, pass in an empty Dictionary Object as the optional third parameter. When the call returns, this object
contains the relations corresponding to the children for the same Key value. (The Relation for the first Child object in the returned Children object
is the first element in the Relations object. Relation for the second child is the second element in the Relations object, and so on.)

Creating or Modifying Files under a Component_Folder

If the Component_Folder does not exist, complete the following steps:

Create a Component_Folder object using Repo.Create.
Create a child of type "WEAK_ENTITY" through the relation "COMPONENT_FOLDER_CONTENT".



3.  

4.  

Set the PathName property of the COMPONENT_FOLDER_CONTENT relation to the full path name of the file you want to store in the
repository.
Call SetFile method on the Relation object passing in the text string containing the file contents and the type, which is 17
(ComponentFolderFile).

VBScript and JScript versions 5.0 and later do not support binary files. This restricts the use of TurboScripter to text
files.

TurboScripter Object Reference

This section contains brief descriptions of the TurboScripter objects for reference. Each entry has a description of what the object does and lists
the filename of a sample script utilizing that object that can be found in the AD\TSCRIPTS subdirectory. vb sample scripts provided with

 lists the TurboScripter sample scripts with a description of each script.Turboscripter

vb sample scripts provided with Turboscripter

Sample VB
script

Description

auto Retrieves fields that have a date type and documents the views that use them in an Excel spreadsheet.

create Creates or deletes repository objects.

CreateDefaultINI Creates new appcofgdefault.ini and partitiondefault.ini files from downloaded AppBuilder mainframe files.

CreateServer Creates a Server object. 
Searches all Rules in the repository and adds frontier rules to the Server object. If more than 999 rules are found, it creates
additional Server objects.

draw Opens a specified ERD file from the repository and displays the names of entities in the diagram.

ExportFile Retrieves a file from an object and saves it. The sample can retrieve Rule source file, Window panel file, and an .ini
configuration file from AppConfig and Partition.

gettype Gets all the Views of a certain Rule and outputs their relationships and usage to the parent Rule.

hierarch Generates a sample hierarchy beginning with TS_. In the process, it uses Create, CreateChild, SetProperty, SetFile,
Property Dictionaries during Create and for Relations during CreateChild, Commit, and Rollback.

ImportFile Restores file to object. The sample can set rule source file, window panel file, and an .ini configuration file for AppConfig and
Partition.

model Retrieves the meta-information about the repository.

pnl_crt Creates a sample panel in the repository and creates a few sample controls with properties.

pnl_read Retrieves a Window Panel that you want to read from the repository, opens it, and displays the controls and their properties.

query Prompts you for the method that you want to test, and, depending on the method entered, runs Query, Find, or Get method.

rename Renames a view or a field and modifies any rule source that uses the original name.

SortSet Sorts the selected set by the values in the Define column of the set. This script must be invoked from the AppBuilder
Workbench, with the set to be sorted selected.

The TurboScripter objects include the following:

Repository Object - Implements IRepo
Entity Object - Implements ITSEnt
Relation Object - Implements ITSRel
Trace Object - Implements Itrace
Host Object - Implements IScriptUtils
Child Script Object - Implements IScript
TurboHost - Implements ITurboHost
CoDraw Object
CoPanel Object
Trace Object - Implements Itrace
CoCtrl Object
Attribute Object



Repository Object - Implements IRepo

This section discusses the Repository Object - Implements IRepo. The following sections describe actions that can be taken on the Repository
Object and properties that can be applied to the Repository Objects.

Query(String ObjectType, String PropName, String Pattern)

Queries the repository for Objects of type ObjectType with the property PropName that have the value Pattern. Returns a Dictionary object
containing a list of TSEnt objects that the repository returns. This list is keyed by the index of the elements in the list starting from 0. Pattern can
contain '*' as wildcard. If the Property name is a Domained value, use the Display Value in the repository model.
Example:

REM *** Following query returns a Dictionary of TSEnt objects of type
REM ***  that have names beginning with "VIEW" "HPS"
Set myViews = Repo.Query( , , )"VIEW" "Name" "HPS"
REM *** Following query returns a Dictionary of TSEnt objects of type
REM ***  that have their  property set to "FIELD" "Field_Type" "8"
REM ***  is a Domain and  is the Display Value"Field_Type" "Date"
Set myDateFields = Repo.Query( , , )"FIELD" "Field_Type" "Date"

Sample script: Query.vbs

Find(String ObjectType, String PropName, String Value)

Returns the corresponding TSEnt Object. If more than one object matches the criteria, the first object is returned. If the Property name is a
Domained value, use the Display Value in the repository model. This is typically used to find a specific object whose unique property value is
known.
Sample script: Query.vbs

Get(String Type, String Name)

Returns the TSEnt object with the given Type and Name.
Sample script: Query.vbs

Create(String Type, String Name, (optional)Dictionary Properties)

Returns the created object. If the TSEnt object already exists, the existing object is retrieved and returned. Display values can be used for
Domained properties. To set the properties when creating an object, fill in the Properties object with the Key as Property Name and Item as
Property Value.
Sample script: Create.vbs

Delete(String Type, String Name)

Returns Nothing. Raises Error if the specified object is not found.
Sample script: Create.vbs

Commit()

The entire session is committed. When called from the WorkBench, changes done by the other tools are also committed.
Sample script: Create.vbs

Attempting to access deleted objects after commit could destabilize the Construction Workbench. Make sure that objects that
have been deleted before are not accessed after the commit.

Rollback()

The entire session is rolled back. When called from the Construction Workbench, changes done by the other tools are also rolled back.
Sample script: Create.vbs

Attempting to access objects that have been created before the rollback could destabilize the Construction Workbench. The
script author must make sure that objects that have been created before are not accessed after the rollback.

GetEntityTypes()

Returns a Dictionary object containing all the entity types in the repository as strings. This list is keyed by the index starting from 0.



Sample script: Model.vbs

GetRelationTypes()

Returns a Dictionary object containing all the relation types in the repository as strings. This list is keyed by the index of the elements in the list
starting from 0.
Sample script: Model.vbs

GetPropertyNames(String ObjectType)

Returns a Dictionary object containing all the property names for this object type. This list is keyed by the index of the elements in the list starting
from 0.
Sample script: Model.vbs

GetPropertyType(String ObjectType, String PropName)

Returns the property type as a String. The value is one of "STRING", "LONG", "UNSIGNED_INT", "DOMAIN" or "INTERNAL"
Sample script: Model.vbs

GetDomainValues(String ObjectType, String PropName)

Returns a Dictionary object containing all the valid Domain values for this property. This Dictionary Object contains the Storage Values of the
domain elements as the Key and the Display Value (or User Value) as the item. Returns an error for properties that do not have a Domain
associated.
Sample script: Model.vbs

StatusToString(int status)

Returns the repository status message from a status code.

Entity Object - Implements ITSEnt

GetProperty(String PropName)

Returns the required property as a Variant object. The only variable type in VBScript. The PropName must be a valid property of this repository
object type as published in the repository model.
Sample script: Query.vbs

SetProperty(String PropName, Variant PropValue)

Sets the property specified by PropName to the value in PropValue. Returns nothing. Raises an Error if the property is invalid or the value is
invalid. For properties that have a domain associated with them, the Display value (or User Value), not the storage value, must be specified.
Sample script: Hierarch.vbs

CreateChild(String Type, String Name, String RelationType, (optional) Dictionary Properties, (optional) Dictionary RelationProperties)

Creates a child object of the specified Type and Name. The Properties Dictionary can contain the properties of the child object while the
RelationProperties Dictionary can contain the properties of the relation, for example, Sequence Number of the relation. If the specified object
already exists in the repository, this method returns the retrieved object.
Sample script: Hierarch.vbs

GetChild(String Type, String Name, String RelationType)

Returns an Entity Object (TSEnt) that is a child of the calling object.

GetChildren(String Type, String RelationType, (optional) Dictionary RelationObjects)

Returns a Dictionary object containing the child objects (TSEnt) of the specified type. The indices for these objects are from 0 to (Count - 1). If the
RelationObjects is a valid Dictionary, then the Relation object (TSRel) for each of the corresponding child objects are filled in.
Sample script: gettype.vbs

GetParents(String Type, String RelationType, (optional) Dictionary RelationObjects)

Returns a Dictionary object containing the parent objects(TSEnt) of the specified type. The indices for these objects are from 0 to (Count - 1). If
the RelationObjects is a valid Dictionary, then the Relation object (TSRel) for each of the corresponding child objects will be filled into
RelationObjects. Use the same key value to access the child object as well as the relation object for that child.
Sample script: Rename.vbs

GetType()



Returns the Object Type name of this object as a String.
Sample script: gettype.vbs

GetFile(Integer FileType)

Returns the File associated with this object. Valid values for File Type are given in the following table:

File Type Values

Value File Type

0 RepoKeywords

1 RepoText

2 WindowPanel

3 ReportSection

4 PhysicalBitmap

5 DrawingFile

6 ReportFile

7 RuleSource

8 ComponentSource

9 WindowHelp

10 DatabaseOptions

11 ServerOptions

12 MachineOptions

13 FormContents

14 MigrationFile

15 ClosureScope

16 ApplicationFolder

17 ComponentFolderFile

18 ConstructorSource

19 DestructorSource

20 MethodSource

21 CursorSqlBody

22 RepoInitializer

23 PrepFile

Example:
If this is a Rule object, then GetFile(7) will return the source file for this rule as a string.0(RepoText) is a valid file type for all Entity (TSEnt) and
Relation (TSRel) objects.1(RepoKeywords) is a valid file type for all TSEnt objects.

Sample script: Rename.vbs

SetFile(Integer FileType, String FileStr)

Sets the file associated with this object in the repository to FileStr. This can be used to create RuleSource (Value = 7) files from RULE objects and
RepoText(0) and RepoKeywords(1) files from all Entity objects (TSEnt).
Sample script: Rename.vbs

DeleteChildRelation(String ChildType, String ChildName, (optional) String RelType)

Deletes the Relation between this Entity object (TSEnt) and the child object identified by ChildType and ChildName. If this object and the Child
object are connected by more than one type of relation, then the RelType must be specified.



DeleteParentRelation(String ParentType, String ParentName, (optional) String RelType)

Deletes the Relation between this Entity object (TSEnt) and the parent object identified by ParentType and ParentName. If this object and the
parent object are connected by more than one type of relation, then the RelType must be specified.

Properties implemented by TSEnt

TSEnt does not have any static properties of its own. It assumes all the valid properties of the repository object that it represents.
Example:

Get the Field_Type property of myField

Set myField = Repo.Get("FIELD", "RETURN_CODE")
MyFieldType = myField.Field_Type

ExtractODF(String directory)

Extracts the Object Definition File (definition of the object in XML format) for this TSEnt into the given directory. The odf file name is in the format
<ShortName>.odf.xml.
Example:

myObj.ExtractODF("C:\temp")

ODFGen(String extractToDir, BOOL isDeep)

Extracts the ODF for this TSEnt and its children in the same file when isDeep is True.
Example:

myObj.ExtractODF("C:\temp", true)

IsPrepared

Returns true if this TSEnt is already prepared.

IsSystem

Returns true is this TSEnt is a system object.

IsTransformed

Returns true if this TSEnt is a transformed object.

MarkPrepared

Marks this TSEnt as prepared.

MarkDirty

Marks this TSEnt as dirty.

Relation Object - Implements ITSRel

GetProperty(String PropName)

Returns the required property as a Variant object. The only variable type in VBScript. The PropName must be a valid property of this repository
object type as published in the repository model.
Sample script: gettype.vbs

SetProperty(String PropName, Variant PropValue)

Sets the property specified by PropName to the value in propValue. Returns nothing. Raises an Error if the property is invalid or the value is
invalid. For properties that have a domain associated with them, the Display value (or User Value), not the storage value, must be specified.
Sample script: hierarch.vbs

GetType()

Returns the Object Type name of this object as a String.
Sample : pnl_read.vbs



GetFile(Integer FileType)

Returns the File associated with this object.
Example: If this is a COMPONENT_FOLDER_CONTENT object, then GetFile(17) returns the component folder file for this relation object as a
string if it is a text file.
Sample script: rename.vbs

SetFile(Integer FileType, String FileStr)

Sets the file associated with this object in the repository to FileStr. This can be used to create ComponentFolderFile files from
COMPONENT_FOLDER_CONTENT relation. When retrieving Component Folder files, only text files can be retrieved. Binary files cannot be
retrieved.
Sample : rename.vbs

Host Object - Implements IScriptUtils

CreateScript(String FileName, String Language)

Returns a Script object that is initialized to have the same environment as the calling script. This call is used to create a new script object that can
be executed from inside this script. Call the method Run() on the returned Script Object to execute the new child script.

Child Script Object - Implements IScript

Run( )

Executes the Child Script object in the same environment as the parent script. This method raises an Error if the execution of the script fails.

AddInputObject(String Type, String Name)

Adds the repository object specified by Type and Name to the InputObject Dictionary of this child script object.

AddTypeLib(String TypelibID, Long MajorVersion, Long MinorVersion, (optional) Long Flags)

Adds the specified TypeLibrary to the scope of this script object. Any constants defined in the TypeLibrary can now be used within the script.

AddTopLevelObject(String Name, Object TopObject)

Adds the specified ActiveX Object to the list of Top Level objects for this script. The script can access the object using the Name parameter.

TurboHost - Implements ITurboHost

The TurboHost object implements the functionality required to host the scripting engine and serves as the entry point to the Repo, Script and
Trace Objects. The methods and properties of this object can be used from other applications like VB that support COM and are not for use from
inside a script.

RepoInit(String RepositoryName, String UserName, String Password, (optional) String VersionName)

Connects to the specified repository and returns the repository object. This object is a must either to run scripts or work with any repository
objects directly.

ScriptRun(String ScriptFileName, String Language, Dictionary InputObjects, Long WindowHandle, (optional) Dictionary TopLevelObjects)

Executes the specified script. Returns an error on failure. VBScript and JScript are the supported languages. The Window Handle can be 0, in
which case the handle of the currently active window is used. The TopLevelObjects Dictionary contains ActiveX objects keyed by their name.
These objects can be used from inside a script just like the default Top Level Objects like "Trace" or "Repo".

ScriptletRun(String ScriptContents, String Language, Dictionary InputObjects, Long WindowHandle, (optional) Dictionary TopLevelObjects)

Works the same way as ScriptRun except that a string containing the script instead of the file name is passed. This is useful when scripts are
generated on the fly by an application.

ScriptSelectAndRun(Dictionary InputObjects, Long WindowHandle)

This method brings up a dialog box containing the scripts in the directory specified in the registry. This dialog also shows the scripts present in the
TScripts Component Folder. You can then select the script you want to be executed.

ScriptInit(String ScriptFileName, String Language)



This method returns the Script Object that is initialized to the file name and language specified. Once this object is obtained, methods to add input
objects, to add top-level objects, and to execute the script can be called.
Top-level objects added by TurboScripter to the scope of all scripts:

Repository Object - Implements IRepo - Repository Object for querying, creating or deleting objects in the repository
Trace Object - Implements Itrace - Trace Object to get and set the trace file and trace level
Host Object - Implements IScriptUtils - Host Object to enable creating a child script
Input or  - Dictionary object that contains the input Entity objects (TSEnt). Sample script:Rename.vbs.Entity Object - Implements ITSEnt

CoDraw Object

The CoDraw Object provides access to Drawing Objects stored in the repository. Only read access is allowed. To access Drawing Objects from
VB or TurboScripts, call CreateObject("CoDrawFile.CoDrawFile"). This returns the created ICoDrawfile object, which can be used to perform read
operations on the drawing.

Open(String DrawingName, String DrawingType)

Retrieves the specified Drawing object and opens it for reading. The DrawingName is the name of the Drawing object. The DrawingType is the
value in the Drawing_Type property of this object. Since the Drawing_Type property can only have values from the Drawing_Type domain, the
Display value must be specified.
Sample script: Draw.vbs

GetAllRepoObjects()

Retrieves all the repository objects in the drawing and returns a Dictionary object that contains these as Entity objects (TSEnt).
Sample script: Draw.vbs

GetRepoObjects(String Type)

Retrieves the Repository objects of the specified Type in the drawing and returns a Dictionary object that contains these as TSEnt objects.
Sample script: Draw.vbs

DrawTrace

Sets the trace level for the CoDraw object. The domain values are the same as the  in the TurboScripter Object Model. The defaultTrace Levels
value is set to TRACE_NONE. You must set tracing explicitly to get trace information.

The CoDraw object reflects the state of the Drawing Object as it is in the repository. If changes are made to the drawing file
from the workbench, these changes must be committed before the CoDraw Object is opened.

CoPanel Object

The CoPanel object provides COM/OLE Automation-based access to the various controls and their properties. It enables a TurboScript to create,
read, update, and delete the controls and their properties. They include:

CoPanel Object Control Types
CoPanel Object Colors
CoPanel Object GUI Types

The constants in the following table can only be used when the script is invoked from within the Construction
Workbench.

CoPanel Object Control Types

  Control Type Constant

1. CHARTWINDOW ctrlChart

2. CHECKBOX ctrlCheckbox

3. COMBOBOX ctrlCombobox

4. EDITFIELD ctrlEditfield

5. ELLIPSE ctrlEllipse



6. GROUPBOX ctrlGroupbox

7. HOTSPOT ctrlHotspot

8. LISTBOX ctrlListbox

9. MULTILINEEDIT ctrlMultiLineEdit

10. OLECONTROL ctrlActiveX

11. PUSHBUTTON ctrlPushbutton

12. RADIOBUTTON ctrlRadiobutton

13. RECTANGLE ctrlRectangle

14. SPREADSHEET ctrlMCLB

15. STATICTEXT ctrlStatictext

16. BITMAP ctrlBitmap

17. MENU ctrlMenu

18. SUBMENU ctrlSubMenu

19. MENUITEM ctrlMenuItem

20. SEPARATOR ctrlMenuSeparator

21. CELL ctrlCell

22. CELLFIELD ctrlCellField

23. CELLTEXT ctrlCellText

24. XDATA ctrlXData

25. YDATA ctrlYData

26. FOOTINGTEXT ctrlFootingText

27. LEFTMARGINTEXT ctrlLeftMarginText

28. RIGHTMARGINTEXT ctrlRightMarginText

29. HEADINGTEXT ctrlHeadingText

CoPanel Object Colors

  Color

1. Default

2. Black

3. White

4. DarkGray

5. Gray

6. LightGray

7. DarkBlue

9. DarkGreen

10. Green

11. DarkCyan

12. Cyan

13. DarkRed



14. Red

15. DarkMagenta

16. Magenta

17. DarkYellow

18. Yellow

19. Pink

20. Brown

CoPanel Object GUI Types

GUI Type

IBM_3270

Workstation

HTML

NewPanel(GUIType gui, String filename)

Creates a new panel of the specified type. The object is created in the repository only after Commit is called. This call must be called before
adding any controls to the panel.
Filename is an optional parameter used to initialize a panel from a template.
Sample script: pnl_crt.vbs

OpenPanel(String winName, String winLanguage, GUIType gui)

Opens an existing panel in the repository. The default value for language is "".
Sample script: pnl_read.vbs

AddControl(ControlType control_type)

Adds a new control of the specified control_type to the panel and returns a Control Object.
Sample script: pnl_crt.vbs

AddAttribute(String AttrbuteName)

Adds the specified attribute to the Panel object and returns the Attribute Object. This method is called when a new attribute that is not in the
current Window Model must be added to the panel.

DeleteAttribute(String AttributeName)

Deletes the specified attribute from the Panel object. This can be done for attributes in the Window Model and for newly added attributes.

GetAttribute(String AttributeName)

Returns the Attribute Object for the specified attribute.
Sample script: pnl_read.vbs

DeleteControl(Control ctrl)

Deletes the control specified by the ctrl object from the panel.

Commit(String WindowName, String Language)

Saves the Panel object in the repository. For new panels, if a panel with the same GUI and language exists under the WindowName, an error is
returned. The panel is updated if an existing panel is opened, updated and committed.
Sample script: pnl_crt.vbs

GetAllAttributes()

Returns a Dictionary object containing a list of all the Attribute Objects for this panel.



Rollback()

Rolls back all changes made to the panel and returns it to the NewPanel or OpenPanel state.

GetAllControls()

Returns a Dictionary object with a list of all the controls in the panel.

SaveToFile(String PanelFileName, String HelpFileName)

Saves the panel to a file named PanelFileName and the help to HelpFileName.

GetDomainValues(String Type)

Given a Domain Type, this call returns a dictionary object containing all the values in the domain.
Refer to the .Valid Domain Types and Values

GetLanguage()

Retrieves that language property for the current panel object.

SetLanguage(String Language, Boolean overwrite)

Set the language property for the panel. If overwrite is TRUE, the panel replaces an existing panel of that language if it already exists.

NewLanguagePanel(String Language, String BaseLanguage)

Create a new language panel based on an existing language panel specified by the BaseLanguage. If the BaseLanguage is a blank string, the
new language will be created based on the default language.

Paste(VARIANT objects)

Adds objects, supplied in panel file format, to the panel. Returns a Dictionary object with a list of the controls that were added.

GetDomainTypes()

GetDomainTypes() returns a dictionary of domain type strings.

GetDomainValues()

GetDomainValues() returns a dictionary of values for a given domain type.

TraceLevel

Sets the trace level for the CoPanel object. The property uses the same domain values as  in the TurboScripter Object Model. TheTrace Levels
default value is set to TRACE_NONE. You must explicitly set the value for tracing to get trace information on the CoPanel object.
These methods are used together to provide Window Painter the valid attribute values for a given attribute. These values are contained in the
Window Painter model.
See .Valid Domain Types and Values

Trace Object - Implements Itrace

OutFile

An integer constant that specifies the name of the file to which all trace outputs should be written. If the file already exists, the existing file is
deleted and a new file of the same name is opened. To save an existing trace file, get the  property, create a  with thisOutFile FileSystemObject
name and save it to another filename. The value of the  property is initialized to the value of the key in the registry.OutFile

HKEY_LOCAL_MACHINE\SOFTWARE\BluePhoenix\AppBuilder\IDWB\ SCRIPTING\TURBO_SCRIPTER\Trace_File

If there is an invalid value in the registry, then the  property is assigned to  in the current directory.OutFile ts.out

Level

An integer property that specifies the severity of the messages to be written to the trace file. The following table lists the valid values:

Trace Levels



Numeric Value Integer Constants Trace File Contents

0 TRACE_NONE No trace information at all

1 TRACE_EXECUTION Trace errors

2 TRACE_DEBUG Trace errors and informational messages

3 TRACE_ALL Trace detailed error and information messages 
Note that this value significantly impacts performance.

TRACE_EXECUTION, TRACE_DEBUG, and TRACE_ALL are integer constants defined in the TSATL type library. Any other numeric value
above 2 is the same as setting the value to 2.

Log(String format, String param)

This method logs messages.
Example:

Trace.Log( , );"Codegeneration %s with errors" "failed"

SetOutFile(String newVal)

This method opens a log file for appending.
Example:

Trace.SetOutFile( )"output.log"

Valid Domain Types and Values

Here is a list of the current domain types and values used in  and . The supported values forGetDomainTypes() GetDomainValues(String Type)
each type is provided in the linked subtopic.

Domain Types and Values

COUNTRY BORDER_TYPE

COORDTYPE FONT

JUSTIFICATION CHARTTYPE

FORMAT STYLE

COLOR STYLE_3270

HSCROLL SELECTIONTYPE

VSCROLL DRAWLINES

COUNTRY

Country Values

SYSTEM ALBANIA

ARGENTINA AUSTRALIA

AUSTRIA BELGIUM

BRAZIL CANADA_ENGLISH

CANADA_FRENCH CHINA

CZECHOSLOVAKIA DENMARK

FINLAND FRANCE



GERMANY GREECE

HUNGARY ICELAND

ITALY JAPAN

NETHERLANDS NEW_ZEALAND

NORWAY POLAND

PORTUGAL ROMANIA

SOUTH_AFRICA SOUTH_KOREA

SPAIN SWEDEN

SWITZERLAND TAIWAN

THAILAND THAILAND_BUDDHIST

TURKEY UNITED_KINGDOM

UNITED_STATES YUGOSLAVIA

COORDTYPE

Coordtype values

CHAR PIXEL

JUSTIFICATION

Justification values

LEFT RIGHT

FORMAT

Format values

CASEENTERED UPPER

LOWER FIRSTUPPER

ALLFIRSTUPPER  

COLOR

Color values

CUSTOM DEFAULT_COLOR

BLACK WHITE

DARKGRAY GRAY

LIGHTGRAY DARKBLUE

BLUE DARKGREEN

GREEN DARKCYAN

CYAN DARKRED

RED DARKMAGENTA

MAGENTA DARKYELLOW

YELLOW PINK



BROWN  

HSCROLL

Hscroll values

SHOW_ALWAYS SHOW_NEVER

SHOW_AS_NEEDED  

VSCROLL

Vscroll values

SHOW_ALWAYS SHOW_NEVER

SHOW_AS_NEEDED  

BORDER_TYPE

Border values

BORDER_NONE BORDER_SIZEABLE

BORDER_DIALOG  

FONT

Font values

CUSTOM SYSTEMFONT8

MODERN8 MODERN10

MODERN12 ROMAN8

ROMAN10 ROMAN12

ROMAN14 ROMAN18

ROMAN24 SWISS8

SWISS10 SWISS12

SWISS14 SWISS18

SWISS24  

CHARTTYPE

Charttype values

LINECHART2D BARCHART2D

PIECHART2D STACKEDBARCHART2D

COLUMNCHART2D SMOOTHLINECHART2D

SCATTERCHART2D AREACHART2D

BARLINECHART2D HILOWCLOSE2D

CANDLE2D POINTANDFIG2D

LINECHART3D BARCHART3D

PIECHART3D STACKEDBARCHART3D



COLUMNCHART3D AREACHART3D

PERBARCHART3D BARLINECHART3D

STYLE

Style values

DROPDOWN DROPDOWNLIST

SIMPLE  

STYLE_3270

Style_3270 values

DROPDOWN DROPDOWNLIST

SELECTIONTYPE

Selectiontype values

SINGLE MULTIPLE

EXTENDED  

DRAWLINES

Drawlines values

NOLINES VLINES

HLINES VHLINES

CoCtrl Object

GetAllAttributes()

Returns a Dictionary object containing a list of all the Attribute Objects for this control.

AddAttribute(String AttributeName)

Adds the specified attribute to the Panel object and returns the Attribute Object. This method is called when a new attribute that is not in the
current Window Model must be added to the panel.

GetAttribute(String AttributeName)

Returns the Attribute Object for the specified attribute. Use this object only in Construction Workbench.
Sample script: pnl_read.vbs

GetType()

Returns the ControlType constant (defined above) that specifies this control type.
Sample script: pnl_read

DeleteAttribute(String AttributeName)

Deletes the specified attribute from this control. This can be done for attributes in the Window Model and for newly added attributes.

GetContents()

Returns a Dictionary Object containing the controls that are embedded in this control. Fails if no controls are present.

AddControl(ControlType type)



A control of ControlType type is added to this control.
Sample script: pnl_crt.vbs

DeleteControl(Control ctrl)

Deletes the Control specified by ctrl from this control.

DeleteContents()

Deletes all embedded controls in this control.

ChangeParent(IcoCtrl * old, IcoCtrl * new)

Changes a control objects parent.

ChangeType()

Modifies the control type.

Copy()

Creates a SAFEARRAY of BYTEs that correspond to the panel file format for the control.

SetDataLink( String Type, String Name )

Creates a data link property for a control on a window. The data object is the entity specified by the Type and Name. Depending on the control
type, the Type parameter should be 'VIEW' or 'FIELD', e.g. for an MCLB, it is View, while for a Column or Edit control, it is Field.
The Name parameter should be the name of the data item, view or field, to be linked to the control.
Example 1: SetDataLink( "FIELD", "retrun_code" )
This links the FIELD "return_code" to the control. The FIELD object has to be in the scope of the Window to which the control belongs. If the data
item can not be linked to the control, e.g. it is not within the window view, the method returns false.
If Name is specified as an empty string, "", the method removes any data link for the control.
Example 2: SetDataLink( "FIELD", "" ) - This empties a data link.
This method can link to a data item within a sub-view of the window view. However, if there are multiple instances of that data item within the
window view, this method uses the first instance found. A subsequent fix is planned to allow a specific instance of the data item to be linked to the
control.

Attribute Object

set_Value(VARIANT val)

Sets the Value of this attribute to that specified by val. All variables in VBScript are of type VARIANT, which is a generic type for all other
supported types. This method would be successful as long as the value is of the right type, for example, String, Integer etc.
Sample script: pnl_crt.vbs

get_Value()

Returns the value of the attribute. If the attribute is a compound attribute, like Font or Color, then this value would contain an object like Font or
Color.
Sample script: pnl_crt.vbs

get_Name()

Returns the name of this attribute.
Sample script: pnl_read.vbs

DeleteAttribute()

Removes this attribute from the parent control.

Font Object and Color Object

These are compound attributes and can be treated like a sub-control, since they contain the same methods that characterize a control object.
They have attributes that can be accessed through GetAllAttributes or GetAttribute(String AttributeName).

Starting TurboCycler



1.  
2.  

TurboCycler is an installation component of the AppBuilder program. You can access TurboCycler from the following application development
tools:

Database Diagrammer
Entity Relationship Diagrammer
Matrix Builder
Process Dependency Diagrammer
State Transition Diagrammer
Window Flow Diagrammer

To open the TurboCycler from the Construction Workbench, select the object in the Hierarchy window to which you want to apply the TurboCycler
script and select  .Tools > TurboCycler
The following topics are discussed in this section:

Selecting Generation Templates
Setting Up Generation Templates
Generating Your Application

Selecting Generation Templates

To select a TurboCycler generation template, complete the following steps:

From Windows® Start menu, select  .All Programs > AppBuilder > Construction Workbench
Open a project in the Hierarchy and select an object that you want to use the TurboCycler on. Select  .Tools > TurboCycler

          The TurboCycler - Select Generation Templates window opens.

TurboCycler-Select Generation Templates window

The Selected Templates and Available Templates list boxes display templates that you can use with the selected object type (in 
, the object type is Function).TurboCycler-Select Generation Templates window

     3. Select the templates that you want to use with the  and  buttons.Add Remove

Selecting a Template in TurboCycler

If you add additional templates, alter the default templates, or create new templates (using the TurboCycler Developer's Kit), the objects you



1.  

create are available through the Query option.

     4. Select  ,  or  . Generate Setup Templates, Cancel Generate.

     5.  starts the generation process.  displays a window in which you can select the modules to generate (see Generate Setup Templates Setting
).  returns you to the previous window.Up Generation Templates Cancel

Setting Up Generation Templates

To set up your generation template, use the following procedure.

Procedure - Setting up Templates

Select  .Setup Templates

The TurboCycler Setup Generation Templates dialog appears. Use this dialog to specify precisely what output you want TurboCycler to generate
(for example, whether the application should perform an SQL update or an SQL insert, or both) The output choices are called modules.

Generation Template Setup Window

The Object Type list box displays the repository object type, and the Generation Templates list box lists the available templates for that object
type ( ). The text in the Template Description box describes the selected template. The Selected Modules andGeneration Template Selection
Available Modules fields identify the available modules for this object type/template combination.

   2. Select the modules to generate with the  and  buttons.Add Remove

Generation Template Selection
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Generating Your Application

When you have selected the appropriate modules, you can generate the application.
To generate an applications, complete the following steps:

Select the  button in the Select Generation Templates window to start the TurboCycler process.Generate

The Rename Object window opens.

Rename Object Window

During the generation process, a status window notifies you of the progress of the generation.

     2. Click  to stop TurboCycler between modules.Cancel

The program returns to the Construction Workbench TurboCycler window ( ). You can reviewTurboCycler-Select Generation Templates window
the results of the TurboCycler process after completion.

The TurboCycler process generates objects using names defined by the templates for the objects you select. If you run
TurboCycler more than once, previously generated objects with modifications are replaced by newly generated objects.
Because of this, you must carefully examine the objects created by a generation. To validate the generation results and make
sure that no desired user modifications have been lost, examine the hierarchy, rule, and window objects. If the results of a
generation process are not satisfactory, you can roll back the session changes from the Construction Workbench. Click  > File

 from the Construction Workbench.Rollback

Using Default Templates

This topic includes:
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Understanding Default Templates
Developing the Application
Information about using default templates:

CRUD Rules Template
GUI Rules/Windows Template
Utilities Template
Rename Views, Fields and Rules Template
Rename Verify Template
Hierarchy Cloner Template

Understanding Default Templates

TurboCycler software includes a set of six default templates. You can generate a fully functional reference table application using all of the six
templates. The default templates specify part of the TurboCycler output and make modifications easier.
The default templates are designed for single-byte characters. For templates using the 'String Manipulation function' in a DBCS environment, you
must modify the default templates. See  for more information.Editing and Compiling a Template

CRUD Rules Template: includes SQL statements (Create, Read, Update, and Delete database access operations)
GUI Rules/Windows Template: supplies graphical interface event-handling procedures
Utilities Template: contains message-handling procedures used by generated objects
Rename Views, Fields and Rules Template: modifies the source of any rules that refer to a renamed Field or View object
Rename Verify Template: shows the rules in the repository that must be modified if the name of the selected object is changed
Hierarchy Cloner Template: creates a new Hierarchy of repository objects based on an existing Hierarchy

The TurboCycler process uses the default templates to create output objects with fully coded rules including calls to system components as
needed, painted windows with predefined styles, and view and field physical data structures. These objects are automatically related in a logical
hierarchy in the repository.

Two or more users cannot run TurboCycler templates that create and update the same repository objects. This is true for
objects that are sent through TurboCycler as well as other objects that the template might access to update or create. If two or
more users attempt to run TurboCycler templates that create and update the same repository objects, the first user locks the
object, and the second user gets an error message "Object exists in the repository in an Uncommitted State."

Using Default Templates describes how to use the default templates. It details the output objects that the templates generate and defines the
specific Rules, Windows, and Hierarchies generated by each default template.
The source code for each of these templates is included in the TurboCycler Developer's Kit. Two source code samples are included in Template

.Samples
Using the default templates, you can generate a functional application, including complete function hierarchies, detail and list windows, database
access rules, and standard utilities. You can write generation templates to automate an unlimited number of processes in the development
lifecycle. You can also write templates to customize processes like forward engineering, transformation, reverse engineering, and any other
process that generates objects in the repository from other repository objects.

Developing the Application

Before starting TurboCycler, perform the following Construction Workbench modeling steps:

Create an entity relationship diagram (ERD).

          This establishes the ERD as a logical model that consists of entities, relationships, properties, identifiers, and data types. See Defining an
 for more information.Entity Relationship Diagram

     2. Forward engineer the ERD into a database diagram (DBD).

         Forward engineering creates a relational model containing tables, keys, and columns. See Forward Engineering an Entity Relationship
 for more information.Diagram

     3. Transform the DBD into a Hierarchy Diagram with file structures. See  for more information.Transforming a Database Diagram (DBD)

For detailed information about creating an ERD, forward engineering an ERD, and transforming a DBD, refer to the Developing Applications
 and the Guide Development Tools Reference Guide

These steps populate the repository with the information that TurboCycler needs to generate a reference-table application. Without TurboCycler,
developing applications using these objects requires you to write rules code yourself to reflect the model.

Encountering Errors

If TurboCycler encounters a repository error or other errors that are specific to an object, a message is displayed.
In the error message window, select  for TurboCycler to continue processing other objects while omitting all objects that encountered theYes
error.

Session Reports



The TurboCycler Report option displays a summary of the last TurboCycler session. This file is overwritten for each TurboCycler session. If you
want to save the session information, then the file  needs to be saved manually. The location for this file can be specified on theTC.OUT
Turbocycler set of options of the Workbench Options dialog (  >  , then click Script > TurboCycler).Tools Workbench Options

CRUD Rules Template

You can generate Create, Read, Update, Delete rules (CRUD) for any existing file hierarchy in the repository. Because of the traceability
information stored in the repository during forward engineering and transformation, four object types in the repository (Files, Tables, Entities, and
many-to-many relationships) can generate CRUD rules. If you want to generate CRUD rules from non-file objects, you must perform the
appropriate forward engineering and transformation steps before the generation process, or an error message is displayed.
The CRUD Rules template contains six modules:

Clone Data View Module
SQL Delete Rule Module
SQL Fetch Rule Module
SQL Insert Rule Module
SQL Select Rule Module
SQL Update Rule Module

Clone Data View Module

Clone Data View creates a view in the repository. The view name is the name of the file (for long file names, truncated to a maximum of 19
single-byte characters or eight DBCS characters), plus the suffix _  . This view contains, as its children, all of the fields included in the file dataCDV
view. Assorted CRUD rules and some GUI rules and windows use the cloned data view to avoid problems of hierarchy ambiguity. The following
figure shows a generated clone data view and the corresponding file data view.

Generated Clone Data View with its Corresponding Data View

SQL Delete Rule Module

SQL Delete Rule creates a Rule with appropriate Input View, Output View, and Rules Code that handles record deletion in the table specified by
the file implementation name. It determines which file to delete the record from by the primary key view mapped to its input view. An SQL code is
returned from the delete operation. The following figure shows an example of a delete rule hierarchy.

Delete Rule Hierarchy

SQL Fetch Rule Module

SQL Fetch Rule creates a rule with appropriate input view, output view, and rules code. This rule fetches records from the table specified by the
file implementation name. The fetch rule is compatible with smooth scrolling techniques through the use of the NUMBER_OF_RECORDS field in
the input view. For each fetch, fifty occurrences of records are fetched according to the parameters mapped to the primary key view, cloned data
view, and FETCH_TYPE field in the rule input view.
You can specify the FETCH_TYPE as blank, which defines a fetch for all records whose key is greater than or equal to the key mapped to the
input view, or as "D", which defines a fetch using a LIKE clause against all fields in the key. The fetch rule returns and maps the SQL code to the
field RETURN_CODE if an SQL error occurs. The number of records fetched is returned to the NUMBER_OF_RECORDS field and all fetched
records are returned to the occurring cloned data view in the output view.

SQL Insert Rule Module

SQL Insert Rule creates a rule with appropriate input view, output view, and rules code. This rule inserts a record in the table specified by the file



implementation name. It inserts the record mapped to the cloned data view of its input view and returns the SQL code from the insert operation.

SQL Select Rule Module

SQL Select Rule creates a rule with appropriate input view, output view, and rules code. This rule selects a record by primary key from the table
specified by the file implementation name. It uses the primary key mapped to its input view to select a single record in the database table and
returns the contents of the record in the cloned data view of the output view. It returns the SQL code from the select operation.

SQL Update Rule Module

SQL Update Rule creates a rule with appropriate input view, output view, and rules code. This rule handles updates to a database record selected
by the primary key in the table specified by the file implementation name. It sets all fields of the record of the table to the values mapped to the
cloned data view of the rule input view. It returns the SQL code from the update operation.

GUI Rules/Windows Template

You can generate GUI rules and windows for any forward engineered and transformed entity hierarchy in the repository. The GUI Rules/Windows
template extracts information already defined in the logical, relational, and structural models of the repository. This template uses traceability
information defined during forward engineering and transformation to generate GUI rules and windows from entities, many-to-many relations,
tables, and files in the repository. If any object of these types does not have the required traceability information, you cannot use this template to
generate GUI rules and windows for that object, and an error message is displayed.
The GUI Rules/Windows Template contains the following modules:

Detail Display Module
Display Driver Module
Browse Display Module
List Display Module
Query Display Module
Logical Driver Module

Detail Display Module

Detail Display creates both a rule and a window for each entity that you specify, with appropriate hierarchies that have references to sets and
components. This rule and window display data details in the application interface. They display information and allow standard record
maintenance (create, read, update and delete). You can edit all fields in the data view of the detail display window.
The hierarchy generated for a kernel entity is different from the one generated for a non-kernel entity. The detail display for a kernel entity is a
choice in the AppBuilder Application Execution menu for accessing the generated application; therefore, a function and process are generated for
every kernel entity. Because the detail display rule for a kernel entity is the root rule for the generated process, it contains no input or output view.
Use the Open choice in the File menu to use a kernel entity detail display to select an instance of the kernel entity.
Because the details of a non-kernel entity are meaningful only in the context of another entity, you can navigate to a non-kernel detail display only
from another entity; it does not serve as an entry point into the application. For this reason, the detail display rule for a non-kernel entity contains
an input and an output view. Also, you cannot open an instance directly from a non-kernel detail display, as it is necessary to clarify its context
through navigation from another object.
A generated detail display window always contains File, Edit, and Options menus. Use the File menu to create a new object, save an object,
delete an existing object, or exit the application. The Edit menu provides undo and redo facilities. Use the Options menu to eliminate the status
bar that appears at the top of the detail display.
View or Query menu choices are available when the table implementing the entity contains referred-by keys (for the View menu) or foreign keys
(for the Query menu). You can use View and Query menus to navigate from object to object (entity to entity) in the application. The status line
under the menu bar displays information about current actions.

Display Driver Module

Display Driver creates a rule with appropriate hierarchies that have references to sets and components. This rule initializes window parameters
and enables or disables objects on the detail window by interacting with the Detail Display rule. The display driver rule does not have an output
view, so no return code is passed back to the calling rule.

Browse Display Module

Browse Display creates both a rule and a window with appropriate hierarchies that have references to sets and components for any kernel entity.
This rule and window provide a way of looking at information for a kernel entity without updating the information. You can use this browsing
technique for object-to-object navigation only for kernel entities. A detail display rule for a non-kernel entity handles object-to-object navigation.
Use the browse display also when navigating to a kernel entity to avoid recursion in the repository.
The browse display window is very similar to a detail display window. However, the browse display offers only the Exit choice in the File menu.
You can perform no other actions including object-to-object navigation. For that reason, there is no status line.

List Display Module

List Display creates both a rule and a window with appropriate hierarchies that have references to sets and components for the entity. Use this
window to select an instance of this entity from the Query menu. The list display rule shows a list of entity instances that meet the criteria that the
primary key specifies. It supports smooth scrolling, so you query the table and select a single instance in the table implementing this entity. The
list display rule takes as input the primary view of the entity that it uses as search criteria. The output of the list display rule is a single instance of
the cloned data view.
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The list display window contains a multicolumn list box with one column for every field in the data view of the file corresponding to this entity. The
top of the window has an edit field for every field in the primary view that you can use to specify selection criteria for a subset of entity. The menu
contains a single choice for toggling the status line on and off. Use the push buttons at the bottom of the window to:

Select a set of rows in the list box according to the criteria specified at the top of the window
Select a single row from the list box
Cancel from this window

The status line under the menu bar displays information about current actions.

Query Display Module

Query Display creates both a rule and a window with appropriate hierarchies that have references to sets and components for the entity. Use this
rule and window to navigate to this entity from another entity, usually through a View menu. The query display rule shows all entity instances that
meet the criteria specified in the primary key. It supports smooth scrolling, so you can specify information to query the table and select a single
instance in the table implementing this entity.
If you select an instance of this entity, either the detail display for this entity for a non-kernel entity or browse display for a kernel entity is
conversed. The query display rule takes as input the cloned data view of the entity, which it uses as search criteria if you specify any. The query
display rule is for navigation and viewing only.
The query display window has a multicolumn list box with one column for every field in the data view of the file corresponding to this entity. Above
the multicolumn list box is an edit field for every field in the primary view. Use it to specify search criteria for a subset of entity instances. The
menu contains a single choice for toggling the status line at the top of the window on and off. Use the push buttons at the bottom of the window
to:

Select a set of rows in the list box according to criteria at the top of the window
Select a single row from the list box
Cancel from this window

The status line under the menu bar displays information about current actions.

Logical Driver Module

Logical Driver creates a rule with appropriate hierarchies that have references to sets and components that acts as a layer between the detail
display and browse display presentation rules and the SQL rules. Logical Driver performs all complex field-to-field mappings when making calls to
SQL rules. It takes the action that is to be performed on the instance along with the entity instance (the cloned data view) in the input view. If
errors occur, it automatically calls the messaging routine defined by the Message Display template.

Utilities Template

The Utilities template generates a message-handling rule and window for almost any modal message that a rule might need, such as an SQL
failure. The only module included in this template is the Message Display Module. Message Display creates the HPS_MODAL_MESSAGE rule
and window with appropriate hierarchies that have references to sets and components to display any four-line message. You can specify the push
buttons to display through the HPS_MESSAGE_TYPES. The output view returns your response to the message.

Rename Views, Fields and Rules Template

Whenever you must change the name of an existing FIELD or VIEW object, use the Field and View Rename template to automatically modify the
source of any rules that refer to the renamed object.
To change the source of rules that refer to a renamed object, complete the following steps:

Go to Construction Workbench.
Select a single FIELD or VIEW object to rename.
Select  and the  template.Tools > TurboCycler Rename Views, Fields and Rules
When the template displays the Rename window, type the new name for the object.

           It automatically modifies the source of any rules that refer to the object to use the new name. Before finishing, the template shows a list of
the rules it modified.
           The Status pane displays the generation process.

     5. Select  to stop TurboCycler generation.Tools > Stop TurboCycler

Rename Verify Template

The Rename Verify template does not modify any rules or change the name of the selected object. It only shows which rules in the repository
need to be modified if the name of the selected object is changed.
When you rename views that have a window parent, the window panel is not modified at all. The rule source change is a blind search and
replace.

Hierarchy Cloner Template

The Hierarchy Cloner template creates a new hierarchy of repository objects based on an existing hierarchy. The new hierarchy consists of a



mixture of both newly created objects and existing objects from the source hierarchy. Using this template involves the following:

Understanding the Cloning Process
Using the Hierarchy Cloner
Setting Initialization Parameters

For each object in the source hierarchy, cloner relies on pairs of search and replace strings to determine whether it should reuse the existing
object or create a new object based on the existing object.
The Hierarchy Cloner never modifies or has any effect on existing objects in the repository with one exception: while creating the new hierarchy,
cloner can establish a parent/child repository relation between a newly created object and an existing object.

When cloning hierarchies containing error, lookup, or define sets, the encoding and display attribute values are replaced blindly
without error checking for value overflow and such. Make sure that these values do not overflow and are valid.

Understanding the Cloning Process

This section discusses how the cloning process works. Each object that the cloner examines must meet the following conditions to be cloned:

The name of the object must be changed after cloner does string replacement using the strings you supply.
The type of the object must be in the user-specified list of types to clone.

If either of these conditions is not met, the object is reused, and its child objects are not examined.
If the object is to be cloned, the cloner creates a new object of the same type with the cloned name and copies certain properties from the source
object to the cloned object. The new object is attached to the new object hierarchy, and cloning continues by examining children of the source
object. If the cloned object already exists in the repository, it is reused and never modified.
The properties copied are as follows:

Those that are available in TurboCycler
Writable
Not required to be unique by the repository

Thus, the template supplied is general purpose in nature and is not geared specifically to any one type of application hierarchy. If you have
special requirements for cloning, customize the supplied template using the TurboCycler Developer's Kit.

Rollback does not remove all unwanted objects after cloning by TurboCycler.

Using the Hierarchy Cloner

Use the Hierarchy Cloner template from the Hierarchy Diagrammer to clone application hierarchies and to make copies of an existing hierarchy.
To do this, you must identify one or more substrings contained in the names of the existing objects that can be used to guide the cloning process.

If you clone a window with cloning fields, you will lose the link properties of all the objects on the window panel.

The following objects can be cloned:

Function
Process
Rule
File
View
Field
Set
Value
Component
Window
Physical event
Report
Section
Component folder
Bitmap

In addition to these, the cloner reuses BITMAP images, but it does not clone them. COMPONENT FOLDER does not copy or clone external tab
information, and REPORT does not copy or clone the content of the Report. The cloner copies a component source from the original; it does not
clone a component source to a new component.



The information in the Description field, except for COMPONENT and COMPONENT FOLDER, is saved to the repository.
Description field is copied, not cloned.

Because the cloner never modifies existing objects in the repository, subsequent regeneration of this template has no effect.

Always select a single object and choose  from the Analysis menu. Cloner automatically examines allTurboCycler Selected
objects under the selected object. Do not pass multiple objects for cloning.

When cloner executes, a dialog is displayed. Use this dialog to specify settings for the cloned object.

Clone dialog example

The controls and their meanings are listed in the following table:

Cloner Controls and Descriptions

Control Description

Replace (entry field) The substring to search for

With (entry field) The replacement string to use

Add (push-button) Add the new pair of strings to the list

Delete (push-button) Delete the selected pair of strings from the list

Move Up (push-button) Move the selected pair of strings up in the list

Move Down (push-button) Move the selected pair of strings down in the list



Objects to clone (listbox) Objects listed here are candidates for cloning

Objects to reuse (listbox) Objects listed here will never be cloned

Clone (push-button) Begins the cloning process

Verify Once settings have been specified above, 
(Replace XXX With YYY>Add), the Cloner verifies what will be modified When you do the cloning.

Save Settings are saved to Turbo.ini

Cancel Cancels the process and closes the dialog.

When cloner is finished, the new hierarchy is displayed. In this display, you can browse the new hierarchy and see the objects that were created.

Setting Initialization Parameters

The settings entered in the cloner dialog are saved to the CLONER section in the TURBO.INI. This file contains the default settings for the Cloner
dialog ( ):Clone dialog example

[CLONER]
REPLACE=EMPLOYEE COMPANY FIRM
WITH=MANAGER ORGANIZATION COMPANY
TEXT_AND_KEYWORDS=IGNORE
SOURCE_FILES=YES
REUSE=FIELD VALUE COMPONENT
IMPLEMENTATION_NAMES=NO
TRUNCATE_LONG_NAMES=NO

The REPLACE entry contains a series of substrings to search for, separated by spaces. The WITH entry contains one replacement string for each
substring in the REPLACE entry. TEXT_AND_KEYWORDS may be set to:

IGNORE: created objects have no text or keywords
COPY: created objects have the same text and keywords as the source object
CLONE: created objects have the same text and keywords as the source object except modified by the name cloning procedure

If SOURCE_FILES is NO, then created objects have identical source files as the source object; if it is YES then source files are cloned.
The REUSE entry contains a list of object types separated by a single space that are never to be cloned, regardless of their names. The
IMPLEMENTATION_NAMES entry can be either YES or NO depending on whether implementation names and screen literals should be cloned.
When cloner forms a name that is too long, it either automatically truncates the name or displays a dialog asking you to provide a shorter name.
This choice is controlled by the TRUNCATE_LONG_NAMES entry, which can be either YES or NO.

Clone Implementation Names

When you clone a Field, if the  option is not checked, the implementation name is cloned anyway, and otherClone Implementation Names
properties such as screen literals are left unchanged. However, if you check  , the implementation name and theClone Implementation Names
screen literals are cloned. The reference table name is never cloned.

TurboCycler Tutorial
TurboCycler software complements and enhances the AppBuilder environment. Because of their compatibilities, the sample TurboCycler tutorial
is an extension of the AppBuilder environment walkthroughs in the workstation Workbench reference.
The tutorial summarizes the automobile rental agency sample from AppBuilder training and shows the results when you use the TurboCycler
product with the same repository objects. The tutorial that follows assumes that you perform all of the steps for each tool.
If you imported the IVP project into the repository, the ERD and the entities mentioned in this tutorial are all available, so you don't have to create
them from scratch.
The steps are:

Reviewing Forward Engineering and Transforming
Generating with TurboCycler

Reviewing Forward Engineering and Transforming

This section describes the TurboCycler building process. Refer to the AppBuilder  , Developing Applications Guide Development Tools Reference
 , and online help for greater detail about building the models the TurboCycler walkthrough uses.Guide

Defining an Entity Relationship Diagram
Forward Engineering an Entity Relationship Diagram
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Transforming a Database Diagram (DBD)

Defining an Entity Relationship Diagram

The first step in designing your application is to create an Entity Relationship Diagram (ERD). To create an ERD, complete the following steps:

In the Construction Workbench, create a new Entity Relationship Diagram (      ).File > New > Entity Relationship Diagram
Proceed to create the drawing shown in the following figure:

Entity relationship diagram

     3. Select  in the Edit menu; then, select  in the Edit menu to place the objects in the Repository tab in theSelect All Open as Hierarchy
Workbench.

     4. Create the attributes, identifiers, and data types for the IVP_ERD_RESERVATION_ENT, IVP_ERD_CUSTOMER_ENT,
IVP_ERD_IND_CUST_ENT, IVP_ERD_CORP_AGREEMENT_ENT, IVP_ERD_CUST_ADDR_ENT, IVP_ERD_INVOICE_ENT,
IVP_ERD_CONTRACT_ENT entities, as shown in the following figures.

The IVP_ERD_RESERVATION_ENT entity

The IVP_ERD_CUSTOMER_ENT entity



The IVP_ERD_IND_CUST_ENT entity

The IVP_ERD_CORP_AGREEMENT_ENT entity

The IVP_ERD_CUST_ADDR_ENT entity



The IVP_ERD_INVOICE_ENT entity

The IVP_ERD_CONTRACT_ENT entity
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    5. In the Construction Workbench, select  press Ctrl+M, or click the  toolbar button. Name the entity relationship diagramFile > Commit, Commit
IVP_ERD_EX_RESERVATION.

Forward Engineering an Entity Relationship Diagram

This section assumes you have created the Entity Relationship Diagram (ERD) and attributes described in Defining an Entity Relationship
.Diagram

Select the ERD that you just created.
Verify that each relationship has a cardinality symbol at each end.
Choose  in the  menu. Repeat the previous steps if you have errors.Forward engineer Analysis
Create a new Database Diagram (DBD) to view the tables created and their relationships:

Select      . A blank DBD opens.File > New and select Database Diagram
In the new DBD, add a Table object and then double-click the table object. This opens the Insert Table dialog.
Use the Query button to see the tables that have been created and add each of the tables to the DBD.
To show all objects and their relationships, select each of the tables in turn and select  >  (or F8). This will display the tables,Edit Explode
the primary keys, the foreign keys, and the relationships between the entities.

You might have to rearrange the exploded objects so that they are displayed in an orderly and convenient manner.

Tables and keys that forward engineering created
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    5. Select  , press Ctrl+M, or click the  icon. If you have displayed the columns and keys in the DBD, name and save theFile > Commit Commit
drawing.

Transforming a Database Diagram (DBD)

This section assumes that you have created the Entity Relationship Diagram (ERD) and attributes in the ERD as described in Defining an Entity
 and that you forward engineered as described in . The following stepsRelationship Diagram Forward Engineering an Entity Relationship Diagram

populate the repository with information that TurboCycler needs to generate a reference-table application with Views, Rules, and Windows
needed for any application program. To transform a DBD, complete the following steps:

Select  to open the DBD that you have created.File > Open > Database Diagram
Be sure that all tables display in the Database Diagram.
Select  in the  menu.Transform Analysis
The results of the transformation are displayed in the Analysis tab of the Output window.
Right-click  and select   .Repository Insert > File
Query for the file entities created.

Insert File window
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     6. Insert the files into the Hierarchy. You can select several files at a time, then you can click Insert. If you insert one file at a time, click Apply
between each selection and click  when you want to close the Insert File window.Insert

Generating with TurboCycler

The following walkthrough shows how to complete the TurboCycler process using default templates. The steps are:

Editing Screen Literals
Selecting TurboCycler Windows
Preparing the Application
Procedure - Testing the Application

Editing Screen Literals

Transformation generates default screen literals that might require editing. Names are system generated or concatenated from labels that you
entered earlier. The windows generated by TurboCycler benefit from literals edited for brevity, conciseness, or appearance. Rename screen
literals before starting TurboCycler generation.

If you do not edit literals once now, you will need to edit at least four windows later.

To change the screen literal, complete the following steps:

Review each field and display the Object Property window for each field. If it is not already displayed, right-click the field and choose
Properties.
The Object Property window displays as follows.

Properties Field window to alter screen literals
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     2. Look to see the system-generated name in the Screen Literal?Long field of the data views of your files in Hierarchy Diagram.

     3. Edit each literal as necessary to change it permanently.

     4. Select  to save session changes.File > Commit

Selecting TurboCycler Windows

This section assumes that you have created the Entity Relationship Diagram (ERD) and attributes described in Defining an Entity Relationship
 and have followed the rest of the procedures described up to this point. To select TurboCycler for Windows, complete the followingDiagram

steps:

Select the Entity Relationship Diagrammer window.
Select  in the Analysis menu to display the TurboCycler window.TurboCycler
Make sure the templates selected in your window match . Include all availableTurboCycler?Select Generation Templates window
templates (CRUD rules, GUI rules/windows, and utilities). Use the  and  buttons to select the templates for generation.Add Remove
When you have selected the templates, select the  push button in the Select Generation Templates window.Setup Templates

TurboCycler-Select Generation Templates window



This displays the TurboCycler?Generation Template Setup window, which lists the modules available for each object type shown.

     5. Select  in the Object Type list box and  in the Generation Template list box. Then select the modules for generation usingEntity CRUD Rules
the  and  buttons.Add Remove

     6. Check all generation templates to make sure you select all the available modules for every template.

TurboCycler-Generation Template Setup window

     7. Select  .Close

     8. If you have selected the appropriate entity templates and the modules that support it, select the  button to start generation in theGenerate
TurboCycler dialog ( ).TurboCycler-Select Generation Templates window

The message line shows the status of the process. If there are errors, repeat the process.

     9. Select  to save changes.File > Commit
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Preparing the Application

After generating and committing your output, make additional modifications and programming changes and continue the process as usual with the
preparation from the Construction Workbench. To prepare an application, complete the following steps in the Preparation Query window:

Select Generated files:

Delete the inappropriate tables.
Prepare files.
Create appropriate tables.

     2. Select Generated Sets: prepare sets

     3. Select Generated Windows: prepare windows

     4. Select Generated Rules: prepare rules

     5. Select Generated Functions: prepare functions

At this point, the preparation of the generated application is complete. Next, run the application (as described in Procedure - Testing the
) to examine and test the output application, including the windows you prepared and painted in TurboCycler.Application

Procedure - Testing the Application

Complete the following steps to test the application TurboCycler generated:

Select    .Start > Programs > AppBuilder > Execution Clients > Windows Client
To execute from within the Construction Workbench, select  .Run > Windows
Select  in the menu.Agent Maintenance
The Execution Workbench asks if you want to start RuleView. Select  .No
The Agent Detail Display window is displayed without any data.
Type test data in the displayed fields.
Select  to save this agent data.File > Save
Type any name (for example, your own name) as additional test data in the Agent Detail Display window. Be sure to assign a different
agent number. Save this data as you did in the previous step.
Select  in the  menu to see the Agent List Display window.Open File
Select the  push button to display both agents.Query
Select  and verify that both agent Smith and the other person's name appear in the Agent List Display window. (You can eitherQuery
query individual agents by their unique number or select the Query push button to see a list of all agents.)
To view the Agent Detail window for any agent, double-click the name of the agent. When you close the Agent Detail window, you return
to the Agent Detail Display window.
To exit, select File >  .Exit

Using TurboCycler Developer Kit

Using the TurboCycler Developer Kit

The TurboCycler Developer Kit provides an open architecture for automatically generating repository objects suitable for any platform and
methodology. TurboCycler Developer Kit is a complementary product to the TurboCycler Standard Edition. With the Developer Kit, you define
generation procedures using templates to automate steps in the software development lifecycle. You can write these generation procedures to
meet your requirements.
To customize the template using the TurboCycler Developer's Kit, follow these general procedures:

Creating a Generation Template
Editing and Compiling a Template

Creating a Generation Template

Creating a Generation Template

TurboCycler generation templates are the procedures executed during a TurboCycler process. Use the TurboCycler template language to define
a template and make generation decisions about what objects to generate in the repository. This involves the following:

Understanding the Generation Template
Customizing the Generation Template



Understanding the Generation Template

TurboCycler generation templates can access any object in the repository. For each object, the template can access all the editable properties of
the object type.  discusses the complete list of object types and properties that TurboCyclerTurboCycler Repository Types and Properties
supports in the Information Model.
A generation template must navigate through the repository to retrieve the information it needs to make generation decisions. For example, a
template defined to generate an SQL Delete Rule for an AppBuilder file object needs information about the file, including information about the
fields in the primary view. The template traverses the file hierarchy to obtain all the information it needs to generate the SQL Delete Rule.
A generation template can define object hierarchies, rules source code, and window panels, as shown in .Functionality of Generation Templates
You can generate a completely functional application by using these templates in the AppBuilder environment.

Functionality of Generation Templates

When building an object hierarchy, the generation template generates both the repository objects and the relationships between them and sets
their properties. Templates can generate any type of object hierarchy including AppBuilder file, rule, and window hierarchies.
When defining rule source code, the generation template completely defines an AppBuilder rule. The source code associated with the rule can
include any statement that the AppBuilder environment supports and can conform to your indentation and naming standards.
Window panels generated from a template can contain any type of control that the AppBuilder Window Painter supports. The template defines the
position of the controls in the window and associates them with objects in the repository.  discusses the types ofTurboCycler Window Controls
controls for window panels and their properties.

Customizing the Generation Template

If an existing generation template does not generate objects, rules, or windows matching your requirements, you can create a new template or
edit an existing template.
If you decide to create a new template, identify the repository information you need to make generation decisions and then identify those objects,
rules, and windows that you are trying to generate. This information helps you design your new generation template efficiently.
If you change an existing template, you can change its object-naming standards, rules coding style and functionality, window presentation styles,
and nearly anything else you want.

Default templates packaged with TurboCycler are not read-only or otherwise protected. Copy them before editing them and
compile the template before running it.



Editing and Complying a Template

Editing and Compiling a Template

Use the template editing environment to edit and compile templates. You can prepare templates by creating new ones or by changing existing
ones. You must successfully compile templates before distributing them to end users or running them from the AppBuilder Construction
Workbench. This involves the following:

Understanding the Environment
Using the Command Line Compiler
Using the Template Compiler

In editing templates, the person who uses the results of your template programming is the  . The person who programs the output of youruser
template is the  .developer

Understanding the Environment

The TurboCycler editing environment provides an interface for using your editor to edit template source files and two ways to compile templates.
TurboCycler keeps all the templates in a single directory. You designate which directory to use. Source files for templates must have a file
extension of .SRC and compiled templates have .TC.
TurboCycler Developer's Kit provides two compilers: a DOS command line compiler and a template compiler.

Using the Command Line Compiler

The only function available at the command line is the ability to compile a source file (.SRC) to a template compile output file (.TC). The command
line compiler has the name TCC.EXE, and its syntax is:

TCC <Source> [<source>]

where:
 = template source file name without the .SRC extension.<source>

You specify only the file name because the .SRC file extension is assumed.
All other functions described in the following sections are available only through the template compiler.

Using the Template Compiler

Use the template compiler to edit and compile templates interactively. It has a multi-threaded compiler that compiles templates in the background
while you perform other work.

Procedure - Opening the template compiler

To open the template compiler, complete the following steps:

Select Start > All Programs > AppBuilder > TurboCycler Development Kit.

The Template Compiler window opens ( ).TurboCycler Template Compiler window

TurboCycler Template Compiler window

The main window for the template compiler contains a title bar identifying the template compiler window, a menu bar, a toolbar, and a work area
with template information.



Template Compiler Tools

The following sections describe the menu options available for Template Compiler:

Actions Menu
Selected Menu
Windows Menu
Options Menu
View Menu
Toolbar

Actions Menu

The menu bar contains an Actions menu, shown in .Template compiler Actions menu

Template compiler Actions menu

Actions Menu Choices describes the Actions menu choices. Each Actions menu choice effects all listed templates, not just those currently
selected.

Actions Menu Choices

Actions Description

New
Template

Displays the New Template window ( ) that helps you prepare a new skeleton or outline template. You canNew Template window
define the file name, template title, and description; create hierarchy, rule, window, text, keywords, flat file, and component sections;
and edit the template. You can also select this choice from the toolbar with the  push button.New

Make Compiles every template source file whose last write time is later than its last compile time. You can also select this choice from the
toolbar with the  push button.Make

Rescan
source
directory

Clears the list of templates shown and rereads the template source directory. You can also select this choice from the toolbar with
the  push button.Rescan

Stop
compiling

Removes any templates waiting for compilation from the compile queue. Compiling stops when the current template completes.
You can also select this choice from the toolbar with the  push button.Stop

Exit Exits the template compiler.

New Template window



Selected Menu

The menu bar contains a Selected menu, shown in .Template Compiler Selected menu

Template Compiler Selected menu

Selected Menu Choices describes the Selected menu items and descriptions. These menu choices affect only the selected templates.

Selected Menu Choices

Menu
Item

Description

Edit
source

Opens the editor for the selected templates. (Depending on options set in the Set Editor window, you can open the editor once for
each selected template or once for all selected templates.) You can also select this choice from the toolbar with the  pushEdit
button.

Compile
source

Queues the selected templates and compiles them in the order they appear in the window. You can also select this choice from the
toolbar with the  push button.Compile

Copy
source

Opens the Copy Template window ( ), which enables you to copy each of the selected templates and to giveCopy Template window
the copy a name and title. You can also select this choice from the toolbar with the  button.Copy



Delete
template
files

Deletes the source and compiled files for all selected templates. You can also select this choice from the toolbar with the Delete
button.

Update
display

Rescans the source files of the selected templates to check whether the title or last-written times have changed. (Use this when you
use the editor to make changes to a template.) You can also select this choice from the toolbar with the  button.Update

Copy Template window

Windows Menu

The menu bar contains a Windows menu, shown in .Template Compiler Windows Menu

Template Compiler Windows Menu

The Compiler messages choice displays a window that shows template compilation and error messages.

Options Menu

The menu bar contains an Options menu, shown in .Template Compiler Options menu

Template Compiler Options menu

Options Menu describes the Options menu choices and describes their behaviors.

Options Menu



Menu
Items

Description

Template
directory

Displays the Open Template Directory window ( ) that specifies the directory where templatesOpen Template Directory window
reside on the developer's system.

Default
action

Specifies the action to be performed when you double-click a template or press  . The choices are Edit, Compile, Copy,Enter
Delete, and Update display.

Editor Opens the Set Editor window ( ) in which you can specify your editor. The editor command field defines theSet Editor window
executable path name, and the editor command line field specifies the command line arguments to pass to the editor. If your editor
supports passing multiple file names on the command line, use the %a specifier. Otherwise, use the %f specifier to open the editor
separately for each selected template. You can also specify any other options to pass to the editor.

Open Template Directory window

Set Editor window

View Menu



Use the View menu to choose whether to display the toolbar and the status bar while you are working in the template compiler window. To display
either bar, click the name of the bar in the drop-down list. A check mark appears. To hide either bar, click again to remove the check mark.

Template Compiler View menu

Toolbar

For fast access to the Actions and Selected menu choices, use the toolbar at the bottom of the template compiler window (Template Compiler
).toolbar

Template Compiler toolbar

The toolbar presents the menu choices as push buttons ( ).toolbar Push Buttons

toolbar Push Buttons

Icon Push button Menu choice equivalent

Edit Edit source choice in Selected menu

Compile Compile source choice in Selected menu

Make Make choice in Actions menu

Stop Stop compiling choice in Actions menu

Copy source Copy source choice in Selected menu

New template New template choice in Actions menu

Delete template files Delete template files choice in Selected menu

Update display Update display choice in Selected menu



Rescan source directory Rescan source directory choice in Actions menu

Template Compiler Work Area

The work area has a row for every template in the template directory.  lists the information for each template.Template Compiler Work Area

Template Compiler Work Area

Dialog
columns

Descriptions  

Status
icons

Four icons indicate template status. Each template displays one icon indicating its status:  

  Source

  Compiled

  Compilation in
progress

  Queued for
compilation

Template
title

The assigned title of the template.  

Filename The file name of the template as stored in the designated directory. (Preassigned file extensions are .SRC for a
source template and .TC for a compiled template.)

 

Last write
date

The date of the last template writing.  

Last write
time

The time of the last template writing.  

Last
compile
date

The date of the last successful template compilation.  

Last
compile
time

The time of the last successful template compilation.  

TurboCycler Template Language

TurboCycler Template Language

The TurboCycler template language defines how to generate repository objects from other repository objects. The logic of a template can include
standard language statements (such as IF?ELSE and WHILE) and more specific TurboCycler statements. TurboCycler statements support
repository navigation, queries, and generation.
This section presents the important high-level concepts for developing templates, followed by the rudimentary statements. If you are not familiar
with basic programming techniques, you might need to review those sections in the supporting statements and structures section before learning
the template sections and concepts.



1.  
2.  

3.  

You can find detailed information about language usage, syntax, and function of the AppBuilder Rules Language in the Rules Language
  .Reference Guide

Flow Diagrams Overview

Flow Diagrams define the syntax of the template language. The syntax is shown in flow diagrams that show how the parts of the template
language relate and how to use each statement.

Using Conventions and Symbols
Reading a Diagram
Inserting Multiple-line and Single-line Comments

Flow diagrams might not illustrate every condition and restriction of each statement. Read the description of each statement for
complete information.

Using Conventions and Symbols

The following conventions and symbols appear in the syntax flow diagrams:

A WORD in all capital letters is a template language keyword.
A word not capitalized or italicized is defined in another flow diagram.
A "word" in quotations is a value from outside the template language that you must provide when you code the statement, such as the
name of a field or a string literal.

Symbols Used in Syntax Flow Diagrams

Symbol Description

Flow of statement starts

Flow continues on next line or may include other path

Flow continued from previous line

Flow can branch in either direction

Flow of statement ends

Reading a Diagram

Complete the following steps to understand the syntax of a diagram:

Start at the double-headed arrow on the left side and go to the end of the diagram.
Follow any one of the possible line paths from left to right. Any path that you can traverse from left to right results in valid syntax. In
whichever line you follow, you must use all words or symbols that you move through on that line.
You cannot go back to the left unless there is a loop, which is indicated by an arrow on its left end and appears above another line. You
can go around a loop any number of times.

Statement Sample

This sample shows a simple flow diagram. It illustrates the basic approach that the TurboCycler flows follow:



Inserting Multiple-line and Single-line Comments

To enter comments, use the // token that ends with a new line character.

Both the // token and the new line are discarded from the input. For example:

USE FIELD(x)
// Get the name of the field
SET Y = QUERY NAME OF X
ENDUSE

Temlate Language Statements

This section contains the flow diagrams for the TurboCycler template language statements. It has two parts. The first part describes the template
statements, and the second part describes supporting statements.
Follow the flows as described above and read the explanations for details and programming techniques.
The template statements contain the language flows for the following:

TEMPLATE Statement
USAGES Block
HIERARCHY Block
RULE Block
WINDOW Block

There are also  and .Other Blocks Supporting Statements and Expressions

TEMPLATE Statement

The TEMPLATE statement is the starting point of a TurboCycler template. It provides the template with a title and description, by which the user
identifies the template during the TurboCycler Standard Edition generation process.
A template contains only one TEMPLATE statement and has a unique name. A template also contains a usages block that determines the
initiation process for this template. A template can contain multiple hierarchy, rule, and window blocks grouped in modules by a common module
name.

"template_name"

A string constant that identifies this template. This is the title of the template that the user sees during a TurboCycler Standard Edition generation.
For example, the CRUD Rules default template is named "CRUD Rules."

DESCRIPTION?ENDDESCRIPTION

Keywords that surround the "template description."

"template_description"

A string constant that describes this template. This is the only description for a template that the user sees during a TurboCycler generation. For
example, the default template named CRUD Rules has the description "Generates the CRUD Rules for the specified Entity, Table or File object."
The description can be as short or long as you want; it may include multiple lines.



usages_block

A template language statement that provides the entry point that TurboCycler uses to run the template. In most cases, TurboCycler starts with a
single repository object and proceeds to extract information about that object needed to generate hierarchies, rules, or windows. Entry points for
the default templates are entity, a many-to-many relationship, table, and file.
A usages block takes a single object and performs assorted repository queries. It sets up variables on which other blocks depend. Refer to 

 for details.USAGES Block

hierarchy_block

A template language statement that defines a hierarchy for any object type, such as rule hierarchy, window hierarchy, file hierarchy, and other
hierarchies. The hierarchy block creates objects, sets their properties, creates relationships between objects, and sets properties for the
relationships. Refer to  for details.HIERARCHY Block

rule_block

A template language statement that defines the source code or rules source for a specific rule. For example, the SQL Delete Rule in the CRUD
Rules Template. Refer to  for details.RULE Block

window_block

A template language statement that paints a window panel for a specific window; for example, the Detail Display Window in the GUI
Rules/Window Template. The window block places controls on the window and establishes links to appropriate repository objects. Refer to 

 for details.WINDOW Block

Special Notes

Different blocks can be strongly dependent on each other. For example, generated rule source depends on a rule hierarchy. You can force
multiple blocks to be generated by giving them all the same module name, thus reinforcing their dependence.
Another example of block interdependence is a rule conversing a window. Using a template to generate a rule conversing a window requires four
heavily dependent blocks:

Rule source block
Window panel block
Rule hierarchy block
Window hierarchy block

Reinforce this dependence by giving all the same module name.  shows this relationship.Example of mutually dependent module blocks

Example of mutually dependent module blocks



USAGES Block

The usages block accepts specified repository object types as valid entry points into the generation process that the template describes. It
associates the current template with repository objects of the object types you specify. Control which objects are selected for generation with the
USAGES statement. TurboCycler generates output objects only for the object types you specify in the usages block.

Thus, your selection influences the tools from which you can access this template. For example, if you define a template to accept entities as
input, the template is available from only those tools supporting entities, such as Entity Relationship Diagrammer, Hierarchy Diagrammer, and
Matrix Builder.

USAGES...ENDUSAGES

Keywords that surround the usages block.

USE...ENDUSE

Keywords that surround your specification of a valid object type, object variable, and use_statement. Each USE...ENDUSE set supports only one
"object_type" specification. Repeat this set of keywords for each object type that you want the template to support.

object_type

The object type from which you want this template to support generation. Any object type in the Information Model is valid, such as RULE,
WINDOW, VIEW, or FIELD. You can select more than one object type by using multiple USE?ENDUSE repetitions, as shown in the flow diagram.
Refer to  for a list of object types.Object Types and Properties
The object type can also be an open drawing. The USE type supports processing the symbols on an open drawing through a template. Refer to 

 for details.Processing Symbols on an Open Drawing

(object_var)



An object variable that stores a reference to the repository object passed into the template from an AppBuilder development tool.

use_statement

A sequence of statements that are part of the usages block. These statements insert the common statement services of use-dependent queries
and variable initializations such as RETURN, DEBUG, IF, FOR, WHILE, and SET. See .common_statement

USE ALL...ENDUSE

Keywords that surround your specification of all shared use statements in a usages block. The use statements contained in the USE
ALL?ENDUSE set are applied to each USE?ENDUSE set. Use this statement to code any function that you want applied to all USE?ENDUSE
invocations only once. The generation process then executes the complete set for each USE?ENDUSE set defined in the usages block.

common_statement

A sequence of statements common to several block statements including this one. The common statement provides common services for
use-dependent queries and variable initializations such as RETURN, DEBUG, IF, FOR, WHILE, and SET. Refer to  forCommon Statement
details.

HIERARCHY Block

The hierarchy block defines a hierarchy for any object type such as a rule hierarchy, window hierarchy, or file hierarchy. The hierarchy block
creates objects and sets properties for them, creates relationships between objects, and sets properties for those relationships.

The hierarchy block that TurboCycler generates closely resembles the hierarchy that AppBuilder prepares in both content and form in the
following respects:

Create repository objects
Set properties for those objects
Create relationships between objects
Set properties of the relationships

Double Arrow in Hierarchy Block

If the first arrow statement in a hierarchy block consists of a single arrow and the object named already exists in the repository, TurboCycler
deletes all existing relations to child objects. This feature allows the template to control precisely what objects the hierarchy contains. This feature
can be undesirable, however, if the template is meant to update an existing object without disturbing existing child relations. In this case, you
should begin the hierarchy with two arrows instead of one.
After executing the following block, the rule named TEST is guaranteed to have only the view VIEW1 as a child:

HIERARCHY "Example"
RULE "TEST"
VIEW  VIA RELATION OWNS_VIEW"VIEW1"
ENDHIERARCHY

Alternatively, the following block simply appends the view VIEW1 as a child of the rule TEST without disturbing any existing children.



HIERARCHY "Example"
RULE "TEST"
VIEW  VIA RELATION OWNS_VIEW"VIEW1"
ENDHIERARCHY

Comparison of AppBuilder and TurboCycler hierarchies compares a hierarchy diagram and TurboCycler, and shows their similarities.

Comparison of AppBuilder and TurboCycler hierarchies

HIERARCHY...ENDHIERARCHY

Keywords that surround the hierarchy block.

"module_name"

A string constant that provides the name for the module to be generated. The name must be a unique phrase that accurately distinguishes this
module from any other. The user of a template selects the module for generation using the TurboCycler Setup Generation Templates window.

hierarchy_statement

A sequence of statements that are part of the hierarchy block. These statements insert the unique hierarchical statements for creating entities and
templates. The hierarchy_statement also inserts the common statement services of hierarchy-dependent queries and variable initializations such
as RETURN, DEBUG, IF, FOR, WHILE, and SET. Refer to .common_statement

->

A hierarchy symbol that establishes the generational level for the following definition of an object.

object_type

A parameter that defines the type of object being generated. Refer to  for a list of object types.Object Types and Properties

object_name

Either a string expression or an object expression that specifies the name of the object being generated.

[...]



A set of brackets encloses properties of the object that are to be set.

,

Use a comma to separate each object property expression (see  below).object_property_expr

object_property_expr

An object property expression that sets the property of the object to the specified value. Refer to  for a detailed list.Object Types and Properties
The format for this statement is PROPERTY = string_expr or PROPERTY = int_expr.

VIA RELATION

A keyword that creates the relationship for the object and specifies how the child object is to be related to the parent object.

relation_type

A parameter that defines the type of relationship for the object. Refer to  for a detailed list.Relationship Types and Properties

relation_property_expr

A parameter that sets the properties of the relationship to the specified value. Refer to  for a detailed list. TheRelationship Types and Properties
format for this statement is PROPERTY = string_expr or PROPERTY = int_expr.

common_statement

A sequence of statements common to several block statements including this one. The common statement provides common services for
hierarchy-dependent queries and variable initializations such as RETURN, DEBUG, IF, FOR, WHILE, and SET. Refer to  forCommon Statement
details.

RULE Block

The rule block defines the rules source code for a specific rule. An example of a rule block is the SQL Delete Rule in the CRUD Rules Template. If
the repository already has existing source code for a specified rule, any code you generate with an identical name overwrites the existing code.

The rule block creates rule source code as well as all common template statements for manipulating variables, looping and branching, returns,
and debugging. You can recognize rule source by the curly braces that enclose it.
Everything you write within the curly braces goes into the rule code, either directly as rule source code or indirectly by macro substitution.

RULE...ENDRULE

Keywords that surround the rule block.

"module_name"

A string constant that provides the name for the module to be generated. The name must be a unique phrase that accurately distinguishes this
module from any other. Select the module for generation using the TurboCycler Setup Generation Templates window.

NAMED

Keyword that specifies the rule that the "rule_name" parameter identifies.

rule_name



Either a string expression or object expression that identifies the rule to be generated in the repository.

rule_statement

A sequence of statements that are part of the rule block. These statements include the unique "curly braces" rules code and the common
statement services of rule-dependent queries and variable initializations such as RETURN, DEBUG, IF, FOR, WHILE, and SET. Refer to 

 below.common_statement

{...}

Curly brace symbols indicate that the enclosed statements are rules code. Rules code can be a single statement or multiple statements. The
source of rules code is either direct as a copy from the template (see ) or indirect from a substitution macro (see rule_source $(substitution_macro)
).

rule_source

Everything that is enclosed in braces, except the $(substitution_macro) format, is put directly into rules code. Code the Rules Language statement
that you want incorporated. See  for more information.Special Notes

$(substitution_macro)

Everything that is enclosed in the "$... " format becomes rules source code by macro substitution. Use this statement to place the value of
template variables or expressions into the rules source. See  below for more information.Special Notes

common_statement

A sequence of statements common to several block statements including this one. The common statement provides common services for
rule-dependent queries and variable initializations such as RETURN, DEBUG, IF, FOR, WHILE, and SET. Refer to .Common Statement

Special Notes

The RULE and NAMED keywords identify the name of the module for the TurboCycler user and rule object to be added to the repository. For
example, the statement:

RULE  NAMED "SAMPLE" "B"

creates a module called SAMPLE, which generates rules source code for object B in the repository. If source code exists for object B, the new
rule source overwrites the existing code.
If a template has more than 72 characters of rules source per line, TurboCycler breaks each line at the last blank space before the limit, making
as many lines as necessary to contain the code.
To create rules source code, code inside the curly braces, including any macro substitutions. The position of curly braces determines the
indentation of the rules source code, as shown in the following example. (Refer to  for a detailed sample of a real rule sourceTemplate Samples
generation.)

RULE  NAMED "Sample" "B"
SET V = GET VIEW NAMED "V1"
\{ *> Rule generated by TurboCycler <*)
\}
SET FROM = 10
\{ DCL
I INTEGER;
ENDCL
MAP $(FROM) TO I
MAP $(FROM + 20)
TO RETURN_CODE OF $(QUERY NAME OF V)
\}
ENDRULE

TurboCycler generates the following rules source code:



*> Rule generated by TurboCycler <*
DCL
I INTEGER;
ENDCL
MAP 10 TO I
MAP 30
TO RETURN_CODE OF V1

Object Property Comparisons

All comparisons to object properties in the retrieval clause are case insensitive. For example, the following statement retrieves the VIEW object
named V1:

SET V = GET VIEW NAMED "V1"

Properties are not converted to upper case during reads and writes.

Property Value Expression Types

Property values are converted to the same expression type as the query value in HAVING and WITH clauses. For example, the following
expression works as expected.

SET X = CHILD FIELD OF VIEW HAVING \[LENGTH = 33\]

WINDOW Block

The window block paints a window panel for a specific window, such as the Detail Display Window in the GUI Rules/Window Template. The
window block places controls on the window and links them to appropriate repository objects.

Building menus in a window is similar to making menu hierarchies with the Window Painter menu editor. The statements in a window block
specify window panels in a way that corresponds to the Window Painter graphic interface. For example, the window block MAKE statement
corresponds to dropping controls in Window Painter. However, TurboCycler does not support creating or updating cascading menus from the



template.
The PLATFORM keyword and its parameter window_platform specify the GUI target of the window. The default value is PWS_GENERIC.
You can create 3270 or other types of window panels, but you must observe documented AppBuilder restrictions on those panels.
The following example shows how to code a window block statement that constructs a menu. The example creates a menu for the File item,
consisting of lines for New, Save, and Exit, each of which has a separator between them.

REM --- Generate a sample window \---;
WINDOW  NAMED MyDetailSample"Sample Window"
SET MyCDV = GET VIEW NAMED MyClonedDataView
REM --- Make the Detail Sample Display \---;
\-> MENUITEM "&File"
\-> \-> MENUITEM  \[HPSID= \]"&New" "New"
\-> \-> SEPARATOR
\-> \-> MENUITEM  \[HPSID= ,GREYED= \]"&Save" "Save" "TRUE"
\-> \-> SEPARATOR
\-> \-> MENUITEM  \[HPSID= \]"&Exit" "Exit"
ENDWINDOW

See  for detailed coding of template windows.Template Samples

WINDOW...ENDWINDOW

Keywords that surround the window block.

"module_name"

A string constant that provides the name for the module to be generated. The name must be a unique phrase that accurately distinguishes this
module from any other. The user of a template selects the module for generation using the TurboCycler Setup Generation Templates window.

NAMED

Keyword that specifies the window that the "window_name" parameter identifies.

window_name

Either a string expression or object expression that names the window to be generated in the repository.

window_statement

A sequence of statements that are part of the window block. These statements include the window block-specific statements as well as the
common statement services of window-dependent queries and variable initializations such as RETURN, DEBUG, IF, FOR, WHILE, and SET.
Refer to .scommon_statement

->

A menu hierarchy symbol that establishes the generational level for the menu item entry.

MENUITEM

A keyword that starts the text for a menu line and assigns its properties.

"menu_text"

The menu text (a string expression) that provides the text of a menu line.

[...]

A set of brackets that enclose properties of the menu item to be set.

menu_property

This statement sets the properties associated with a menu item. Refer to the following flow diagram for the parameters of this variable.



SEPARATOR

A keyword that creates a horizontal divider in a list of menu lines.

MAKE...ENDMAKE

A set of keywords that makes a control on the window. You can also define the properties of the control and link it to a repository object in the
MAKE...ENDMAKE statement.

control_type

A parameter that describes the kind of window control being generated. Refer to  for details of control types.Window Statement Control Types

control_var

A control variable that stores a reference to a window control and gives access to the control later; essentially it names the object being created
by the MAKE. Use it with functions like LEFTOF or BOTTOMOF.

HAVING

A keyword that sets the properties for the window controls. Each control type has its own properties defined by the parameter following
"control_property_expr".

control_property_expr

A parameter that defines the properties for the window control. Refer to  for the detailed parameter list of the propertiesWindow Control Properties
of window controls. The format of this expression is PROPERTY = string or PROPERTY = integer.

LINKED TO

A keyword that connects the control being created to an existing repository object. You can link controls only to objects that are descendents of a
window view.

link_object

An object expression that names the repository object associated with the made control object being created.

OF

A keyword required when the link to a control is a descendent that is not a direct child of the window view. Each level needed to link to a direct
child of the window view requires an OF keyword. Use the OF statement multiple times to link to the appropriate level of the window view.

link_qualifier

An object expression that identifies the descendent of the window view for which the link is being made.

CONTAIN?ENDCONTAIN

A set of keywords that also define the type, name, and properties of a window control object. The CONTAIN statement makes a window control
within a previously defined control. Use CONTAIN to make CELLS in a SPREADSHEET or to define the axes of a CHART. The format of these
parameters is the same as the MAKE keywords.

IN

A keyword that identifies the parent control of the contained control.

parent_control

A control variable that names the parent control object of the contained control being defined.

SIZE WINDOW

A keyword that defines the dimensions of the window being generated.

window_width

An integer expression giving the width of the window in pixels.

BY



A keyword that indicates another window dimension follows.

window_height

An integer expression giving the height of the window in pixels.

POSITION WINDOW

A keyword that defines the location of the window being generated.

left_corner

An integer expression that locates the left side of the window being generated.

bottom_corner

An integer expression that locates the bottom of the window being generated.

scommon_statement

A sequence of statements common to several block statements including this one. The common statement provides common services for
window-dependent queries and variable initializations such as RETURN, DEBUG, IF, FOR, WHILE, and SET. Refer to  forCommon Statement
details.

Other Blocks

These include:

COMPONENT Block
FLATFILE Block
KEYWORDS Block
TEXT Block
USE ANY Block
DIALOG Block

See also the .Supporting Statements and Expressions

COMPONENT Block

This block is available for composing the source of a COMPONENT. Its syntax is:

The statements supported are the same as for the RULE block statement. For details, refer to the .RULE Block

FLATFILE Block

This block is available for composing text files. Its syntax is:

The statements allowed are the same as for the RULE block statement. For details, refer to the .RULE Block

KEYWORDS Block

This block is available for composing the KEYWORDS of an object. Its syntax is:



The object_expr translates to the repository object for which the KEYWORDS are to be written. The statements allowed are the same as for the
RULE block statement. For details, refer to the .RULE Block

TEXT Block

A new block is available for composing the TEXT of an object. Its syntax is:

The object_expr translates to the repository object for which you are writing the TEXT. The statements allowed are the same as for the RULE
block statement. For details, refer to the .RULE Block

USE ANY Block

This type of USE block accepts any object type for processing. The syntax of the USE ANY statement is:

If you use the USE ANY?ENDUSE block, put it after all your USE?ENDUSE blocks and before the USE ALL?ENDUSE block.

DIALOG Block

A block type is available for composing user dialogs. The block is:

DIALOG "module_name"

// Dialog statements
ENDDIALOG
Use the DIALOG block to prepare and display a dialog box to the user while the template is running. This can be used to ask questions of the
user and to display the results of the generation process.

Specifying Size and Position of User Dialogs and Controls

You can specify the size and position of user dialogs and controls by specifying their coordinates in dialog units. A dialog unit is defined as 1/8 of
the average height of the system font and 1/4 the average width of the system font. In other words, there are about 4 dialog units for every
character width you specify, and 8 dialog units for every character height. For example, if you wanted to create a dialog that was 40 characters in
width and 50 characters in height, you would make the width 160 units and the height 400 units.

Creating Controls on a Dialog

Create controls on a dialog using the MAKE...ENDMAKE statement as used in the WINDOW block. All of the controls can be assigned to a
variable, and any of the properties can be queried using the QUERY statement. Some of the controls can have a LINKED TO clause, which is
always optional. Unlike the WINDOW block MAKE statement, the LINKED TO clause must always specify a template variable.
You can use the HAVING clause of the MAKE statement to set the properties of dialog controls. You can also set these properties using the new
SET PROPERTY OF VARIABLE function.

Setting Properties of Dialog Controls

The following table lists the properties of the dialog controls and describes the characteristics of those properties. An N in the table means
Microsoft Windows.

Dialog Control Properties



  A

U

T

O

S

C

R

O

L

L

B

O

R

D

E

R

B

O

T

T

O

M

C

O

N

T

O

L

_

T

E

X

T

C

T

L

3

D

D

E

F

A

U

L

T

G

R

O

U

P

S

T

A

R

T

H

E

 I
G

H

T

H

O

R

Z

S

C

R

O

L

L

H

P

S

 I
D

L

E

F

T

M

A

R

G

 I
N

M

U

L

T

 I
P

L

E

_

S

E

L

E

C

T

 I
O

N

P

A

S

S

W

O

R

D

R

E

A

D

O

N

L

Y

T

A

B

S

T

O

P

V

E

R

T

S

C

R

O

L

L

W

 I
D

 T
H

W

O

R

D

W

R

A

P

CHECKBOX     N N     N N   N N         N   N  

EDIT_FIELD N N N N N   N N N N N N   N N N   N  

GROUPBOX     N N     N N   N N         N   N  

LISTBOX     N N N   N N N N N   N     N N N  

MULTILINE_EDIT N N N N N   N N N N N       N N N N N

PROTECTED_EDIT_FIELD   N     N                            

PUSH_BUTTON     N N   N N N   N N         N   N  

RADIO_BUTTON     N N     N N   N N         N   N  

STATIC_TEXT     N N     N N   N N         N   N  

Dialog Control Property Descriptions

Property Type Description

AUTOSCROLL boolean Control scrolls right automatically. Also scrolls down for Multiline Edit.

BORDER boolean Gives the control a border.

BOTTOM integer Sets the vertical position of the bottom edge of the control.

CONTROL_TEXT string Text displayed by the control.

DEFAULT boolean Button has heavy emphasis.

GROUPSTART boolean Used primarily to group radio buttons.

HEIGHT integer Sets the vertical size of the control.

HORZSCROLL boolean Control has a horizontal scroll bar.



HPSID integer Allows the template to recognize the control.

LEFT integer Sets the position of the control.

MARGIN boolean Gives the control a border.

MULTIPLE_SELECTION boolean Multiple items can be selected.

PASSWORD boolean Text is invisible.

READONLY boolean Text cannot be altered.

TABSTOP boolean User can tab to the control.

VERTSCROLL boolean Control has a vertical scroll bar.

WIDTH integer Sets the horizontal width of the control.

WORDWRAP boolean Text automatically wraps.

Using Linked-to Variables

The control types in the following sections can have a linked-to clause. The linked-to clause is always optional. The linked-to clause must always
specify a template variable.

CHECKBOX

The button is checked if the linked variable contains the value "TRUE," otherwise it is unchecked. After the dialog is closed, the variable contains
either the value "TRUE" or "FALSE," depending on whether the user checked or unchecked the button.

RADIO_BUTTON

The button is checked if the linked variable contains the HPSID of the RADIO_BUTTON. After the dialog is closed, the variable contains the
HPSID of the button only if it is checked. Normally, you link several mutually exclusive RADIO_BUTTONS to a single variable. Then, the variable
will contain the HPSID of the RADIO_BUTTON that the user selects before closing the dialog.

EDIT_FIELD

The text displayed in the EDIT_FIELD is taken from the linked variable. After the dialog is closed, the linked variable contains the modified text.

MULTILINE_EDIT

The text displayed in the MULTILINE_EDIT is taken from the linked variable. After the dialog is closed, the linked variable contains the modified
text.

LISTBOX

The linked variable must be list. The LISTBOX is populated using the items of the list variable. When the dialog is closed, the variable is modified
to contain a list of the selected items from the LISTBOX.

If the LINKED_TO variable has not been assigned a value, it defaults to the LOCAL variable.

Using the TCDIALOG Variable to Set the Properties of the Dialog Window

TurboCycler creates a local variable named TCDIALOG upon entry into a dialog block. This variable represents the dialog window itself, and the
following properties can be set using this variable:

LEFT, for setting the left edge of the dialog
BOTTOM, for setting the bottom edge of the dialog
TOP, for setting the top edge of the dialog
WIDTH, for setting the width of the dialog
HEIGHT, for setting the height of the dialog
CONTROL_TEXT, for setting the caption displayed on the dialog title bar

Processing the Dialog

After using MAKE statements to define the dialog, use the SHOW DIALOG statement to display the dialog to the user. When you close the dialog,
TurboCycler creates a local variable named TCEVENTSOURCE that contains the HPSID of the push button that closed the dialog.



If you are running Microsoft Windows 2000, if you press the  key, the TCEVENTSOURCE variable is assigned the value ofEsc
IDCANCEL.

Template Block Features

Template Block Features

The template language involves the following procedures:

Declaring Local Variables from Any Block
Making Any Block a Callable Procedure

Declaring Local Variables from Any Block

Any block can declare local variables immediately after the first line of the block. Each local variable must be given an initial value. Here are two
examples:

HIERARCHY "Test"
USES LOCAL \[X = 1, Y = \]"Hello"
// statements
ENDHIERARCHY

TEXT  NAMED X"Test"
USES LOCAL \[Y = QUERY NAME OF X\]
// statements
ENDTEXT

Local variables are destroyed when the block exits. A local variable with the same name as a global variable hides the global variable.
USE...ENDUSE blocks cannot declare local variables.

Making Any Block a Callable Procedure

You can turn any block into a callable procedure simply by prefixing the block with the procedure keyword:

PROCEDURE
HIERARCHY "Test"
// statements
ENDHIERARCHY

PROCEDURE
RULE  NAMED X"Test"
// statements
ENDRULE

Procedures are not part of any module, and they will only execute when called from elsewhere in the template. Use a CALL statement to call a
procedure:

CALL PROCEDURE "Test"
// or...
SET PROC = "Test"
CALL PROCEDURE PROC

Arguments can also be passed. The procedure declares formal parameters as follows:

PROCEDURE REQUIRES \[X, Y, Z\]
HIERARCHY "Test"
// statements
ENDHIERARCHY



The parameters become local variables to the block and can be referenced immediately, even in the block header:

PROCEDURE REQUIRES \[ARULE, AVIEW\]
HIERARCHY "Test1"
USES LOCAL \[X = QUERY NAME OF ARULE\]
// statements
ENDHIERARCHY

PROCEDURE REQUIRES \[RULENAME\]
RULE  NAMED RULENAME"Test2"
// statements
ENDRULE

The CALL statement passes actual arguments:

CALL PROCEDURE  PASSING \[MYRULE, MYVIEW\]"Test1"

Arguments are passed by reference only, so only currently defined variables can be passed as arguments. If the procedure alters the value of a
parameter, the value of the corresponding argument is also altered.
Do not give two different procedures the same name?only the first will be recognized since there is no "module" concept with procedures.
Procedures can be called from USE and HIERARCHY blocks only. This restriction enforces the concept that other block types (rule and window,
for example) cannot functionally decompose.

Other Statements

You can also use these statements in building your application with the templates:

CALL Statement
CALL SERVICE Statement
SELECT Statement
APPEND and REMOVE Statements
TRAVERSE Statement
UPDATE MESSAGE Statement
SHOWMESSAGE Statement
SET Statement

CALL Statement

The CALL statement allows one template to call another. Its syntax is:

This statement executes a module in a template for an object, just as if you passed the object to the template. Although the syntax allows the
object to be optional, TurboCycler Standard Edition flags it as an error. This is a forward-looking language feature that supports the execution of a
template without any repository object. The called template begins execution at the USE block that the FOR object names.
The "module_name" and template parameters must be string expressions identifying the module name and template title (not its file name) to be
run. The object parameter reduces to a repository object that the called template processes.
The optional PASSING clause describes a list of variables common to both templates. You can use each variable for both input and output.
A template can call itself. This is more efficient in space and time than calling another template, but keep the following points in mind:

The user can run any module in a template for any USE...ENDUSE blocks. Because the template cannot hide its modules from the user,
you must document which modules can be generated from each object type the template accepts and instruct the user to configure the
template from the setup dialog initially. The template must enforce the proper use of modules through programming.
A template calling itself shares variables passed to it but shares no others. Each invocation of the template creates new instances of its
variables.

An error results if the requested template does not exist, does not have the requested module, or does not accept the object type passed. In the
case of a CALL statement, a USE ANY block is not considered a match for the object type.



The CALL MODULE statement is only allowed in USE...ENDUSE and HIERARCHY...ENDHIERARCHY statements.

CALL SERVICE Statement

The CALL SERVICE statement supports user exits. A template can request a service from a dynamic link library (DLL). By using this call, the
template and the DLLs can share variables.

You can initiate user exits to interact with the user or to implement additional functionality beyond the previous capabilities of the templates
language.
The "C" header file (TCSDK.H) defines the application program interface for writing user exits. Sample user exit code can be found in
C:\appbuilder\template\samples\userexit. You must put the user exit DLLs in the TurboCycler template directory on the development workstation.

SELECT Statement

TurboCycler Release 2.2.0.3.1 includes a selection construct for evaluating arbitrary case expressions. The syntax is:

SELECT
CASE expr1 :
// statements
ENDCASE

CASE expr2 :
// statements
ENDCASE
.
.
.
DEFAULTCASE :
// statements
ENDCASE
ENDSELECT

APPEND and REMOVE Statements

The APPEND statement appends an item to a list variable:

APPEND expression TO list_var

If list_var is not a list variable, it becomes one. The statement can be used to compose lists containing arbitrary expressions. The REMOVE
statement removes an item from a list, collapsing subsequent items:

REMOVE list_var ( index )

If the index is out of bounds, an error is generated.

TRAVERSE Statement

The purpose of the TRAVERSE statement is to eliminate any explicit navigation logic from the template and to transform a recursive template
algorithm into a finite automation. Use this statement to enable the template to navigate a hierarchy by specifying an explode path and a series of
procedures that should be called at each "node."

TRAVERSE root_object
explode_path
ENDTRAVERSE

Here is an example showing the explode path:



USE RULE( ROOT )
TRAVERSE ROOT
\->VIEW VIA RELATION OWNS_VIEW : "doView"
->->FIELD VIA RELATION VIEW_INCLUDES : "doField"
->->RECURSE VIA RELATION VIEW_INCLUDES : "doView"
\->RECURSE VIA RELATION USES_RULE : "doRule"
ENDTRAVERSE
ENDUSE

In the example, the template is interested in finding all views, fields, and rules that are under the root rule. This is done by showing how the
template should explode the hierarchy under the root object. In this case, the RECURSE statement is also used?it always refers to objects under
the parent having the same type and related by way of the given relationship. It also specifies that the explosion should be repeated for these
objects.
Therefore, the first RECURSE refers to the VIEW object because the parent object (having one less arrow) is a VIEW. Furthermore, it says that
for each VIEW found, all the explode lines leading to (and including) the RECURSE should be repeated.
Note the following:

\->VIEW VIA RELATION OWNS_VIEW : "foo"
->->FIELD VIA RELATION VIEW_INCLUDES : "foo"
->->RECURSE VIA RELATION VIEW_INCLUDES : "foo"

Here all fields under the first view and all fields under every view under the first view are seen. Compare this to:

\->VIEW VIA RELATION OWNS_VIEW : "foo"
->->RECURSE VIA RELATION VIEW_INCLUDES : "foo"
->->FIELD VIA RELATION VIEW_INCLUDES : "foo"

where only fields under the first view are seen. However, views descending from the first view are seen here, just as in the first example.
The last item on the line is the name of the procedure that should be called whenever this node is seen. The procedure is called with four
arguments, so it must declare four parameters:

PROCEDURE  REQUIRES \[PAR, KID, LINK, LEVEL\]"foo"
// any block type

where:

PAR = the parent object

KID = the child object

LINK = the relation between the parent and the child

LEVEL = the depth in the hierarchy, starting at 1

You cannot start one TRAVERSE while another is active. The purpose is to specify the complete explode path in the first one
so there is no need to nest them. You can execute a STOP TRAVERSE statement from within a called procedure to prevent
exploding children of the current child object to stop traversing a particular "branch" after the template has decided it is no
longer interested in those children.

Here is an example of a template:



TEMPLATE "Test traverse"
DESCRIPTION "" ENDDESCRIPTION
USAGES
USE FUNCTION (INFUNCTION)

SET FILENAME = "c:
\\
tra.out"
TRAVERSE INFUNCTION
\->PROCESS VIA RELATION REFINES_INTO :"test"
->->RULE VIA RELATION IS_DEFINED_BY :"test"
->->->COMPONENT VIA RELATION USES_COMPONENT :"test"
->->->->RECURSE VIA RELATION COMPONENT_USES_COMPONENT :"test"
->->->RECURSE VIA RELATION USES_RULE :"test"
->->RECURSE VIA RELATION REFINES_INTO :"test"
ENDTRAVERSE
ENDUSE
ENDUSAGES

PROCEDURE REQUIRES \[P, C, REL, DEPTH\]
FLATFILE  NAMED FILENAME"test"
SET Z = TYPEOF(C) + "" + (QUERY NAME OF C)
UPDATE MESSAGE Z
FOR I = 1 TO DEPTH \{$( )\}"\t"
ENDFOR
\{$(TYPEOF(C)):$(QUERY NAME OF C)$( )\}"\n"
ENDFLATFIL

UPDATE MESSAGE Statement

Templates can optionally indicate progress by posting messages directly on the work-in-progress dialog using the UPDATE MESSAGE
statement:

UPDATE MESSAGE "Still going..."

TurboCycler changes the message to the module name of each block as it enters that block.

SHOWMESSAGE Statement

A function that is available for posting simple message boxes to the user. The syntax is:

SHOWMESSAGE (caption, message, buttons, icon)

The dialog has caption as its title and displays a message inside the dialog. The dialog can have one of the following values for buttons:

Dialog Buttons

Buttons Value

OK 1

OK CANCEL 3

RETRY CANCEL 5

ABORT RETRY IGNORE 6

YES NO 7

YES NO CANCEL 8

Optionally, the dialog can use an icon:

Dialog Icons



Icon Style Value

Hand 1

Question 2

Exclamation 3

Asterisk 4

Information 5

Query dialog 6

Warning dialog 7

Error dialog 8

The function returns the button pressed to close the dialog. It has one of the following values:

Function Return Buttons

Button Value

CANCEL 0

OK 1

ENTER 2

ABORT 3

RETRY 4

IGNORE 5

YES 6

NO 7

A value of 8 is returned if an error occurs during the SHOWMESSAGE operation.

SET Statement

The following statement for setting properties is available:

SET property OF object = value

This statement can be used in WINDOW blocks to set properties of window controls. This is an alternative to using the HAVING clause of the
MAKE statement. These properties can also be retrieved using the QUERY expression.
TurboCycler automatically creates a local variable named TCWINDOW upon entry to a WINDOW block. This variable refers to the window itself
and can be used, for example, to set the CAPTION, ENTER_KEY, and CLOSE_KEY of the window:

WINDOW  NAMED TEST"Test"
// window statements
SET CAPTION OF TCWINDOW = "Foobar"
ENDWINDOW

Supporting Statements and Expressions

The last part of the template language contains language flows for the following:

Common Statement



Conditional Expression (conditional_expr)
Integer Expression (int_expr)
List Expression (list_expr)
Object Expression (object_expr)
String Expression (string_expr)

Common Statement

The common statement is a sequence of template language statements that originates in several block statements, such as USAGES, WINDOW,
RULE, and HIERARCHY.

The flow diagrams indicate that the common statement refers back only to the originating block statement, not indiscriminately
to any other block statement. You must return to the block where you started.

For example, if you originate in the RULE block, the scope of the "block statement" includes this common statement and that particular rule
statement directing you here. The block statement function, including this common statement, supports recursive execution.

RETURN

Keyword to end the execution of a template for the passed-in object. Through the execution of this statement, you can pass back a specifiable
return code. See "return_code" for an explanation of the return codes.

return_code

Either an integer expression or string expression that indicates the reason for terminating the template. When the return code is:

An integer, the number is not displayed. Zero means successful completion. Nonzero signifies an error, so any module that depends on
this execution should not continue.
A string expression, it is displayed and indicates an error.

DEBUG...ENDDEBUG

A pair of keywords that surround one or more statements to be analyzed. DEBUG produces output including a trace of the executed instructions,
branch conditions, variable assignments, and repository queries. You cannot change or select the DEBUG output.
Debug records output in a file specified in the DEBUG_FILE option in the Tools> Workbench Options, TurboCycler set of options. You must set
the fully qualified path and file name for your DEBUG file. You can also select to write the output only to a file. This will prevent the output from
being displayed on the Analysis window in the Workbench.

HPS.INI does not include the DEBUG_FILE parameter.

block_statement



A variable reference back to the block statement that invoked this common statement. The originator is one of the following block statements:
usages block, rule block, window block, or hierarchy block.
The block statement consists of this common statement and any unique instructions that are part of the block statement that invoked this common
statement.
A block statement and this common statement together can execute recursively, as the flow diagrams show.

IF...ENDIF

Keywords that surround a sequence of block statements. The IF control conditionally executes the statements that follow. If the conditional
expression is true, the block statement that immediately follows it is executed. The ELSE statement or the ENDIF indicate the end of the block. If
the conditional statement is false, the ELSE statement is executed if it is present.

conditional_expr

A conditional expression the program tests for validity. If true, the next block statements are run; if false, the ELSE block statements are run. (The
template language does not have an explicit THEN.) Refer to  for the syntax.Conditional Expression (conditional_expr)

ELSE

An alternative logic path that the program follows when the conditional expression of the IF is not true.

FOR...ENDFOR

Keywords that surround a sequence of block statements. The FOR loop control executes a sequence of instructions repetitively for a specified
number of iterations. The range of the "from_expr" (from expression) and the TO "to_expr" (to expression) defines the number of loop iterations.
You can increment the count of iterations by a value other than one with the BY "by_expr" (by expression).

loop_var

Loop variable (an integer variable) that is the counter for the FOR loop.

from_expr

From expression (an integer expression) that sets the starting count for the FOR loop counter.

TO

Keyword that specifies the end-point value that limits loop repetitions.

to_expr

To expression (an integer expression) that sets the ending count for the FOR loop counter.

BY

Keyword that introduces the value for incrementing the loop count. Otherwise, the increment defaults to counting by one.

by_expr

By expression (an integer expression) that sets the incrementing value for the FOR loop counter.

WHILE?ENDWHILE

Keywords that surround a sequence of block statements. The WHILE loop control executes a sequence of instructions repetitively until defined
conditions are met. The "(conditional_expr)" parameter defines the conditions.

(conditional_expr)

A conditional expression, enclosed in required parentheses, on which this program evaluates and acts. While the conditional expression remains
true, the following block statements are executed. Refer to  for the syntax.Conditional Expression (conditional_expr)

SET

A keyword that assigns values to your variables, including string, integer, list, and object variables.

=

The equal sign that is the assignment operator.



string_expr

A string expression for string assignment. Refer to .String Expression (string_expr)

int_expr

An integer expression for integer assignment. Refer to .Integer Expression (int_expr)

list_expr

A list expression for a list assignment. Refer to .List Expression (list_expr)

object_expr

An object expression for an object assignment. Refer to .Object Expression (object_expr)

Conditional Expression (conditional_expr)

A conditional expression combines two expressions with a logical operator; the resultant combination evaluates to true or false. This evaluation
can determine the sequence of programming execution. Expressions can be integers, lists, objects, and strings. Refer to Logical and Arithmetic

 for comparison results.Operators

int_expr

Any integer expression, as defined in .Integer Expression (int_expr)

list_expr

Any list expression, as defined in . Lists are equal when they have identical children in the same order.List Expression (list_expr)

object_expr

Any object expression, as defined in . Objects are equal when they refer to identical repository objects.Object Expression (object_expr)



string_expr

Any string expression, as defined in . Strings are equal when their characters match exactly.String Expression (string_expr)

AND/OR

Keywords that specify either an additional conditional expression or an alternative conditional expression that enhances the previous qualification.

conditional_expr

A conditional expression that can be added as another or an alternative conditional expression. (This usage supports recursive invocation of
conditional expressions.)

Logical and Arithmetic Operators

The following operators are used in conditional expressions:

= equal

> greater than

< less than

>= greater than or equal to

<= less than or equal to

<> not equal to

IN contained in or embedded within another string

Conditional Expressions shows examples of conditional expressions and how they evaluate.

Conditional Expressions

Expression Evaluation

where X is 1 and Y is 2:  

x = y False

y = x False

x <> y True

where x is Field X and y is View X:  

x = y False

x <> y True

where x = "TurboCycler" and y = "Turbo":  

x = y False

x <> y True

x IN y False

y IN x True

Integer Expression (int_expr)

An integer expression is a combination of whole number values, functions, or operators that evaluate to a whole number.



+ and -

Positive and negative arithmetic operators that act on the following "digit" parameter.

digit

Any numeral of one character.

NUMBEROF

A keyword that counts and reports the number of items in the list specified by the "(list)" parameter.

(list)

A list parameter (list expression) that identifies the list whose items are to be counted. Refer to  for more about listList Expression (list_expr)
expressions.

QUERY

A keyword that retrieves information for the repository object that the "repository_object" parameter names.

object_property

A parameter that describes the property to be retrieved for the specified object type. Some object properties return strings, others integers. Only
object properties having and returning integer values are valid for the integer expression. Refer to  for details.Object Types and Properties

OF

A keyword that identifies the repository_object being queried.

repository_object

An object expression that defines the repository object for which numeric information is being obtained.



int_var

An integer variable in the template that has an integer value.

(int_expr)

Any integer expression, as defined in . The parentheses are optional, but you can use them to improve readabilityInteger Expression (int_expr)
and to resequence the order of operators.

int_expr

An integer expression that you can use with the following arithmetic operators to derive calculated values.

* / + -

Arithmetic operators that function with the surrounding integer expressions and evaluate to an integer value.

RIGHTOF/LEFTOF/TOPOF/BOTTOMOF/HEIGHTOF/WIDTHOF

Limited to window block statements, these keywords retrieve the dimensions of window control parameters.

(window_control)

A window control variable that refers to a window that the MAKE or CONTAIN statement creates. Refer to .WINDOW Block

List Expression (list_expr)

A list expression refers to a group of objects in the repository. Use this expression to obtain a list of objects whose properties match your selection
criteria.

list_var

A list variable in the template that refers to an object in the repository.

(list_expr)

Any list expression enclosed in parentheses to improve readability.



CHILDPARENT

Keywords that retrieve a list of children or parents of a given object. These keywords serve as the repository interface to promote navigation from
object to object.

criteria_object_type S

The object types of the children or parents to be retrieved from the list. The trailing character S signifies a list of objects is to be retrieved. The
plural form of any object type supported by the Information Model is valid, such as RULES, WINDOWS, VIEWS, and FIELDS. (Note that plurals
are constructed by putting the suffix S on the base word, with these exceptions: ENTITIES, PROCESSES, and LOGICAL_PROCESSES.) Refer
to  for a list of object types.Object Types and Properties

OF

A keyword that introduces the root_object parameter as the point to begin navigation.

root_object

An object expression that refers to the object from which you want to start navigation.

HAVING

A keyword that specifies properties the list of children or parent must have.

[...]

A set of brackets enclosing the values of properties that must be met for the retrieved objects.

criteria_property

Criteria property (an object property expression) that specifies the values that the properties of the retrieved child and parent objects must have.
Refer to  for a complete list.Object Types and Properties

AND/OR

Keywords that specify either an additional criteria_property or an alternative criteria_property that modifies the previous qualification.

VIA RELATION

A keyword that specifies the relationship type between children or parents. This is a required parameter.

criteria_relation_type

Criteria relation type (a relation type expression) that specifies the type of relationship to the children and parent objects. Refer to Relationship
 for a detailed list.Types and Properties

WITH

A keyword that specifies required properties of the relationship (with children or parents) to the object.

criteria relation property

Criteria relation type (a relation property expression) that specifies the values the properties of the relationship to the retrieved child/parent objects
must have. Refer to  for a detailed list.Relationship Types and Properties

ORDER BY

Sorts the list by the properties specified. Properties can apply to either the entity or the relationship.

TurboCycler automatically sorts lists by SEQUENCE_NUMBER. Do not specify ORDER BY [SEQUENCE_NUMBER].

Object Expression (object_expr)

An object expression refers to an object in the repository. Using this expression, you can obtain various properties about that object.



The last four flow lines address traceability data that the forward engineering and reverse engineering processes create.

object_var

An object variable in the template that refers to an object in the repository.

(object_expr)

Any object expression that can be enclosed in parentheses to improve readability.

object_list

A list expression that represents a list of objects in the repository, which you index for a specific item in the list. The index is the offset of the item
being accessed.

[...]

A set of brackets that index into a list of objects.



RELATION

A keyword that refers to a relationship to the specified object in the repository, not to the object itself. Use this expression to obtain sequence
number information among other data.

list_index

An integer expression that is the index into the object list. The first item in a list has an index value of one (1).

CHILD/PARENT

Keywords that retrieve a list of children or parents of a given object. These keywords serve as the repository interface to promote navigation from
object to object. They return only the first qualified object encountered. Refer to Sample of a Hierarchy Diagram Coded as an Object Expression
for a coding example using CHILD and related parameters.

object_type

An object type of the child or parent to be retrieved. Refer to  for a list of object types.Object Types and Properties

OF

A keyword that introduces the root_object parameter as the navigation starting point.

root_object

An object expression that refers to the object from which you want to start navigation.

[...]

A set of brackets that enclose the values of properties the child/parent object must have.

criteria_property

Criteria property (an object property expression) that requires the child or parent object to have the specified value for the property. Refer to 
 for a detailed list. Examples of the format for this statement are PROPERTY = string_expr and PROPERTY =Object Types and Properties

int_expr.

AND/OR

Keywords that specify either an additional criteria_property or an alternative criteria_property that modifies the previous qualification.

VIA RELATION

A keyword that specifies the relationship type between the child or parent. This is a required parameter. Refer to Sample of a Hierarchy Diagram
 for a coding example using VIA RELATION and related parameters.Coded as an Object Expression

criteria_relation_type

Criteria relation type specifies the type of relationship to the child/parent object. Refer to  for details.Relationship Types and Properties

WITH

A keyword that specifies requisite properties of the relationship (with a child or parent) to the object. Refer to Sample of a Hierarchy Diagram
 for a coding example using WITH and related parameters.Coded as an Object Expression

criteria_relation_property

Criteria relation type (a relation property expression) that specifies the values that the properties of the relationship to the child/parent object must
have.

GET

A keyword that specifies repository objects to be retrieved. You can make conditional queries of repository objects.

criteria_object_type

A property that specifies the type of the object being retrieved. Refer to  for a list of valid object types. When theObject Types and Properties
criteria_object_type parameter is not plural, this expression retrieves a single repository object. When criteria_object_type is plural, the expression



retrieves any number of objects of the specified type from the repository.

NAMED

A keyword that identifies the "object_name" parameter.

HAVING

A keyword that specifies properties the child or parent must have. Use the HAVING clause to select a subset of these objects. Refer to Sample of
 for a coding example using HAVING and related parameters.a Hierarchy Diagram Coded as an Object Expression

object_name

A string expression that specifies the name of the object to be retrieved. The object_name parameter can optionally contain a single asterisk * as
the last character. When accessing the members of the resulting list, the RELATION subscript modifier has no meaning.

DERIVED KEY OF

A keyword that obtains the key that implements an identifier or a relationship in the repository.
To understand key usage with relationships or identifiers, you must understand how forward engineering handles keys. Forward engineering
begins with an entity relationship diagram, which consists of entities, attributes, relationships, and identifiers. The forward engineering process
turns those objects into a database diagram consisting of tables, keys, and columns. As part of this activity, forward engineering links keys to
relationships to produce a foreign key and links keys to identifiers to produce a primary or index key. Consequently, the following TurboCycler
functions occur:

DERIVED KEY OF Relationship (provides a foreign key)

DERIVED KEY OF Identifier FOR entity_qualifier
(provides a primary or index key)

logical_object

An object expression that is either an ERD relationship or an identifier. If a relationship, it is not qualified by the entity_qualifier and returns a
foreign key. If an identifier, it must be qualified by its owning entity and returns a primary or an index key.

FOR

A keyword that introduces the "entity_qualifier" parameter. This phrase applies only to an identifier object that is querying for a primary or index
key.

entity_qualifier

An object expression that names the entity for which an identifier is being sought.

ORIGINATING IDENTIFIER OF

A keyword that starts the query for an identifier by searching through its primary or index key. This function is the reverse of the "DERIVED KEY
OF logical_object FOR entity_qualifier" function. In this case, you supply the key and receive the identifier object.

identifier_created_key

An object expression that names the primary or index key from which you receive the corresponding identifier object.

ORIGINATING RELATIONSHIP OF

A keyword that initiates the query for a relationship by searching through its foreign key. This function is the reverse of the . In thislogical_object
case, you supply the key and receive the relationship object.

relationship_created_key

An object expression that names the foreign key through which you obtain the corresponding relationship object.

REFERRED COLUMN OF

A keyword that returns a column object that is referred by another column when two tables are connected by a foreign key.
To understand referred column queries between tables with keys, you must understand how tables, keys, and columns are structured in database
diagrams. If two tables have columns connected by a foreign key, you can extract column objects about one by using the key data from the other.
For instance, consider the following example:



REFERRED COLUMN OF columnf FOR forkey

In this example, you supply a foreign key column (columnf) and the foreign key (forkey) and receive the referred column object of the foreign key
by which columnf is referred. Now, here is another example:

REFERRED COLUMN OF columnp FOR prikey TO forkey

In this example, you supply the primary key column (columnp) and the primary or index key (prikey) referred by the foreign key (forkey) and
receive the foreign key column object that is referring to columnp.
Refer to  for a visual representation of these examples of the REFERRED COLUMN OF keyword.Example of REFERRED COLUMN OF coding

original_column

An object expression that names the column object from which the search begins.

FOR

A keyword that names the key_qualifier through which searching starts.

key_qualifier

An object expression that identifies the key that is searched for the desired response object.

TO

A keyword that names the foreign key, as described in the second example of the REFERRED COLUMN OF keyword.

referred_key_qualifier

An object expression that names the foreign key, as described in the second example of the REFERRED COLUMN OF keyword.

Additional information

Sample of a Hierarchy Diagram Coded as an Object Expression shows a coding example of the CHILD entity type, HAVING, VIA RELATION, and
WITH.

Deleting Objects

A keyword that specifies repository objects to be deleted.

Delete (object_expr)

Sample of a Hierarchy Diagram Coded as an Object Expression



Example of REFERRED COLUMN OF coding shows an example of a diagram and flow for the REFERRED COLUMN OF statement.

Example of REFERRED COLUMN OF coding



String Expression (string_expr)

A string expression refers to a string of characters.

"string_literal"

A character string enclosed in double quotes.

Lexical analysis of string literals



The backslash character "\" is the escape sequence in string literals. Supported escape sequences are described in .Escape Sequences

Escape Sequences

Characters Description

\ 
Backslash

\t Horizontal tab (HT)

\v Vertical tab (VT)

\b Backspace (BS)

\n Newline (LF)

\r Carriage return (CR)

\f Form feed (FF)

\a Alert (BEL)

\" Double quote

\xhhh Hex number (all three digits required)

If any other character follows a backslash, the backslash is ignored.

Use the double backslash for file names. For example: SET myDirectory = "G: 
HPS 
" 

SUBSTR (...)

A keyword that retrieves a specified character substring from the "original_string" parameter.

original_string

A string expression that identifies the character string from which the SUBSTR retrieves a substring.

from_expr

An integer expression that indicates the starting point of the "original_string" parameter of retrieved data.

to_expr

An integer expression that indicates the end point of the "original_string" parameter of retrieved data.

QUERY

A keyword that retrieves property information for the repository object that is named by the repository_object parameter.

object_property

A parameter that describes the property to be retrieved for the specified object type. Some object properties return strings, others integers. Only
the object properties having and returning string values are valid for the object expression.Object Types and Properties

OF

A keyword that identifies the "repository_object" parameter being queried.

repository_object

An object expression that defines the repository object for which character string information is being obtained.

string_var

A string variable in the template that has a character value.



(string_expr)

Any string expression, as defined in . The parentheses are optional, but you can use them to improve readability.String Expression (string_expr)

+ string_expr

A string expression that concatenates another string expression to the one just completed.

Processing Symbols on an Open Drawing

A USE type is supported that allows a template to process the symbols on an open drawing. An example of a template that can be generated
from an open ERD is:

USAGES
USE ERD Drawing ( _drw_ )
// statements
ENDUSE
ENDUSAGES

Here the variable  refers to the open drawing. To obtain a list of the entities on the drawing, use:drw

SET ENTS = CONNECTED ENTITIES OF DRW

The variable ENTS contains the drawing symbols?not repository objects. Drawing symbols have the following properties:

TYPE: The symbol type (ENTITY, for example).
ASSOCIATED_OBJECT: The associated repository object, if any.
SELECTED: "TRUE" if the symbol is selected by the user; otherwise, it is "FALSE."
FOCUSED: "TRUE" if the symbol was in focus; otherwise, it is "FALSE." (Only one symbol can have the focus.)

Here is an example of the use of the ENTS variable:

FOR I = 1 TO NUMBEROF( ENTS )
SET ENTITY = QUERY ASSOCIATED_OBJECT OF ENTS(I)
ENDFOR

A symbol can be connected to other symbols. Both boxes and lines are considered symbols without distinction. For the ERD example:

SET ENTITYSYMBOL = ENTS(1)

// Query  relationship lines coming from the entityfor
SET LINES = CONNECTED RELATIONSHIP_LINES OF ENTITYSYMBOL
VIA CONNECTION RELATION_OUT

// Query  relationship lines coming into the entityfor
SET LINES = CONNECTED RELATIONSHIP_LINES OF ENTITYSYMBOL
VIA CONNECTION RELATION_IN

SET REPO_OBJECT = QUERY ASSOCIATED_OBJECT OF LINES(1)
SET REPO_LINK = QUERY ASSSOCIATED_OBJECT OF LINES(CONNECTION 1)

In the last two lines, repository objects of types RELATIONSHIP and IS_RELATED_VIA are returned, respectively. These statements have a very
strong analogy to the TurboCycler CHILD...VIA RELATION and RELATION array subscript modifier statements?they are meant to work in the
same way for drawing symbols.

 through  list the symbols associated with different types of diagrams.Entity Relationship Diagrammer Window Flow Diagrammer

Entity Relationship Diagrammer

Symbol Name Plural Name Symbol Type

RELATION_OUT n/a connection

RELATION_IN n/a connection



SUBTYPE_OUT n/a connection

SUBTYPE_IN n/a connection

ENTITY ENTITIES box

BUSINESS_OBJECT BUSINESS_OBJECTS box

RELATIONSHIP_LINE RELATIONSHIP_LINES line

SUBTYPE_LINE SUBTYPE_LINES line

NOTE NOTES box

State Transition Diagrammer

Symbol Name Plural Name Symbol Type

IS_PRECONDITION n/a connection

IS_POSTCONDITION n/a connection

EVENT_CLAUSES n/a connection

STATE STATES box

EVENT EVENTS box

TRANSITION_LINE TRANSITION_LINES line

Database Diagrammer

Symbol Name Plural Name Symbol Type

REFERRED_OUT n/a connection

REFERRED_IN n/a connection

HAS_OUT n/a connection

HAS_IN n/a connection

TABLE TABLES box

KEY KEYS box

FOREIGN_KEY FOREIGN_KEYS box

INDEX_KEY INDEX_KEYS box

HAS_KEY_LINE HAS_KEY_LINES line

REFERRED_KEY_LINE REFERRED_KEY_LINES line

Process Dependency Diagrammer

Symbol Name Plural Name Symbol Type

DEPEND_OUT n/a connection

DEPEND_IN n/a connection

TRIGGER_OUT n/a connection

TRIGGER_IN n/a connection

EVENT_TRIGGER_IN n/a connection



EVENT_TRIGGER_OUT n/a connection

LOGICAL_PROCESS LOGICAL_PROCESSES box

DECISION DECISIONS box

TRIGGER_LINE TRIGGER_LINES line

DEPENDENCY_LINE DEPENDENCY_LINES line

EVENT_TRIGGER_LINE EVENT_TRIGGER_LINES line

Window Flow Diagrammer

Symbol Name Plural Name Symbol Type

FLOW_OUT n/a connection

FLOW_IN n/a connection

NEST_OUT n/a connection

NEST_IN n/a connection

EVENT_OUT n/a connection

EVENT_IN n/a connection

DETACH_OUT n/a connection

DETACH_IN n/a connection

RULE_INITIATES n/a connection

DECISION_OUT n/a connection

DECISION_IN n/a connection

DECISION_NEST_OUT n/a connection

PROCESS PROCESSES box

ENTRY_POINT ENTRY_POINTS box

DIALOG_UNIT DIALOG_UNITS box

WINDOW WINDOWS box

RULE RULES box

DECISION DECISIONS box

TERMINAL TERMINALS box

FLOW_LINE FLOW_LINES line

NESTED_FLOW_LINE NESTED_FLOW_LINES line

DETACHED_FLOW_LINE DETACHED_FLOW_LINES line

MESSAGE_FLOW_LINE MESSAGE_FLOW_LINES line

Functions for TurboCycler Developer's Kit

The TurboCycler Developer's Kit comes with a number of commonly needed functions that you can use to help you build your templates.

Get and File Functions
String Manipulation Functions
Superseded Functions

Get and File Functions



The following functions are available:

GetConfiguration (app, key)
GetEnvironment (environment_variable)
GetHPSConfiguration (app, key)
GetTime (format_string)
isDefined (variable_name)
NewFilename ( )
removeFile (file_name)
ReadFlatFile(pathname)

GetConfiguration (app, key)

This function retrieves the value of the key parameter from the app parameter section of the file to which the environment variable TURBOINI
points. You can use this function to place editable parameters in this file, rather than hard coding them in the template. Documentation provided
with the template must explain what is required with respect to this file. Templates must share this file. If the entry cannot be found, an empty
string is returned.

GetEnvironment (environment_variable)

This function retrieves the value of any environment_variable. If the requested variable is not defined, an empty string is returned.

GetHPSConfiguration (app, key)

This function retrieves the value of the key parameter from the registry. If the entry cannot be found, an empty string is returned.

The following sample key and values illustrate how one can set up the logic: 

_HKEY_CURRENT_USER\Software\BluePhoenix\AppBuilder\IDWB\Tools\TurboCycler\Settings_ \\
_ = _ \\"BITMAP_DIR" "D:\AppBuilder\NT\RT\BMP"
_ = _ "MENU_FILE" "D:AppBuilder\\NT\RT\MENU"

Then add a statement similar to the following: 

SET gBITMAP_DIR = GetHPSConfiguration( _"_ Tools \\
TurboCycler \\
Settings _ _ BITMAP_DIR _"_ ) \\"_ , _"
SET gMENU_FILE = GetHPSConfiguration( _"_ Tools \\
TurboCycler \\
Settings _ _ MENU_FILE _"_ ) "_ , _"

In Windows, the HPSINI file cannot be read using the GetHPSConfiguration function. However, AppBuilder can use the
Registry for the TurboCycler GetHPSConfiguration. The following sample key and values illustrate how one can set up the logic:

HKEY_CURRENT_USERS\Software\BluePhoenix\AppBuilder\IDWB\Tool\Turbocycler\Settings 
"BITMAP_DIR"="D:\AppBuilder\NT\RT\BMP" 
"MENU_FILE="D:\AppBuilder\\NT\RT\MENU" 
Then, add a statement similar to the one below: 
SET gBITMAP_DIR = GetHPSConfiguration("Tools 
TurboCycler 
Settings", "BITMAP_DIR" ) 
SET gMENU_FILE = GetHPSConfiguration("Tools 
TurboCycler 
Settings", "MENU_FILE" )

GetTime (format_string)

This function uses the format_string parameter to generate a string containing the current date or time information. The format_string is composed
of text and, optionally, one or more of the conversion specifiers described in :Conversion Specifiers

Conversion Specifiers



Specifier Description Example

%a Abbreviated weekday name Sun

%A Full weekday name Sunday

%b Abbreviated month name Dec

%B Full month name December

%c Date and time Dec 02 1995 06:55:15

%d Day of the month 02

%H Hour of the 24-hour day 23

%I Hour of the 12-hour day 11

%j Day of the year, from 001 335

%m Month of the year, from 01 12

%M Minutes after the hour, from 00 55

%p AM/PM indicator (AM) AM

%S Seconds after the minute, from 00 48

%U Sunday week of the year, from 00 51

%w Day of the week, from 0 for Sunday 0

%W Monday week of the year from 00 43

%x Date Dec 02 1995

%X Time 06:55:15

%y Year of the century, from 00 95

%Y Year 1995

%z Time zone name, if any EST

%% Percent character %

Using any other % character in the format string is illegal, and an empty string is returned.

isDefined (variable_name)

This function returns 1 if the variable_name is defined as a variable in the template; otherwise, it returns 0. Use this function to determine whether
the template is being executed by a user or another template.

NewFilename ( )

This function generates a unique file name.

removeFile (file_name)

This function attempts to delete the file specified by the file_name parameter. It returns 1 if successful or 0 if unsuccessful.

ReadFlatFile(pathname)

TurboCycler reads in text files using the READFLATFILE (pathname) function. The function returns a string containing the text file. Only text files
smaller than 64K can be read using this function.

String Manipulation Functions

The first character in a string is at position one, not position zero.

strCenter (str, length, pad)



Returns a string of length with str centered. Remaining spaces are filled using pad.

strCopies (str, n)

Returns a string of n concatenated copies of str.

strCutLeft (str, length)

Returns str with the leftmost length characters removed.

strCutMiddle (str, start, length)

Returns str with length characters starting at position start removed.

strCutRight (str, length)

Returns str with the rightmost length characters removed.

strFilespec (str, "option")

Returns the part of the file name in str specified by the option. The option can be: Drive, Dir, Name, or Extension. The "option" parameter must be
of type string, otherwise an error will be received when trying to use the turbo cycler.

strFind (needle, haystack, int n)

Returns the position of the nth occurrence of needle in haystack.

strInsert (needle, haystack, n)

Inserts needle in haystack at position n.

strLeft (str, length)

Returns a string comprised of the leftmost length characters of str.

strLength (str)

Returns the number of characters in str.

strLine (str, i)

Returns the i the line in str.

strLines (str)

Returns the number of lines in str, separated by carriage returns.

strLower (str)

Converts str to lower case.

strMiddle (str, start, length)

Returns a string comprised of length character taken from str beginning at position start.

strReplace (search, replace, str)

Replaces each occurrence of the string search in str with the string replace. The search is case insensitive.

strReverse (str)

Returns a string comprised of the characters from str in reverse order.

strRight (str, length)

Returns a string comprised of the rightmost length character of str.



strToken (str, delimiter_set, n)

Returns the nth token in str, using the characters in delimiter_set as delimiters.

strTokens (str, delimiter_set)

Returns the number of tokens in str separated by any of the characters in delimiter_set.

strTrim (str, "option")

Returns str without leading or trailing white space. The option can be: Leading, Trailing, or Both. The "option" parameter must be of type string,
otherwise an error will be received when trying to use the turbo cycler.

strUpper (str)

Converts str to upper case.

strWord (str, i)

Returns the i the word in str.

strWords (str)

Returns the number of words in str, separated by white space.

Superseded Functions

Superseded Functions lists functions and statements from previous releases of TurboCycler that have since been superseded and are no longer
used.

Superseded Functions

For these functions: Use:

RIGHTOF() 
LEFTOF() 
WIDTHOF() 
HEIGHTOF()

The new QUERY property statement instead.

For these statements: Use:

POSITION WINDOW

SIZE WINDOW

The SET property statement instead: 
SET BOTTOM OF TCWINDOW = 50 
SET LEFT OF TCWINDOW = 50 
SET WIDTH OF TCWINDOW = 200 
SET HEIGHT OF TCWINDOW = 150

Template Samples

The TurboCycler Developer's Kit includes the following two sample templates to show you how to generate object hierarchies, rules, and a
window:

SQL Delete Rule Sample - part of the CRUD Rules template
Detail Display Rule and Window Sample - part of the GUI Rules/Windows template

These samples demonstrate many of the features available in the template language. The samples are located in the directory
AD\TEMPLATE\SAMPLES.

Source code for all the Standard Edition templates is included with the TurboCycler Developer's Kit in the directory
APPBUILDER\AD\TEMPLATES.

SQL Delete Rule Sample

This sample is a part of the Standard Edition CRUD Rules template that generates an SQL Delete Rule for an AppBuilder file object. Generating a



completely functional SQL Delete Rule requires defining both the rule hierarchy and rule source code. Therefore, this sample template includes
both a hierarchy module and rule module. Both modules have the same name, forcing the generation of both the hierarchy and rule.
In the usages block, this template retrieves all the information it needs from the repository and sets up any local variables that multiple modules
require. In this example, the process error checks the generated rule source code and rule hierarchy. You can generate an SQL Delete Rule
without error-checking, but any errors would remain undetected until you prepare the generated rule.
In the hierarchy block, the template generates the SQL Delete Rule hierarchy. Input and output view are both declared as children of the rule and
as root-level objects. These declarations ensure that TurboCycler deletes all children not created from this template. In some cases, you might not
want to do this.
In the rule block, the template generates the source code for the SQL Delete Rule. It includes a comment area at the top saying that it was
generated and specifies the name of the file for which it was generated. The placement of the { } (curly brace characters) is critical to generating
properly spaced and indented rules source. A good example of this placement is the WHERE clause of the SQL ASIS.

TEMPLATE "SQL Delete Rule Sample"
DESCRIPTION
"Generates an SQL Delete Rule  an AppBuilder Filefor
object."
ENDDESCRIPTION

USAGES
USE FILE(MyFile)
REM --- Retrieve primary view information from repository \---;
SET MyPrimeView = CHILD VIEW OF MyFile VIA RELATION
OWNS_VIEW WITH \[VIEW_USAGE = \]"PRIMARY"
SET MyPrimeFields = CHILD FIELDS OF MyPrimeView
VIA RELATION VIEW_INCLUDES

REM --- Retrieve file information from repository \---;
SET MyFileName = QUERY NAME OF MyFile
SET MyFileImplementation = QUERY IMPLEMENTATION_NAME
OF MyFile
ENDUSE

USE ALL
REM --- Verify that we have a primary view \---;
IF MyPrimeView = 0
RETURN "The file does not have a primary view."
ENDIF

REM --- Verify that we have primary fields \---;
IF (NUMBEROF(MyPrimeFields)) = 0
RETURN "The primary view  the file does not havefor
any fields."
ENDIF

REM --- Verify that we have a file implementation name \---;
IF MyFileImplementation = ""
RETURN "The file does not have an implementation
name."
ENDIF

REM --- Verify that all primary fields have an
implementation name \---;
FOR I = 1 TO NUMBEROF(MyPrimeFields)
IF (QUERY IMPLEMENTATION_NAME OF MyPrimeFields(I))
= ""
SET MESSAGE =  + (QUERY NAME"The primary field "
OF MyPrimeFields(I)) + " does not have an
implementation name."
RETURN MESSAGE
ENDIF
ENDFOR
ENDUSE
ENDUSAGES

REM \-------------------------------------------------------\-
--- SQL Delete Rule Modules ---
\-----------------------------------------------------------;

REM \-------------------------------------------------------;



HIERARCHY "SQL Delete Rule"

REM --- Create Strings  SQL Delete Rule Modules \---;for
SET DeleteRuleName = (SUBSTR (MyFileName, 1, 19) ) +
"_SQL_DEL"
SET DeleteRuleIV = DeleteRuleName + "_IV"
SET DeleteRuleOV = DeleteRuleName + "_OV"

REM --- Build Hierarchy  the SQL Delete Rule \---;for
\-> RULE DeleteRuleName \[DBMS = \]"DB2"
->-> FILE MyFileName VIA RELATION ACCESSES
\[SEQUENCE_NUMBER = 10\]
->-> VIEW DeleteRuleIV VIA RELATION OWNS_VIEW
\[VIEW_USAGE = , SEQUENCE_NUMBER = 20\]"Input"
->-> VIEW DeleteRuleOV VIA RELATION OWNS_VIEW
\[VIEW_USAGE = , SEQUENCE_NUMBER = 30\]"Output"

REM --- Build Hierarchy  the SQL Delete Rule Input View \---;for
\-> VIEW DeleteRuleIV
->-> VIEW MyPrimeView VIA RELATION VIEW_INCLUDES
\[SEQUENCE_NUMBER = 10\]

REM --- Build Hierarchy  SQL Delete Rule Output View \---;for
\-> VIEW DeleteRuleOV
->-> FIELD  VIA RELATION VIEW_INCLUDES"RETURN_CODE"
\[SEQUENCE_NUMBER = 10\]

ENDHIERARCHY

RULE  NAMED DeleteRuleName"SQL Delete Rule"
\{
*>--------------------------------------------------------<*
*>\- Rule: $(DeleteRuleName) \-<*
*>\- SQL Delete Rule  the File: $(MyFile). \-<*for
*>\- Automatically Generated by TurboCycler. \-<*
*>-------------------------------------------------------<*

SQL ASIS
DELETE FROM $(MyFileImplementation)
WHERE
\}

FOR I = 1 TO NUMBEROF(MyPrimeFields)
\{ $(QUERY IMPLEMENTATION_NAME OF MyPrimeFields(I)) =
:$(DeleteRuleIV).$(MyPrimeFields(I)) \}
IF I <> NUMBEROF(MyPrimeFields)
\{AND
\}
ENDIF
ENDFOR

\{
ENDSQL

IF SQLCODE = 0
SQL ASIS
COMMIT
ENDSQL
ENDIF



MAP SQLCODE TO RETURN_CODE
\}
ENDRULE

Detail Display Rule and Window Sample

This sample is part of the Standard Edition GUI Rules/Windows template that generates a simple Detail Display rule and window with no
application logic for an AppBuilder file object. Generating an executable detail display hierarchy requires defining a function/process hierarchy,
rule hierarchy, window hierarchy, rule source code, and window panel. Therefore, the sample template includes two hierarchy blocks, a rule block,
and a window block. All modules have the same name, which forces the generation of all of these blocks.
In the usages block, this template retrieves all information that it needs from the repository and sets up any local variables that multiple modules
require. In this example, the process error checks the generated rule source code and window panel. If error-checking is not performed, you can
generate a detail display window without any fields in it (if no fields were in the data view).
The use of the FOR loop over the fields in the data view clones the data view. This example also shows how to create any kind of hierarchy,
including a function/process hierarchy. The sample rule block is relatively simple because it does not include any application logic.
In the window block, the template makes several controls, including a static text and edit field for every field in the data view. In doing this, a
variable (MyBottom) stores the current value of the bottom position of the next window control. This template also creates a simple menu
hierarchy and includes a bit map in the top left corner of the screen. It is important to understand how the template maintains the size and position
of the window.

TEMPLATE "Detail Display Sample"
DESCRIPTION
"Generates a Detail Display Rule and Window  afor
AppBuilder File ."Object
ENDDESCRIPTION

USAGES
USE FILE(MyFile)
REM --- Query repository  information needed byfor
blocks \---;
SET MyDataView = CHILD VIEW OF MyFile VIA RELATION
OWNS_VIEW WITH \[VIEW_USAGE = \]"DATA"
SET MyFields = CHILD FIELDS OF MyDataView VIA RELATION
VIEW_INCLUDES
SET MyFileName = QUERY NAME OF MyFile
ENDUSE

USE ALL
REM --- Verify there is a data view \---;
IF MyDataView = 0
RETURN "The file does not have a data view."
ENDIF

REM --- Verify the data view has fields \---;
IF (NUMBEROF(MyFields)) = 0
RETURN "The data view does not have any fields."
ENDIF

REM --- Set up Strings needed by blocks \---;
SET MyClonedDataView = (SUBSTR (MyFileName, 1, 19) ) +
"_CDV"
SET MyDetailRule = (SUBSTR (MyFileName, 1, 16) ) +
"_SAMPLE_DETAIL"
SET MyDetailWindow = (SUBSTR (MyFileName, 1, 16) ) +
"_SAMPLE_DETAIL"
SET MyProcessName = (SUBSTR (MyFileName, 1, 19) ) +
"_MAINT"

ENDUSE

ENDUSAGES

REM --- Detail Display Function/ /Rule Hierarchies \---;Process

HIERARCHY "Detail Display"

REM --- Create the Function/  hierarchy \---;Process



\-> FUNCTION MyFileName \[MENU_DESCRIPTION = MyFileName\]
->-> PROCESS MyProcessName \[MENU_DESCRIPTION = MyFileName
+ \] VIA RELATION REFINES_INTO" Maintenance"
\[SEQUENCE_NUMBER = 10\]

REM --- Attach a root rule to the  \---;Process
\-> PROCESS MyProcessName
->-> RULE MyDetailRule VIA RELATION IS_DEFINED_BY
\[SEQUENCE_NUMBER = 10\]

REM --- Create the Detail Display Rule Hierarchy \---;
\-> RULE MyDetailRule
->-> WINDOW MyDetailRule VIA RELATION CONVERSES_WINDOW
\[SEQUENCE_NUMBER = 110\]
->-> VIEW  VIA RELATION OWNS_VIEW"HPS_EVENT_VIEW"
\[SEQUENCE_NUMBER = 120, VIEW_USAGE = \]"WORK"

ENDHIERARCHY

REM --- Detail Display Rule Source Code \---;
RULE  NAMED MyDetailRule"Detail Display"
\{
*>--------------------------------------------------------<*
*>\- Rule: $(MyDetailRule) \-<*
*>\- Detail Display Rule  the File: $(MyFile). \-<*for
*>\- Automatically Generated by TurboCycler. \-<*
*>--------------------------------------------------------<*

  EVENT_SOURCE <> 'Exit'do while
map TIME to STATUS_TIME
map DATE to STATUS_DATE
converse window $(MyDetailRule)

caseof EVENT_SOURCE
 'New'case

clear $(MyDetailRule)
endcase

enddo
\}
ENDRULE

REM --- Detail Display Window Hierarchy \---;
HIERARCHY "Detail Display"

REM --- Create the Window Hierarchy \---;
\-> WINDOW MyDetailWindow
->-> VIEW MyDetailWindow VIA RELATION OWNS_VIEW
\[SEQUENCE_NUMBER = 10\]

REM --- Create the Window View Hierarchy \---;
\-> VIEW MyDetailWindow
->-> FIELD  \[TYPE = , LENGTH = 4\]"STATUS_DATE" "DATE"
VIA RELATION VIEW_INCLUDES \[SEQUENCE_NUMBER = 10\]
->-> FIELD  \[TYPE = , LENGTH = 4\]"STATUS_TIME" "TIME"
VIA RELATION VIEW_INCLUDES \[SEQUENCE_NUMBER = 20\]
->-> VIEW MyClonedDataView VIA RELATION VIEW_INCLUDES
\[SEQUENCE_NUMBER = 30\]

REM --- Clone the data view in the window view \---;
\-> VIEW MyClonedDataView
FOR X = 1 TO NUMBEROF(MyFields)
->-> FIELD (QUERY NAME OF MyFields(X)) VIA RELATION
VIEW_INCLUDES \[SEQUENCE_NUMBER = (10*X)\]
ENDFOR

ENDHIERARCHY

REM --- Detail Display Window Panel \---;
WINDOW  NAMED MyDetailWindow"Detail Display"



SET MyCDV = GET VIEW NAMED MyClonedDataView

REM --- Make the Detail Display Menu \---;
\-> MENUITEM "&File"
->-> MENUITEM  \[HPSID = \]"&New" "New"
->-> SEPARATOR
->-> MENUITEM  \[HPSID = \]"&Print" "HPS_MENU_PRINT"
->-> SEPARATOR
->-> MENUITEM  \[HPSID = \]"E&xit" "Exit"

\-> MENUITEM "&Edit"
->-> MENUITEM  \[HPSID = \]"&Cut" "HPS_MENU_CUT"
->-> MENUITEM  \[HPSID = \]"Co&py" "HPS_MENU_COPY"
->-> MENUITEM  \[HPSID = \]"&Paste" "HPS_MENU_PASTE"

REM --- Set up area information \---;
SET MyWidth = 440
SET MyBottom = (20 + (29 * (NUMBEROF(MyFields) - 1)))

REM --- Place all edit fields \---;
FOR X = 1 TO NUMBEROF(MyFields)

MAKE STATIC_TEXT
HAVING \[HPSID =  + (QUERY NAME OF MyFields(X)),"ID"
LEFT = 20,
TEXT = (QUERY SCREEN_LITERAL OF MyFields(X)),
BOTTOM = MyBottom,
WIDTH = 150,
HEIGHT = 19,
FONT = \]"SWISS8"
ENDMAKE

REM --- PROCEDURE TO DETERMINE WIDTH OF FIELD \---;
SET FieldType = QUERY TYPE OF MyFields(X)
SET FieldLength = QUERY LENGTH OF MyFields(X)
IF FieldType = "INTEGER"
IF FieldLength = 15
SET ControlWidth = 60
ELSE
SET ControlWidth = 100
ENDIF
ELSE
IF FieldType =  OR FieldType = "DATE" "TIME"
SET ControlWidth = 100
ELSE
SET ControlWidth = 7 * FieldLength
IF ControlWidth < 30
SET ControlWidth = 30
ENDIF
ENDIF
ENDIF

MAKE EDIT_FIELD edit
HAVING \[HPSID = (QUERY NAME OF MyFields(X)),
LEFT = 175,
BOTTOM = MyBottom,
HEIGHT = 19,
WIDTH = ControlWidth,
FONT = ,"SWISS8"
TABSTOP = \]"TRUE"
LINKED TO MyFields(X) OF MyCDV
ENDMAKE

SET MyBottom = MyBottom - 29

IF (RIGHTOF(edit) + 20) > MyWidth
SET MyWidth = RIGHTOF(edit) + 20
ENDIF



ENDFOR

REM --- Reset the bottom to be above all edit fields \---;
SET MyBottom = 20 + (29 * NUMBEROF(MyFields)) + 15

REM --- Place Bitmap/Status Information Above Edit Fields \---;

MAKE BITMAP
HAVING \[HPSID = , LEFT = 20,"HPS"
BOTTOM = MyBottom, WIDTH = 50,
HEIGHT = 50, FILE = \]"DEFAULT.BMP"
ENDMAKE
MAKE PROTECTED_EDIT_FIELD
HAVING \[HPSID = , LEFT = 80,"STATUS_DATE"
BOTTOM = MyBottom + 31, HEIGHT = 19,
WIDTH = 60, FONT = ,"SWISS8"
TABSTOP = \]"FALSE"
LINKED TO (GET FIELD NAMED )"STATUS_DATE"
ENDMAKE

MAKE PROTECTED_EDIT_FIELD
HAVING \[HPSID = , LEFT = 80,"STATUS_TIME"
BOTTOM = MyBottom, HEIGHT = 19,
WIDTH = 60, FONT = ,"SWISS8"
TABSTOP = \]"FALSE"
LINKED TO (GET FIELD NAMED )"STATUS_TIME"
ENDMAKE

SET MyBottom = MyBottom - 2
MAKE RECTANGLE
HAVING \[HPSID = , LEFT = 0,"Line"
BOTTOM = MyBottom, WIDTH = MyWidth,
HEIGHT = 1\]
ENDMAKE

SET MyBottom = MyBottom + 50

REM --- Size and Position the window \---;
SIZE WINDOW MyWidth BY (MyBottom + 45)



POSITION WINDOW AT 50, 50

ENDWINDOW

TurboCycler Repository Types and Properties

Repository Types and Properties describes the object types in the Information Model that TurboCycler can access or generate. The Information
Model defines the objects that an AppBuilder repository can contain. Repository objects include entities and relationships. The Information Model
describes the entity types and relationship types they can have with each other. These objects have properties that you can query or set. Some
properties have a set of values called a domain.
Repository Types and Properties describe the types of objects, the relationships between them, and the properties of each that you can use in
template language statements.
This includes:

Object Types and Properties
Entity Types and Properties
Entities and Relationships
Relationship Types and Properties

This chapter begins with a short description of how to access repository information. The next section shows a short example with template
language statements using repository types and properties. Then, object and relationship types and their corresponding properties are described.
Repository Types and Properties ends with a list of the domains for properties that have them.

Repository Object Type Query Sample

A number of TurboCycler template language statements can access the repository and perform queries. For example, you can query the type of a
repository object using the TYPEOF (object_expression) function:

SET X = GET FIELD NAMED "RETURN_CODE"
SET Y = TYPEOF( X ) // Y = "FIELD"

All object query statements return lists that are automatically sorted by sequence number.

Template Language Statement Sample

The following template language statement navigates to the data view of FILEA from within a generation template:

SET DataView = CHILD VIEW OF FILEA
VIA RELATION OWNS_VIEW
WITH [VIEW_USAGE = ]"DATA"

The next example defines the child object type (VIEW) as an object type. VIEW is a valid entity type with three properties: an implementation
name, a name, and a system ID.

VIEW
IMPLEMENTATION_NAME
NAME
SYSID

The next example defines the child relationship type OWNS_VIEW as a relationship type having two properties: sequence number and view
usage. The VIEW_USAGE property has a domain, ViewUsage.

OWNS_VIEW
SEQUENCE_NUMBER
VIEW_USAGE: ViewUsage



The ViewUsage domain controls the values in the following example:

ViewUsage
ALTERNATE CANDIDATE
DATA FOREIGN
INPUT INPUT/OUTPUT
OUTPUT PRIMARY
WORK

You can find a view with VIEW_USAGE 'output' or VIEW_USAGE 'input/output'. Use the following syntax to find a view:

[VIEW_USAGE = ]"INPUT/OUTPUT"

or

[VIEW_USAGE = ]"INPUT"

Object Types and Properties

Object types have properties that can be set or queried. The properties of the object type are described after the object. TurboCycler Entity Types
lists the supported entity types.

TurboCycler Entity Types

APPLICATION_CONFIGURATION KEY

ASSUMPTION LANGUAGE

ATTRIBUTE LOCATION

BITMAP LOGICAL_PROCESS

BITMAP_IMPLEMENTATION MACHINE

BUSINESS_OBJECT MIGRATION

CELL OPPORTUNITY

COLLECTION ORGANIZATION

COLUMN PANEL

COMPONENT PARTITION

COMPONENT_FOLDER PHYSICAL_EVENT

CONTEXT_DIAGRAM PROCESS

DATABASE RELATIONSHIP

DATA_FLOW REPORT

DATA_STORE REQUIREMENT

DATA_TYPE RULE

DEVELOPMENT_PROJECT SECTION

DRAWING SERVER

ENTITY SET

ER_VIEW SOFTWARE_PACKAGE

EVENT STATE

EXTERNAL_AGENT SUCCESS_FACTOR



FIELD SYMBOL

FILE SYSTEM

FORM TABLE

FSDM_SCHEMA TRANSITION

FSDM_VALUE VALUE

FUNCTION VERSION

GOAL VIEW

HELP WINDOW

IDENTIFIER WINDOW_CONTENT

INFORMATION_NEED  

All object types have the properties OBJECT_TEXT and OBJECT_KEYWORDS. For example:

SET X = QUERY OBJECT_TEXT OF Y

The result of this expression is to store the TEXT of object Y as a string in variable X.
Additionally, there are audit properties that are common to all objects in the Workgroup Repository.  is aWorkgroup Repository Audit Properties
list of the audit properties and their character restrictions:

Workgroup Repository Audit Properties

Properties Character Restriction

FWY_PROJECT char 10

FWY_USER char 10

FWY_DATE char 8

FWY_TIME char 8

FWY_LOCKOWNER char 10

FWY_OWNER char 10

Audit Properties

All entities have the read-only audit properties listed in .Universal Read-Only Audit Properties

Universal Read-Only Audit Properties

CHANGE_NUMBER OBJECT_KEYWORDS

OBJECT_TEXT OWNER

PROJECT REMOTE_DATE_CREATED

REMOTE_TIME_CREATED REMOTE_CREATED_BY

REMOTE_DATE_MAINTAINED REMOTE_TIME_MAINTAINED

REMOTE_MAINTAINED_BY  

Entity Types and Properties

The following table provides information on entities and their properties. Each named entity is also hyperlinked to , which lists theRelationships
relationships for each parent-child relationships for each entity.

Entities and their Properties



Name Properties Domain Values

APPLICATION_CONFIGURATION Name 
Sysid

 

ASSUMPTION ASSUMPTION_DESCRIPTION 
TYPE 
PRIORITY 
ACTUAL_START_DATE 
PLANNED_START_DATE 
CONFIDENCE_LEVEL 
RISK

TYPE Properties: 

FINANCIAL 
BUSINESS 
TECHNICAL 

PRIORITY Values: 
MEDIUM 
LOW 
HIGH 

CONFIDENCE_LEVEL Values: 
LOW 
MEDIUM 
HIGH 

RISK Values: 
MEDIUM 
LOW 
HIGH

ATTRIBUTE DERIVATION 
NAME 
SYSID

DERIVATION Values: 

DERIVED 
FUNDAMENTAL

BITMAP IMPLEMENTATION_NAME 
NAME 
SYSID 
TYPE

TYPE Domain values: 

BITMAP 
ICON 
JPEG

BITMAP_IMPLEMENTATION NAME 
SYSID 
TYPE 
X_RESOLUTION 
Y_RESOLUTION

TYPE Domain value: 

BITMAP 
ICON 
JPEG

BUSINESS_OBJECT BUSINESS_OBJECT_DESCRIPTION 
NAME 
SYSID 
TYPE

TYPE values: 

REFERENTIAL 
TRANSACTIONAL

COLLECTION NAME 
NATURE 
NUMBER_OF_ELEMENTS 
NUMBER_OF_GROUPS 
SYSID 
TYPE

NATURE values: 

LOGICAL 
PHYSICAL 
RELATIONAL



COLUMN AVE_LENGTH 
IMPLEMENTATION_NAME 
LENGTH 
NAME 
SCALE 
SYSID 
TYPE

TYPE Domain values: 

BOOLEAN 
CHARACTER 
DATE 
DECIMAL 
GRAPHIC_CHARACTER 
IMAGE 
INTEGER 
MIXED_CHARACTER 
OBJECT_REFERENCE 
PICTURE 
TEXT 
TIME 
TIMESTAMP 
VARCHAR

COMPONENT DBMS_USAGE 
ENVIRONMENT 
EXECUTION_MODE 
IMPLEMENTATION_NAME 
LANGUAGE 
NAME 
SOURCE_FILE 
SYSID

DBMS_USAGE values: 

DB2 
NOT_APPLICABLE 
DLI 

ENVIRONMENT values: 
CICS 
CICS_BATCH 
IMS 
MVS_BATCH 
PC 
PC_SYSTEM 
PC_USER 

EXECUTION_MODE Domain values: 
HAS_SUBROUTINE 
NO_SUBROUTINE 

LANGUAGE values: 
ASSEMBLER 
COBOL 
C 
JAVA 
PLI

COMPONENT_FOLDER COMPONENT_TYPE 
COMPONENT_FOLDER_DESCRIPTION

 

CONTEXT_DIAGRAM SOURCE_FILE  

DATABASE IMPLEMENTATION_NAME 
MACHINE_NAME 
NAME 
SYSID 
TYPE

TYPE Domain values: 

DB2 
DB2/UDB 
ORACLE 
MS-SQLSERVER

DATA_FLOW TYPE 
IMPLEMENT_AS

TYPE Domain values: 

CONTROL 
BOTH 
DATA 

IMPLEMENT_AS values: 
UNKNOWN 
SCREEN 
REPORT



DATA_STORE DATA_STORE_DESCRIPTION 
NAME 
SYSID

 

DATA_TYPE FRACTION 
LENGTH 
NAME 
SYSID 
TYPE

TYPE Domain values: 

BOOLEAN 
CHARACTER 
DATE 
DECIMAL 
GRAPHIC_CHARACTER 
IMAGE 
INTEGER 
MIXED_CHARACTER 
OBJECT_REFERENCE 
PICTURE 
TEXT 
TIME 
TIMESTAMP 
VARCHAR

DEVELOPMENT_PROJECT ACTUAL_END_DATE 
ACTUAL_START_DATE 
ESTIMATED_COST 
ESTIMATED_ROI 
PLANNED_START_DATE 
PLANNED_END_DATE 
RISK 
STATUS 
PRIORITY 
TECHNICAL_COMPLEXITY 
TYPE

RISK Domain values: 

MEDIUM 
LOW 
HIGH 

STATUS Domain values: 
PLANNED 
ACTIVE 

PRIORITY Domain values: 
MEDIUM 
LOW 
HIGH 

TECHNICAL_COMPLEXITY Domain values: 
MEDIUM 
LOW 
HIGH

DRAWING NAME 
SYSID 
TYPE

TYPE Domain values: 

DATABASE_DESIGN 
DATA_STORE_VS_ENTITY 
ENTITY_RELATIONSHIP 
ENTITY_VS_LOCATION_1 
ENTITY_VS_LOCATION_2 
FUNCTION_VS_ENTITY 
FUNCTION_VS_LOCATION 
MATRIX 
ORGANIZATION_VS_ENTITY 
ORGANIZATION_VS_PROCESS 
PROCESS_DEPENDENCY 
PROCESS_VS_ENTITY 
STATE_TRANSITION 
SYSTEM_VS_DATA_STORE 
SYSTEM_VS_PROCESS 
WINDOW_FLOW



ENTITY ACTIVITY_PERIOD 
AVERAGE_DELETES 
AVERAGE_INSERTS 
AVERAGE_UPDATES 
EXPECTED_ROWS 
MAXIMUM_ROWS 
MINIMUM_ROWS 
NAME 
SYSID 
TYPE

ACTIVITY_PERIOD Domain values: 

HOUR 
MINUTE 
SECOND 
DAY 
QUARTER 
YEAR 
MONTH 
WEEK 

TYPE Domain values: 
ASSOCIATIVE 
CHARACTERISTIC 
INTERSECTION 
KERNEL

ER_VIEW ER_VIEW_DESCRIPTION 
SOURCE_FILE 
SOURCE_FILE

 

EVENT CLASS 
EVENT_DESCRIPTION 
NAME 
SYSID 
TYPE

CLASS Domain values: 

TEMPORAL 
EXTERNAL 
INTERNAL

EXTERNAL_AGENT EXTERNAL_AGENT_DESCRIPTION 
TYPE

TYPE Properties: 

SYSTEM 
ROLE 
ORGANIZATION

FIELD FRACTION 
IMPLEMENTATION_NAME 
LENGTH 
MAXIMUM 
MINIMUM 
NAME 
PICTURE_CLAUSE 
REF 
SCREEN_LITERAL 
SCREEN_PICTURE 
SHORT_SCREEN_LITERAL 
SYSID 
TYPE

TYPE Domain values: 

CHARACTER 
DATE 
DECIMAL 
GRAPHIC_CHARACTER 
IMAGE 
INTEGER 
MIXED_CHARACTER 
PICTURE 
TEXT 
TIME 
TIMESTAMP 
VARCHAR

FILE IMPLEMENTATION_NAME 
NAME 
SYSID 
TYPE

TYPE Domain values: 

DB2 
DB2/UDB 
ORACLE 
MS-SQLSERVER



FORM ENVIRONMENT 
BASE 
COUNTRY_LANGUAGE 
SOURCE_FILE

ENVIRONMENT Domain values: 

WINDOWS 
AFP 

BASE Domain values: 
FALSE 
TRUE 

COUNTRY_LANGUAGE Domain values: 
US_ENGLISH 
UK_ENGLISH

FSDM_SCHEMA FSDM_SCHEME_DESCRIPTION 
MUTUALLY_EXCLUSIVE 
NAME 
SYSID

MUTUALLY_EXCLUSIVE Domain values: 

FALSE 
TRUE

FSDM_VALUE FSDM_VALUE_DESCRIPTION 
NAME 
SYSID

 

FUNCTION CHILD_MENU 
MENU_DESCRIPTION 
NAME 
SYSID 
WORKSTATION_GROUP

CHILD_MENU Domain values: 

MENU_BAR 
NO_MENU 
PULL_DOWN

GOAL GOAL_DESCRIPTION 
TYPE 
PRIORITY 
RISK 
ACTUAL_START_DATE 
PLANNED_START_DATE 
CONFIDENCE_LEVEL 
TARGET_VALUE

GOAL_TYPE Domain values: 

OBJECTIVE 
GOAL 
POLICY 
STRATEGY 
MISSION 

PRIORITY Domain values: 
MEDIUM 
LOW 
HIGH 

RISK Domain values: 
MEDIUM 
LOW 
HIGH 

CONFIDENCE_LEVEL Properties 
LOW 
MEDIUM 
HIGH

HELP HELP_DESCRIPTION 
FORMAT 
NAME 
SYSID 
COUNTRY_LANGUAGE 
SOURCE_FILE

FORMAT Domain values: 

IPF 
HPS 
RTF

HELP_TEXT COUNTRY_LANGUAGE COUNTRY_LANGUAGE Domain values: 

US_ENGLISH 
UK_ENGLISH



IDENTIFIER NAME 
SYSID 
TYPE

TYPE Domain values: 

ALTERNATE 
CANDIDATE 
PRIMARY

INFORMATION_NEED INFORMATION_NEED_DESCRIPTION 
PRIORITY 
RISK 
ACTUAL_START_DATE 
PLANNED_START_DATE

PRIORITY Domain values: 

MEDIUM 
LOW 
HIGH 

RISK Domain values: 
MEDIUM 
LOW 
HIGH

KEY IMPLEMENTATION_NAME 
NAME 
SYSID 
TYPE 
DELETE_RULE 
UNIQUE

TYPE Domain values: 

FOREIGN 
INDEX 
PRIMARY 

DELETE_RULE Domain values: 
CASCADE 
NULL 
RESTRICT 

UNIQUE Domain values: 
FALSE 
TRUE

LANGUAGE ABBREV  

LOCATION LOCATION_DESCRIPTION 
NAME 
SYSID

 

LOGICAL_PROCESS LOGICAL_PROCESS_DESCRIPTION 
MODE 
NAME 
SYSID 
TYPE

MODE Domain values: 

ACTION 
DECISION 

TYPE Domain values: 
ASSOCIATE 
CALCULATE 
CAPTURE 
DELETE 
RETRIEVE 
UPDATE 
VALIDATE 
VALIDATE

MACHINE GROUP 
IMPLEMENTATION_NAME 
NAME 
OPERATING_SYSTEM 
OPERATING_SYSTEM_RELEASE 
SYSID

OPERATING_SYSTEM Domain values: 

AIX 
CICS_MVS 
HPUX 
IMS 
MVS 
SUN_OS 
WINDOWS



MIGRATION STATE 
DSN 
RETURN_CODE 
SOURCE_FILE

MIGRATION_STATE Domain values: 

IMPORT_JOB_SUBMITTED 
NO_ACTION_EXECUTED 
IMPORT_JOB_FAILED 
IMPORT_JOB_SUCCESSFUL 
IMPORT_JOB_APPROVED 
LOAD_JOB_FAILED 
IMPORT_JOB_EXECUTING 
EXPORT_JOB_EXECUTING 
LOAD_JOB_SUCCESSFUL 
EXPORT_JOB_FAILED 
LOAD_JOB_APPROVED 
EXPORT_JOB_SUCCESSFUL 
ANALYZE_JOB_SUBMITTED 
EXPORT_JOB_APPROVED 
ANALYZE_JOB_EXECUTING 
LOAD_JOB_SUBMITTED 
ANALYZE_JOB_FAILED 
LOAD_JOB_EXECUTING 
ANALYZE_JOB_SUCCESSFUL 
EXPORT_JOB_SUBMITTED 
ANALYZE_JOB_APPROVED

OPPORTUNITY OPPORTUNITY_DESCRIPTION 
BENEFIT 
EXPLT_COST 
IGNORE_COST 
ACTUAL_START_DATE 
PLANNED_START_DATE 
PRIORITY 
CONFIDENCE_LEVEL 
RISK 
STATUS 
TYPE 
OPERATING_SYSTEM

PRIORITY Domain values: 

MEDIUM 
LOW 
HIGH 

CONFIDENCE_LEVEL Properties 
LOW 
MEDIUM 
HIGH 

RISK Domain values: 
MEDIUM 
LOW 
HIGH 

STATUS Domain values: 
IMPORT_JOB_SUBMITTED 
FUNDED 
REJECTED 
SIZED 
DEFERRED 

OPERATING_SYSTEM Domain values: 
AIX 
CICS_6000 
CICS_MVS 
HPUX 
MVS 
SUN_OS 
WINDOWS

ORGANIZATION NAME 
SYSID

 



PANEL CODEPAGE 
BASE? 
COUNTRY_LANGUAGE 
GUI 
SOURCE_FILE 
COORDINATE_METHOD 
PANEL_DESCRIPTION 
NAME 
SYSID 
X_RESOLUTION 
Y_RESOLUTION

BASE Domain values: 

FALSE 
TRUE 

COUNTRY_LANGUAGE Domain values: 
US_ENGLISH 
UK_ENGLISH 

GUI Domain values: 
3270 
PWS_GENERIC 
OPEN_LOOK 
WINDOWS 

COORDINATE_METHOD Domain values: 
CHARACTER 
PIXEL

PARTITION CELL_RANK 
CLIENT_TYPE 
COLLECTION_ID 
GENERAL_LANGUAGE 
IMPLEMENTATION_PACKAGE 
ISOLATION_MODE 
LINK_TYPE 
MAXIMUM_TRANS_ID 
MINIMUM_TRANS_ID 
NAME 
PARTITION_TYPE 
SERVER_INTERFACE 
SERVER_OWNER 
PLAN_NAME 
QUALIFIER 
SYSID

CLIENT_TYPE values: 

HTML 
CONVERSE 
EVENT-DRIVEN 

GENERAL_LANGUAGE values: 
DEFAULT 
JAVA 

LINK_TYPE values: 
DYNAMIC 
STATIC 

SERVER_INTERFACE values: 
AppBuilder Communications 
RMI 
ENTERPRISE_JAVABEANS 
MQ-SERIES

PHYSICAL_EVENT PHYSICAL_EVENT_DESCRIPTION 
TYPE 
EVENT_CLASS 
EVENT_SCOPE

EVENT_CLASS domain values: 

TEMPORAL 
EXTERNAL 
INTERNAL 

EVENT_SCOPE domain values: 
GLOBAL 
LOCAL 
CELL



PROCESS CHILD_MENU 
EXECUTION_ENVIRONMENT 
MENU_DESCRIPTION 
NAME 
SYSID 
WORKSTATION_GROUP

CHILD_MENU Domain values: 

MENU_BAR 
NO_MENU 
PULL_DOWN 

EXECUTION_ENVIRONMENT Domain values:

CICS 
IMS 
NOT_APPLICABLE 
PC 
PC_AND_CICS 
PC_AND_IMS

RELATIONSHIP ACTIVITY_PERIOD 
AVERAGE_DELETES 
AVERAGE_INSERTS 
AVERAGE_UPDATES 
EXPECTED_ROWS 
MAXIMUM_ROWS 
MINIMUM_ROWS 
NAME 
SYSID 
TYPE

ACTIVITY_PERIOD Domain values: 

DAY 
MONTH 
QUARTER 
WEEK 
YEAR 

TYPE Domain values: 
AND 
IOR 
REGULAR 
SUBTYPE 
XOR 
XOR

REPORT EXECUTION_ENVIRONMENT 
IMPLEMENTATION_NAME 
LEFT_MARGIN 
LINE_SIZE 
NAME 
ORIENTATION 
PAGE_SIZE 
PRINTER_TYPE 
SYSID 
TOP_MARGIN

EXECUTION_ENVIRONMENT Domain values: 

BATCH 
CICS 
CICS_BATCH 

ORIENTATION Domain values: 
LANDSCAPE 
PORTRAIT 

PRINTER_TYPE Domain values: 
3800 
GENERIC



REQUIREMENT REQUIREMENT_DESCRIPTION 
TYPE 
CONFIDENCE_LEVEL 
PLANNED_START_DATE 
PRIORITY 
RISK

REQUIREMENT_TYPE Domain values: 

CUSTOMER 
TECHNICAL 
COMPETITION 
BUSINESS 

CONFIDENCE_LEVEL Properties 
LOW 
MEDIUM 
HIGH 

PRIORITY Domain values: 
MEDIUM 
LOW 
HIGH 

RISK Domain values: 
MEDIUM 
LOW 
HIGH

RULE DBMS 
ENVIRONMENT 
IMPLEMENTATION_NAME 
ISOLATION_MODE 
NAME 
PACKAGE 
PLAN_NAME 
SOURCE_FILE 
SYSID 
TRANID

DBMS Domain values: 

DB2 
N/A 

ENVIRONMENT Domain values: 
CICS 
CICS_AND_BATCH 
IMS 
LANDP_FUNCTION 
LANDP_SERVER 
MVS_BATCH 
PC 
PC_AND_CICS 
PC_AND_IMS 
STRATUS 

EXECUTION_MODE Domain values: 
ASYNCHRONOUS 
SYNCHRONOUS

SECTION IMPLEMENTATION_NAME 
SOURCE_FILE 
NAME 
SYSID

 

SERVER COLLECTION_ID 
IMPLEMENTATION_NAME 
ISOLATION_MODE 
MAXIMUM_TRANSACTION_ID 
MINIMUM_TRANSACTION_ID 
NAME 
NEXT_TRANSACTION_ID

ISOLATION_MODE Domain values: 

GET 
SET 
XDR-GET 
XDR-SET



SET FRACTION 
IMPLEMENTATION_NAME 
LENGTH 
NAME 
PICTURE 
REPRESENTATION_LENGTH 
STYLE 
SYSID 
TYPE

STYLE Domain values: 

DEFINE 
ERROR 
LOOKUP 
VALUES 

TYPE Domain values: 
CHARACTER 
DECIMAL 
GRAPHIC_CHAR 
INTEGER 
MIXED_CHAR

SOFTWARE_PACKAGE STATE 
VALIDATE_FLAG

VALIDATE_FLAG Domain values: 

FALSE 
TRUE

STATE STATE_DESCRIPTION 
NAME 
SYSID 
TYPE

TYPE Domain values: 

FINAL 
INITIAL 
INTERMEDIATE

SUCCESS_FACTOR SUCCESS_FACTOR_DESCRIPTION 
CONFIDENCE_LEVEL 
PRIORITY 
ACTUAL_START_DATE 
PLANNED_START_DATE 
RISK 
TARGET_VALUE

CONFIDENCE_LEVEL Properties: 

LOW 
MEDIUM 
HIGH 

PRIORITY Domain values: 
MEDIUM 
LOW 
HIGH 

RISK Domain values: 
MEDIUM 
LOW 
HIGH 
HIGH

SYMBOL DEFINE 
ENCODING 
DISPLAY

 

SYSTEM SYSTEM_DESCRIPTION 
NAME 
SYSID

 

TABLE ACTIVATION_PERIOD 
AVE_DELETES 
AVE_INSERTS 
AVE_UPDATES 
CREATOR 
IMPLEMENTATION_NAME 
MAXIMUM_ROWS 
MINIMUM_ROWS 
NAME 
SYSID 
TYPE

ACTIVATION_PERIOD Domain values: 

DAY 
MONTH 
QUARTER 
WEEK 
YEAR 

TYPE Domain values: 
TABLE 
VIEW

TRANSITION NAME 
SYSID

 



VALUE IMPLEMENTATION_NAME 
NAME 
SYSID

 

VERSION STATE 
VERSION_DESCRIPTION STATE Domain values: 

ROOT 
DELETED 
FIXED 
RELEASE 
WORKING

VIEW IMPLEMENTATION_NAME 
VIEW_NAME 
SYSID

 

WINDOW IMPLEMENTATION_NAME 
NAME 
SYSID

 

WINDOW_CONTENT GUI 
NAME 
SYSID

GUI Domain values: 

3270 
PWS_GENERIC 
OPEN_LOOK 
OSF_MOTIF 
WINDOWS

Entities and Relationships

The following table provides information on entities and relations in the TurboCycler Developer's Kit. TurboCycler is not supported for the new OO
objects.

Relationships

Parent Relationship Relationship Properties

APPLICATION_CONFIGURATION APPLICATION_CONFIGURATION_HAS_CONFIGURATION_UNIT Sequence Number (1-999)

ASSUMPTION ASSUMPTION_AFFECTS SEQUENCE_NUMBER 
RESPONSIBLE 
MAJOR_INV 
MINOR_INV 
COMMENTS 
OBJECT_TEXT

ASSUMPTION ASSUMPTION_AFFECTS SEQUENCE_NUMBER 
RESPONSIBLE 
MAJOR_INV 
MINOR_INV 
COMMENTS 
OBJECT_TEXT

ASSUMPTION ASSUMPTION_SUPPORTED_BY SEQUENCE_NUMBER 
RESPONSIBLE 
MAJOR_INV 
MINOR_INV 
COMMENTS 
OBJECT_TEXT

ASSUMPTION ASSUMPTION_SUPPORTED_BY SEQUENCE_NUMBER 
RESPONSIBLE 
MAJOR_INV 
MINOR_INV 
COMMENTS 
OBJECT_TEXT



ASSUMPTION ASSUMPTION_SUPPORTED_BY SEQUENCE_NUMBER 
RESPONSIBLE 
MAJOR_INV 
MINOR_INV 
COMMENTS 
OBJECT_TEXT

ASSUMPTION ASSUMPTION_SUPPORTED_BY SEQUENCE_NUMBER 
RESPONSIBLE 
MAJOR_INV 
MINOR_INV 
COMMENTS 
OBJECT_TEXT

ATTRIBUTE CONNECTS_TO SEQUENCE NUMBER (1-999) 
OBJECT_TEXT

ATTRIBUTE CONNECTS_TO SEQUENCE NUMBER (1-999) 
OBJECT_TEXT

ATTRIBUTE CONNECTS_TO SEQUENCE NUMBER (1-999) 
OBJECT_TEXT

ATTRIBUTE CONNECTS_TO SEQUENCE NUMBER (1-999) 
OBJECT_TEXT

ATTRIBUTE IMPLEMENTED_BY SEQUENCE NUMBER (1-999) 
OBJECT_TEXT

ATTRIBUTE IMPLEMENTED_BY SEQUENCE NUMBER (1-999) 
OBJECT_TEXT

ATTRIBUTE IMPLEMENTED_BY SEQUENCE NUMBER (1-999) 
OBJECT_TEXT

ATTRIBUTE IMPLEMENTED_BY SEQUENCE NUMBER (1-999) 
OBJECT_TEXT

ATTRIBUTE IMPLEMENTED_BY SEQUENCE NUMBER (1-999) 
OBJECT_TEXT

ATTRIBUTE IS_COMPOSED_OF_ATTRIBUTE SEQUENCE NUMBER (1-999) 
OCCURS 
OBJECT_TEXT

ATTRIBUTE IS_TYPED_BY SEQUENCE NUMBER (1-999) 
OBJECT_TEXT

BITMAP BITMAP_HAS_BITMAP_IMPLEMENTATION IS_COMPOSED_OF_ATTRIBUTE Properties: 
SEQUENCE NUMBER (1-999) 
OBJECT_TEXT

BITMAP_IMPLEMENTATION PHYSICAL_BITMAP_FILE  

BUSINESS_OBJECT BUSINESS_OBJECT_OWNS BUSINESS_OBJECT_OWNS Properties: 
SEQUENCE NUMBER (1-999) 
OBJECT_TEXT

BUSINESS_OBJECT BUSINESS_OBJECT_OWNS BUSINESS_OBJECT_OWNS Properties: 
SEQUENCE NUMBER (1-999) 
OBJECT_TEXT

BUSINESS_OBJECT BUSINESS_OBJECT_OWNS BUSINESS_OBJECT_OWNS Properties: 
SEQUENCE NUMBER (1-999) 
OBJECT_TEXT

BUSINESS_OBJECT BUSINESS_OBJECT_REFINES_INTO_BUSINESS_OBJECT BUSINESS_OBJECT_REFINES_INTO_BUSINESS_OBJECT
Properties: 
SEQUENCE NUMBER (1-999) 
OBJECT_TEXT

BUSINESS_OBJECT HAS_STATE HAS_STATE Properties: 
SEQUENCE NUMBER (1-999) 
OBJECT_TEXT



BUSINESS_OBJECT HAS_STD_DRAWING HAS_STD_DRAWING Properties: 
SEQUENCE NUMBER (1-999) 
OBJECT_TEXT

COLLECTION CONNECTS_TO CONNECTS_TO Properties: 
SEQUENCE NUMBER (1-999) 
OBJECT_TEXT

COLLECTION CONNECTS_TO CONNECTS_TO Properties: 
SEQUENCE NUMBER (1-999) 
OBJECT_TEXT

COLLECTION CONNECTS_TO CONNECTS_TO Properties: 
SEQUENCE NUMBER (1-999) 
OBJECT_TEXT

COLLECTION CONNECTS_TO CONNECTS_TO Properties: 
SEQUENCE NUMBER (1-999) 
OBJECT_TEXT

COLLECTION IMPLEMENTED_BY IMPLEMENTED_BY Properties: 
SEQUENCE NUMBER (1-999) 
OBJECT_TEXT

COLLECTION IMPLEMENTED_BY IMPLEMENTED_BY Properties: 
SEQUENCE NUMBER (1-999) 
OBJECT_TEXT

COLLECTION IMPLEMENTED_BY IMPLEMENTED_BY Properties: 
SEQUENCE NUMBER (1-999) 
OBJECT_TEXT

COLLECTION IMPLEMENTED_BY IMPLEMENTED_BY Properties: 
SEQUENCE NUMBER (1-999) 
OBJECT_TEXT

COLLECTION IMPLEMENTED_BY IMPLEMENTED_BY Properties: 
SEQUENCE NUMBER (1-999) 
OBJECT_TEXT

COLUMN [None]  

COMPONENT OWNS_VIEW OWNS_VIEW Properties: 
SEQUENCE_NUMBER 
VIEW_USAGE 
OBJECT_TEXT

COMPONENT REFERS_TO REFERS_TO Properties: 
SEQUENCE NUMBER 
OBJECT_TEXT

COMPONENT ACCESSES ACCESSES Properties: 
SEQUENCE_NUMBER 
COMP_USAGE 
OBJECT_TEXT

COMPONENT COMPONENT_USES_COMPONENT COMPONENT_USES_COMPONENT Properties: 
SEQUENCE_NUMBER 
OBJECT_TEXT

COMPONENT COMPONENT_SOURCE [None]

CONTEXT_DIAGRAM CONTEXT_DIAGRAM_CONTAINS CONTEXT_DIAGRAM_CONTAINS Properties: 
SEQUENCE_NUMBER 
OBJECT_TEXT

CONTEXT_DIAGRAM CONTEXT_DIAGRAM_CONTAINS CONTEXT_DIAGRAM_CONTAINS Properties: 
SEQUENCE_NUMBER 
OBJECT_TEXT

CONTEXT_DIAGRAM CONTEXT_DIAGRAM_CONTAINS CONTEXT_DIAGRAM_CONTAINS Properties: 
SEQUENCE_NUMBER 
OBJECT_TEXT



CONTEXT_DIAGRAM CONTEXT_DIAGRAM_CONTAINS CONTEXT_DIAGRAM_CONTAINS Properties: 
SEQUENCE_NUMBER 
OBJECT_TEXT

CONTEXT_DIAGRAM CONTEXT_DIAGRAM_CONTAINS CONTEXT_DIAGRAM_CONTAINS Properties: 
SEQUENCE_NUMBER 
OBJECT_TEXT

CONTEXT_DIAGRAM DATA_CONTENT_DEFINED_BY DATA_CONTENT_DEFINED_BY Properties: 
SEQUENCE_NUMBER 
OBJECT_TEXT

DATABASE ACCESSES ACCESSES Properties: 
SEQUENCE_NUMBER 
COMP_USAGE 
OBJECT_TEXT

DATABASE DATABASE_HAS_TABLE DATABASE_HAS_TABLE Properties: 
SEQUENCE_NUMBER 
MINIMUM_ROWS 
MAXIMUM_ROWS 
ACTIVE_PERIOD 
AVE_INSERTS 
AVE_DELETES 
DONE_FLAG 
DO_FLAG 
OBJECT_TEXT

DATABASE DATABASE_RELATED_TO_DATABASE DATABASE_RELATED_TO_DATABASE Properties: 
SEQUENCE_NUMBER 
REL_TYPE 
SHADOWED_TABLE 
OBJECT_TEXT

DATA_FLOW DATA_CONTENT_DEFINED_BY DATA_CONTENT_DEFINED_BY Properties: 
SEQUENCE_NUMBER 
OBJECT_TEXT

DATA_STORE DATA_CONTENT_DEFINED_BY DATA_CONTENT_DEFINED_BY Properties: 
SEQUENCE_NUMBER 
OBJECT_TEXT

DATA_STORE DATA_STORE_IS_REPLACED_BY_ENTITY DATA_STORE_IS_REPLACED_BY_ENTITY Properties: 
SEQUENCE_NUMBER 
COMMENTS 
OBJECT_TEXT

DATA_TYPE IMPLEMENTED_BY IMPLEMENTED_BY Properties: 
SEQUENCE NUMBER (1-999) 
OBJECT_TEXT

DATA_TYPE IMPLEMENTED_BY IMPLEMENTED_BY Properties: 
SEQUENCE NUMBER (1-999) 
OBJECT_TEXT

DATA_TYPE IMPLEMENTED_BY IMPLEMENTED_BY Properties: 
SEQUENCE NUMBER (1-999) 
OBJECT_TEXT

DATA_TYPE IMPLEMENTED_BY IMPLEMENTED_BY Properties: 
SEQUENCE NUMBER (1-999) 
OBJECT_TEXT

DATA_TYPE IMPLEMENTED_BY IMPLEMENTED_BY Properties: 
SEQUENCE NUMBER (1-999) 
OBJECT_TEXT

DATA_TYPE CONNECTS_TO CONNECTS_TO Properties: 
SEQUENCE NUMBER (1-999) 
OBJECT_TEXT

DATA_TYPE CONNECTS_TO CONNECTS_TO Properties: 
SEQUENCE NUMBER (1-999) 
OBJECT_TEXT



DATA_TYPE CONNECTS_TO CONNECTS_TO Properties: 
SEQUENCE NUMBER (1-999) 
OBJECT_TEXT

DATA_TYPE CONNECTS_TO CONNECTS_TO Properties: 
SEQUENCE NUMBER (1-999) 
OBJECT_TEXT

DATA_TYPE DATATYPE_IS_CONSTRAINED_BY_SET DATATYPE_IS_CONSTRAINED_BY_SET Properties: 
SEQUENCE_NUMBER 
OBJECT_TEXT

DATA_TYPE DATATYPE_IS_COMPOSED_OF_DATATYPE DATATYPE_IS_COMPOSED_OF_DATATYPE Properties: 
SEQUENCE_NUMBER 
OCCURS 
OBJECT_TEXT

DEVELOPMENT_PROJECT DEV_PROJECT_ADDRESSES DEV_PROJECT_ADDRESSESS Properties: 
SEQUENCE_NUMBER 
OBJECT_TEXT

DEVELOPMENT_PROJECT DEV_PROJECT_ADDRESSES DEV_PROJECT_ADDRESSESS Properties: 
SEQUENCE_NUMBER 
OBJECT_TEXT

DEVELOPMENT_PROJECT DEV_PROJECT_ADDRESSES DEV_PROJECT_ADDRESSESS Properties: 
SEQUENCE_NUMBER 
OBJECT_TEXT

DEVELOPMENT_PROJECT DEV_PROJECT_CONTAINS DEV_PROJECT_CONTAINS Properties: 
SEQUENCE_NUMBER 
OBJECT_TEXT

DEVELOPMENT_PROJECT DEV_PROJECT_INCLUDES DEV_PROJECT_INCLUDES Properties: 
SEQUENCE_NUMBER 
OBJECT_TEXT

DEVELOPMENT_PROJECT DEV_PROJECT_INCLUDES DEV_PROJECT_INCLUDES Properties: 
SEQUENCE_NUMBER 
OBJECT_TEXT

DRAWING [none]  

ENTITY IMPLEMENTED_BY IMPLEMENTED_BY Properties: 
SEQUENCE NUMBER (1-999) 
OBJECT_TEXT

ENTITY IMPLEMENTED_BY IMPLEMENTED_BY Properties: 
SEQUENCE NUMBER (1-999) 
OBJECT_TEXT

ENTITY IMPLEMENTED_BY IMPLEMENTED_BY Properties: 
SEQUENCE NUMBER (1-999) 
OBJECT_TEXT

ENTITY IMPLEMENTED_BY IMPLEMENTED_BY Properties: 
SEQUENCE NUMBER (1-999) 
OBJECT_TEXT

ENTITY IMPLEMENTED_BY IMPLEMENTED_BY Properties: 
SEQUENCE NUMBER (1-999) 
OBJECT_TEXT

ENTITY CONNECTS_TO CONNECTS_TO Properties: 
SEQUENCE NUMBER (1-999) 
OBJECT_TEXT

ENTITY CONNECTS_TO CONNECTS_TO Properties: 
SEQUENCE NUMBER (1-999) 
OBJECT_TEXT

ENTITY CONNECTS_TO CONNECTS_TO Properties: 
SEQUENCE NUMBER (1-999) 
OBJECT_TEXT



ENTITY CONNECTS_TO CONNECTS_TO Properties: 
SEQUENCE NUMBER (1-999) 
OBJECT_TEXT

ENTITY ENTITY_IS_DISTRIBUTED_AT ENTITY_IS_DISTRIBUTED_AT Properties: 
SEQUENCE_NUMBER 
MASTER 
VARIANT 
PARTITIONED 
REPLICATED 
SUBSET 
REORGANIZED 
TELEPROC 
COMMENTS 
OBJECT_TEXT

ENTITY HAS_IDENTIFIER HAS_IDENTIFIER Properties: 
SEQUENCE_NUMBER 
OBJECT_TEXT

ENTITY HAS_STATE HAS_STATE Properties: 
SEQUENCE NUMBER (1-999) 
OBJECT_TEXT

ENTITY OWNS_VIEW OWNS_VIEW Properties: 
SEQUENCE_NUMBER 
VIEW_USAGE 
OBJECT_TEXT

ENTITY IS_DESCRIBED_BY IS_DESCRIBED_BY Properties: 
SEQUENCE_NUMBER 
OPTIONALITY 
MINIMUM_PER_SUBJECT 
MAXIMUM_PER_SUBJECT 
OBJECT_TEXT

ENTITY IS_RELATED_VIA IS_RELATED_VIA Properties: 
SEQUENCE_NUMBER 
CONTROLLING 
CARDINALITY 
OPTIONALITY 
DEPENDENT 
ABSTRACT 
ROLE 
MINIMUM_CARDINALITY 
MAXIMUM_CARDINALITY 
OBJECT_TEXT

ENTITY ENTITY_IS_MODIFIED_AT_LOCATION ENTITY_IS_MODIFIED_AT_LOCATION Properties: 
SEQUENCE_NUMBER 
CREATE 
READ 
UPDATES 
DELETE 
COMMENTS 
OBJECT_TEXT

ENTITY ENTITY_MODIFIED_BY ENTITY_MODIFIED_BY Properties: 
SEQUENCE_NUMBER 
CREATES 
READS 
UPDATES 
DELETES 
COMMENTS 
OBJECT_TEXT

ENTITY ENTITY_MODIFIED_BY ENTITY_MODIFIED_BY Properties: 
SEQUENCE_NUMBER 
CREATES 
READS 
UPDATES 
DELETES 
COMMENTS 
OBJECT_TEXT



ENTITY ENTITY_MODIFIED_BY ENTITY_MODIFIED_BY Properties: 
SEQUENCE_NUMBER 
CREATES 
READS 
UPDATES 
DELETES 
COMMENTS 
OBJECT_TEXT

ENTITY ENTITY_MODIFIED_BY ENTITY_MODIFIED_BY Properties: 
SEQUENCE_NUMBER 
CREATES 
READS 
UPDATES 
DELETES 
COMMENTS 
OBJECT_TEXT

ENTITY ENTITY_MODIFIED_BY ENTITY_MODIFIED_BY Properties: 
SEQUENCE_NUMBER 
CREATES 
READS 
UPDATES 
DELETES 
COMMENTS 
OBJECT_TEXT

ENTITY HAS_ERD_DRAWING HAS_ERD_DRAWING Properties: 
SEQUENCE_NUMBER 
OBJECT_TEXT

ENTITY HAS_STD_DRAWING HAS_STD_DRAWING Properties: 
SEQUENCE NUMBER (1-999) 
OBJECT_TEXT

ER_VIEW ER_VIEW_INVOLVES ER_VIEW_INVOLVES Properties: 
SEQUENCE_NUMBER 
OBJECT_TEXT

ER_VIEW ER_VIEW_INVOLVES ER_VIEW_INVOLVES Properties: 
SEQUENCE_NUMBER 
OBJECT_TEXT

ER_VIEW ER_VIEW_INVOLVES ER_VIEW_INVOLVES Properties: 
SEQUENCE_NUMBER 
OBJECT_TEXT

ER_VIEW ER_VIEW_INVOLVES ER_VIEW_INVOLVES Properties: 
SEQUENCE_NUMBER 
OBJECT_TEXT

ER_VIEW ER_VIEW_CONTAINS ER_VIEW_CONTAINS Properties: 
SEQUENCE_NUMBER 
OBJECT_TEXT

EVENT DATA_CONTENT_DEFINED_BY DATA_CONTENT_DEFINED_BY Properties: 
SEQUENCE_NUMBER 
OBJECT_TEXT

EVENT HAS_PDD_DRAWING HAS_PDD_DRAWING Properties: 
SEQUENCE_NUMBER 
OBJECT_TEXT

EVENT IS_COMPOSED_OF_EVENT IS_COMPOSED_OF_EVENT Properties: 
SEQUENCE_NUMBER 
OBJECT_TEXT

EVENT EVENT_CAUSES EVENT_CAUSES Properties: 
SEQUENCE_NUMBER 
EVENT_CAUSES_DESCRIPTION 
OBJECT_TEXT



EVENT EVENT_TRIGGERS EVENT_TRIGGERS Properties: 
SEQUENCE_NUMBER 
EVENT_TRIGGERS_DESCRIPTION 
INCLUSIVE_FLAG 
EXOR_SEQUENCE_NUMBER

EVENT TRIGGERS_LOGICAL_PROCESS TRIGGERS_LOGICAL_PROCESS Properties: 
SEQUENCE_NUMBER 
TRIGGERS_LOGICAL_PROCESS_DESCRIPTION 
OBJECT_TEXT

EVENT EVENT_INFLUENCES_BUSINESS_OBJECT EVENT_INFLUENCES_BUSINESS_OBJECT Properties: 
SEQUENCE_NUMBER 
EVENT_INFLUENCES_BUSINESS_OBJECT_DESCRIPTION

OBJECT_TEXT

EXTERNAL_AGENT DATA_CONTENT_DEFINED_BY DATA_CONTENT_DEFINED_BY Properties: 
SEQUENCE_NUMBER 
OBJECT_TEXT

EXTERNAL_AGENT INITIATES_EVENT INITIATES_EVENT Properties: 
SEQUENCE_NUMBER 
INITIATES_EVENT_DESCRIPTION 
OBJECT_TEXT

FIELD REFERS_TO REFERS_TO Properties: 
SEQUENCE_NUMBER 
OBJECT_TEXT

FIELD USES_LANGUAGE USES_LANGUAGE Properties: 
SEQUENCE_NUMBER 
VALUE_SHORT 
VALUE_LONG 
OBJECT_TEXT

FIELD HAS_HELP_TEXT HAS_HELP_TEXT Properties: 
SEQUENCE_NUMBER 
OBJECT_TEXT

FILE FILE_IS_FORWARDED_TO_FILE FILE_IS_FORWARDED_TO_FILE Properties: 
SEQUENCE_NUMBER 
UPDATE_RULE 
KEY_DELETE_RULE 
INSERT_RULE 
OBJECT_TEXT

FILE IS_KEYED_BY IS_KEYED_BY Properties: 
SEQUENCE_NUMBER 
TYPE 
OBJECT_TEXT

FILE OWNS_VIEW OWNS_VIEW Properties: 
SEQUENCE_NUMBER 
VIEW_USAGE 
OBJECT_TEXT

FORM [none]  

FSDM_SCHEMA FSDM_SCHEMA_HAS_FSDM_VALUE FSDM_SCHEMA_HAS_FSDM_VALUE properties: 
SEQUENCE_NUMBER 
OBJECT_TEXT

FSDM_VALUE FSDM_VALUE_CLASSIFIES_FSDM_SCHEMA FSDM_VALUE_CLASSIFIES_FSDM_SCHEMA properties: 
SEQUENCE_NUMBER 
OBJECT_TEXT

FUNCTION HAS_BITMAP HAS_BITMAP Properties: 
SEQUENCE_NUMBER 
OBJECT_TEXT



FUNCTION FUNCTION_INTERSECTS_WITH_ENTITY FUNCTION_INTERSECTS_WITH_ENTITY Properties: 
SEQUENCE_NUMBER 
CREATES 
READS 
UPDATES 
DELETES 
COMMENTS 
OBJECT_TEXT

FUNCTION FUNCTION_IS_CARRIED_OUT_AT_LOCATION FUNCTION_IS_CARRIED_OUT_AT_LOCATION Properties: 
SEQUENCE_NUMBER 
MAJOR_INV 
MINOR_INV 
COMMENTS 
OBJECT_TEXT

FUNCTION REFINES_INTO REFINES_INTO Properties: 
SEQUENCE_NUMBER 
OBJECT_TEXT

FUNCTION USES_LANGUAGE USES_LANGUAGE Properties: 
SEQUENCE_NUMBER 
VALUE_SHORT 
VALUE_LONG 
OBJECT_TEXT

GOAL GOAL_CONTAINS GOAL_CONTAINS Properties: 
SEQUENCE_NUMBER 
OBJECT_TEXT

GOAL GOAL_INVOLVES FUNCTION_INTERSECTS_WITH_ENTITY Properties: 
SEQUENCE_NUMBER 
CREATES 
READS 
UPDATES 
DELETES 
COMMENTS 
OBJECT_TEXT

GOAL GOAL_SUPPORTED_BY GOAL_SUPPORTED_BY Properties: 
SEQUENCE_NUMBER 
CREATES 
READS 
UPDATES 
DELETES 
COMMENTS 
OBJECT_TEXT

GOAL GOAL_SUPPORTED_BY GOAL_SUPPORTED_BY Properties: 
SEQUENCE_NUMBER 
CREATES 
READS 
UPDATES 
DELETES 
COMMENTS 
OBJECT_TEXT

GOAL GOAL_SUPPORTED_BY GOAL_SUPPORTED_BY Properties: 
SEQUENCE_NUMBER 
CREATES 
READS 
UPDATES 
DELETES 
COMMENTS 
OBJECT_TEXT

GOAL GOAL_SUPPORTED_BY GOAL_SUPPORTED_BY Properties: 
SEQUENCE_NUMBER 
CREATES 
READS 
UPDATES 
DELETES 
COMMENTS 
OBJECT_TEXT



GOAL GOAL_SUPPORTED_BY GOAL_SUPPORTED_BY Properties: 
SEQUENCE_NUMBER 
CREATES 
READS 
UPDATES 
DELETES 
COMMENTS 
OBJECT_TEXT

GOAL GOAL_SUPPORTED_BY GOAL_SUPPORTED_BY Properties: 
SEQUENCE_NUMBER 
CREATES 
READS 
UPDATES 
DELETES 
COMMENTS 
OBJECT_TEXT

HELP [none]  

HELP_TEXT [none]  

IDENTIFIER IMPLEMENTED_BY IMPLEMENTED_BY Properties: 
SEQUENCE NUMBER (1-999) 
OBJECT_TEXT

IDENTIFIER IMPLEMENTED_BY IMPLEMENTED_BY Properties: 
SEQUENCE NUMBER (1-999) 
OBJECT_TEXT

IDENTIFIER IMPLEMENTED_BY IMPLEMENTED_BY Properties: 
SEQUENCE NUMBER (1-999) 
OBJECT_TEXT

IDENTIFIER IMPLEMENTED_BY IMPLEMENTED_BY Properties: 
SEQUENCE NUMBER (1-999) 
OBJECT_TEXT

IDENTIFIER IMPLEMENTED_BY IMPLEMENTED_BY Properties: 
SEQUENCE NUMBER (1-999) 
OBJECT_TEXT

IDENTIFIER CONNECTS_TO CONNECTS_TO Properties: 
SEQUENCE NUMBER (1-999) 
OBJECT_TEXT

IDENTIFIER CONNECTS_TO CONNECTS_TO Properties: 
SEQUENCE NUMBER (1-999) 
OBJECT_TEXT

IDENTIFIER CONNECTS_TO CONNECTS_TO Properties: 
SEQUENCE NUMBER (1-999) 
OBJECT_TEXT

IDENTIFIER CONNECTS_TO CONNECTS_TO Properties: 
SEQUENCE NUMBER (1-999) 
OBJECT_TEXT

IDENTIFIER IDENTIFIER_IS_COMPOSED_OF IDENTIFIER_IS_COMPOSED_OF Properties: 
SEQUENCE_NUMBER 
OBJECT_TEXT

IDENTIFIER IDENTIFIER_IS_COMPOSED_OF IDENTIFIER_IS_COMPOSED_OF Properties: 
SEQUENCE_NUMBER 
OBJECT_TEXT

INFORMATION_NEED INFO_NEED_CONTAINS INFO_NEED_CONTAINS Properties: 
SEQUENCE_NUMBER 
OBJECT_TEXT



INFORMATION_NEED INFO_NEED_AFFECTS INFO_NEED_AFFECTS Properties: 
SEQUENCE_NUMBER 
RESPONSIBLE 
MAJOR_INV 
MINOR_INV 
COMMENTS 
OBJECT_TEXT

INFORMATION_NEED INFO_NEED_AFFECTS INFO_NEED_AFFECTS Properties: 
SEQUENCE_NUMBER 
RESPONSIBLE 
MAJOR_INV 
MINOR_INV 
COMMENTS 
OBJECT_TEXT

INFORMATION_NEED INFO_NEED_SUPPORTED_BY INFO_NEED_SUPPORTED_BY Properties: 
SEQUENCE_NUMBER 
RESPONSIBLE 
MAJOR_INV 
MINOR_INV 
COMMENTS 
OBJECT_TEXT

INFORMATION_NEED INFO_NEED_SUPPORTED_BY INFO_NEED_SUPPORTED_BY Properties: 
SEQUENCE_NUMBER 
RESPONSIBLE 
MAJOR_INV 
MINOR_INV 
COMMENTS 
OBJECT_TEXT

INFORMATION_NEED INFO_NEED_SUPPORTED_BY INFO_NEED_SUPPORTED_BY Properties: 
SEQUENCE_NUMBER 
RESPONSIBLE 
MAJOR_INV 
MINOR_INV 
COMMENTS 
OBJECT_TEXT

INFORMATION_NEED INFO_NEED_AFFECTED_BY INFO_NEED_AFFECTED_BY Properties: 
SEQUENCE_NUMBER 
RESPONSIBLE 
MAJOR_INV 
MINOR_INV 
COMMENTS 
OBJECT_TEXT

KEY KEY_HAS_COLUMN KEY_HAS_COLUMN Properties: 
SEQUENCE_NUMBER 
OBJECT_TEXT

LANGUAGE [none]  

LOCATION LOCATION_IS_SITE_OF LOCATION_IS_SITE_OF Properties: 
SEQUENCE_NUMBER 
OBJECT_TEXT

LOCATION LOCATION_IS_SITE_OF LOCATION_IS_SITE_OF Properties: 
SEQUENCE_NUMBER 
OBJECT_TEXT

LOCATION LOCATION_IS_SITE_OF LOCATION_IS_SITE_OF Properties: 
SEQUENCE_NUMBER 
OBJECT_TEXT

LOCATION LOCATION_USES LOCATION_USES Properties: 
SEQUENCE_NUMBER 
RESPONSIBLE 
MAJOR_INV 
MINOR_INV 
COMMENTS 
OBJECT_TEXT



LOCATION LOCATION_USES LOCATION_USES Properties: 
SEQUENCE_NUMBER 
RESPONSIBLE 
MAJOR_INV 
MINOR_INV 
COMMENTS 
OBJECT_TEXT

LOCATION LOCATION_USES LOCATION_USES Properties: 
SEQUENCE_NUMBER 
RESPONSIBLE 
MAJOR_INV 
MINOR_INV 
COMMENTS 
OBJECT_TEXT

LOCATION LOCATION_USES LOCATION_USES Properties: 
SEQUENCE_NUMBER 
RESPONSIBLE 
MAJOR_INV 
MINOR_INV 
COMMENTS 
OBJECT_TEXT

LOCATION LOCATION_CONTAINS LOCATION_CONTAINS Properties: 
SEQUENCE_NUMBER 
OBJECT_TEXT

LOGICAL_PROCESS DATA_CONTENT_DEFINED_BY DATA_CONTENT_DEFINED_BY Properties: 
SEQUENCE_NUMBR 
OBJECT_TEXT

LOGICAL_PROCESS INITIATES_EVENT INITIATES_EVENT Properties: 
SEQUENCE_NUMBER 
INITIATES_EVENT_DESCRIPTION 
OBJECT_TEXT

LOGICAL_PROCESS HAS_PDD_DRAWING HAS_PDD_DRAWING Properties: 
SEQUENCE_NUMBER 
OBJECT_TEXT

LOGICAL_PROCESS LOGICAL_PROCESS_AFFECTS LOGICAL_PROCESS_AFFECTS Properties: 
SEQUENCE_NUMBER 
CREATES 
READS 
UPDATES 
DELETES 
COMMENTS 
OBJECT_TEXT

LOGICAL_PROCESS DEPENDS_ON_LOGICAL_PROCESS DEPENDS_ON_LOGICAL_PROCESS Properties: 
SEQUENCE_NUMBER 
DEPENDS_ON_LOGICAL_PROCESS_DESCRIPTION 
OBJECT_TEXT

LOGICAL_PROCESS IS_COMPOSED_OF_LOGICAL_PROCESS IS_COMPOSED_OF_LOGICAL_PROCESS Properties: 
SEQUENCE_NUMBER 
OBJECT_TEXT

LOGICAL_PROCESS LOGICAL_PROCESS_IMPLEMENTED_BY LOGICAL_PROCESS_IMPLEMENTED_BY Properties: 
SEQUENCE_NUMBER 
OBJECT_TEXT

LOGICAL_PROCESS LOGICAL_PROCESS_CONTAINS LOGICAL_PROCESS_CONTAINS Properties: 
SEQUENCE_NUMBER 
OBJECT_TEXT

LOGICAL_PROCESS LOGICAL_PROCESS_CONTAINS LOGICAL_PROCESS_CONTAINS Properties: 
SEQUENCE_NUMBER 
OBJECT_TEXT

LOGICAL_PROCESS LOGICAL_PROCESS_CONTAINS LOGICAL_PROCESS_CONTAINS Properties: 
SEQUENCE_NUMBER 
OBJECT_TEXT



LOGICAL_PROCESS LOGICAL_PROCESS_SIGNATURED_BY LOGICAL_PROCESS_SIGNATURED_BY Properties: 
SEQUENCE_NUMBER 
SIGNATURE_TYPE 
OBJECT_TEXT

LOGICAL_PROCESS LOGICAL_PROCESS_SUPPORTS LOGICAL_PROCESS_SUPPORTS Properties: 
SEQUENCE_NUMBER 
RESPONSIBLE 
MAJOR_INV 
MINOR_INV 
COMMENTS 
OBJECT_TEXT

LOGICAL_PROCESS LOGICAL_PROCESS_SUPPORTS LOGICAL_PROCESS_SUPPORTS Properties: 
SEQUENCE_NUMBER 
RESPONSIBLE 
MAJOR_INV 
MINOR_INV 
COMMENTS 
OBJECT_TEXT

LOGICAL_PROCESS LOGICAL_PROCESS_SUPPORTED_BY LOGICAL_PROCESS_SUPPORTED_BY Properties: 
SEQUENCE_NUMBER 
RESPONSIBLE 
MAJOR_INV 
MINOR_INV 
COMMENTS 
OBJECT_TEXT

LOGICAL_PROCESS LOGICAL_PROCESS_SUPPORTED_BY LOGICAL_PROCESS_SUPPORTED_BY Properties: 
SEQUENCE_NUMBER 
RESPONSIBLE 
MAJOR_INV 
MINOR_INV 
COMMENTS 
OBJECT_TEXT

MACHINE MACHINE_CAN_ACCESS_MACHINE MACHINE_CAN_ACCESS_MACHINE Properties: 
SEQUENCE_NUMBER 
OBJECT_TEXT

MIGRATION MIGRATION_COMPRISED_OF MIGRATION_COMPRISED_OF Properties: 
SEQUENCE_NUMBER 
MIGRATION_COMPRISED_OF_DESCRIPTION 
SCOPE_TYPE 
SEED_STATUS

MIGRATION MIGRATION_COMPRISED_OF MIGRATION_COMPRISED_OF Properties: 
SEQUENCE_NUMBER 
MIGRATION_COMPRISED_OF_DESCRIPTION 
SCOPE_TYPE 
SEED_STATUS

MIGRATION MIGRATION_COMPRISED_OF MIGRATION_COMPRISED_OF Properties: 
SEQUENCE_NUMBER 
MIGRATION_COMPRISED_OF_DESCRIPTION 
SCOPE_TYPE 
SEED_STATUS

MIGRATION MIGRATION_COMPRISED_OF MIGRATION_COMPRISED_OF Properties: 
SEQUENCE_NUMBER 
MIGRATION_COMPRISED_OF_DESCRIPTION 
SCOPE_TYPE 
SEED_STATUS

MIGRATION MIGRATION_COMPRISED_OF MIGRATION_COMPRISED_OF Properties: 
SEQUENCE_NUMBER 
MIGRATION_COMPRISED_OF_DESCRIPTION 
SCOPE_TYPE 
SEED_STATUS



MIGRATION MIGRATION_COMPRISED_OF MIGRATION_COMPRISED_OF Properties: 
SEQUENCE_NUMBER 
MIGRATION_COMPRISED_OF_DESCRIPTION 
SCOPE_TYPE 
SEED_STATUS

MIGRATION MIGRATION_COMPRISED_OF MIGRATION_COMPRISED_OF Properties: 
SEQUENCE_NUMBER 
MIGRATION_COMPRISED_OF_DESCRIPTION 
SCOPE_TYPE 
SEED_STATUS

MIGRATION MIGRATION_COMPRISED_OF MIGRATION_COMPRISED_OF Properties: 
SEQUENCE_NUMBER 
MIGRATION_COMPRISED_OF_DESCRIPTION 
SCOPE_TYPE 
SEED_STATUS

MIGRATION MIGRATION_COMPRISED_OF MIGRATION_COMPRISED_OF Properties: 
SEQUENCE_NUMBER 
MIGRATION_COMPRISED_OF_DESCRIPTION 
SCOPE_TYPE 
SEED_STATUS

MIGRATION MIGRATION_COMPRISED_OF MIGRATION_COMPRISED_OF Properties: 
SEQUENCE_NUMBER 
MIGRATION_COMPRISED_OF_DESCRIPTION 
SCOPE_TYPE 
SEED_STATUS

MIGRATION MIGRATION_COMPRISED_OF MIGRATION_COMPRISED_OF Properties: 
SEQUENCE_NUMBER 
MIGRATION_COMPRISED_OF_DESCRIPTION 
SCOPE_TYPE 
SEED_STATUS

MIGRATION MIGRATION_COMPRISED_OF MIGRATION_COMPRISED_OF Properties: 
SEQUENCE_NUMBER 
MIGRATION_COMPRISED_OF_DESCRIPTION 
SCOPE_TYPE 
SEED_STATUS

MIGRATION MIGRATION_COMPRISED_OF MIGRATION_COMPRISED_OF Properties: 
SEQUENCE_NUMBER 
MIGRATION_COMPRISED_OF_DESCRIPTION 
SCOPE_TYPE 
SEED_STATUS

MIGRATION MIGRATION_COMPRISED_OF MIGRATION_COMPRISED_OF Properties: 
SEQUENCE_NUMBER 
MIGRATION_COMPRISED_OF_DESCRIPTION 
SCOPE_TYPE 
SEED_STATUS

MIGRATION MIGRATION_COMPRISED_OF MIGRATION_COMPRISED_OF Properties: 
SEQUENCE_NUMBER 
MIGRATION_COMPRISED_OF_DESCRIPTION 
SCOPE_TYPE 
SEED_STATUS

MIGRATION MIGRATION_COMPRISED_OF MIGRATION_COMPRISED_OF Properties: 
SEQUENCE_NUMBER 
MIGRATION_COMPRISED_OF_DESCRIPTION 
SCOPE_TYPE 
SEED_STATUS

MIGRATION MIGRATION_COMPRISED_OF MIGRATION_COMPRISED_OF Properties: 
SEQUENCE_NUMBER 
MIGRATION_COMPRISED_OF_DESCRIPTION 
SCOPE_TYPE 
SEED_STATUS



MIGRATION MIGRATION_COMPRISED_OF MIGRATION_COMPRISED_OF Properties: 
SEQUENCE_NUMBER 
MIGRATION_COMPRISED_OF_DESCRIPTION 
SCOPE_TYPE 
SEED_STATUS

MIGRATION MIGRATION_COMPRISED_OF MIGRATION_COMPRISED_OF Properties: 
SEQUENCE_NUMBER 
MIGRATION_COMPRISED_OF_DESCRIPTION 
SCOPE_TYPE 
SEED_STATUS

MIGRATION MIGRATION_COMPRISED_OF MIGRATION_COMPRISED_OF Properties: 
SEQUENCE_NUMBER 
MIGRATION_COMPRISED_OF_DESCRIPTION 
SCOPE_TYPE 
SEED_STATUS

MIGRATION MIGRATION_COMPRISED_OF MIGRATION_COMPRISED_OF Properties: 
SEQUENCE_NUMBER 
MIGRATION_COMPRISED_OF_DESCRIPTION 
SCOPE_TYPE 
SEED_STATUS

MIGRATION MIGRATION_COMPRISED_OF MIGRATION_COMPRISED_OF Properties: 
SEQUENCE_NUMBER 
MIGRATION_COMPRISED_OF_DESCRIPTION 
SCOPE_TYPE 
SEED_STATUS

MIGRATION MIGRATION_COMPRISED_OF MIGRATION_COMPRISED_OF Properties: 
SEQUENCE_NUMBER 
MIGRATION_COMPRISED_OF_DESCRIPTION 
SCOPE_TYPE 
SEED_STATUS

MIGRATION MIGRATION_COMPRISED_OF MIGRATION_COMPRISED_OF Properties: 
SEQUENCE_NUMBER 
MIGRATION_COMPRISED_OF_DESCRIPTION 
SCOPE_TYPE 
SEED_STATUS

MIGRATION MIGRATION_COMPRISED_OF MIGRATION_COMPRISED_OF Properties: 
SEQUENCE_NUMBER 
MIGRATION_COMPRISED_OF_DESCRIPTION 
SCOPE_TYPE 
SEED_STATUS

MIGRATION MIGRATION_COMPRISED_OF MIGRATION_COMPRISED_OF Properties: 
SEQUENCE_NUMBER 
MIGRATION_COMPRISED_OF_DESCRIPTION 
SCOPE_TYPE 
SEED_STATUS

MIGRATION MIGRATION_COMPRISED_OF MIGRATION_COMPRISED_OF Properties: 
SEQUENCE_NUMBER 
MIGRATION_COMPRISED_OF_DESCRIPTION 
SCOPE_TYPE 
SEED_STATUS

MIGRATION MIGRATION_COMPRISED_OF MIGRATION_COMPRISED_OF Properties: 
SEQUENCE_NUMBER 
MIGRATION_COMPRISED_OF_DESCRIPTION 
SCOPE_TYPE 
SEED_STATUS

MIGRATION MIGRATION_COMPRISED_OF MIGRATION_COMPRISED_OF Properties: 
SEQUENCE_NUMBER 
MIGRATION_COMPRISED_OF_DESCRIPTION 
SCOPE_TYPE 
SEED_STATUS



MIGRATION MIGRATION_COMPRISED_OF MIGRATION_COMPRISED_OF Properties: 
SEQUENCE_NUMBER 
MIGRATION_COMPRISED_OF_DESCRIPTION 
SCOPE_TYPE 
SEED_STATUS

MIGRATION MIGRATION_COMPRISED_OF MIGRATION_COMPRISED_OF Properties: 
SEQUENCE_NUMBER 
MIGRATION_COMPRISED_OF_DESCRIPTION 
SCOPE_TYPE 
SEED_STATUS

MIGRATION MIGRATION_COMPRISED_OF MIGRATION_COMPRISED_OF Properties: 
SEQUENCE_NUMBER 
MIGRATION_COMPRISED_OF_DESCRIPTION 
SCOPE_TYPE 
SEED_STATUS

MIGRATION MIGRATION_COMPRISED_OF MIGRATION_COMPRISED_OF Properties: 
SEQUENCE_NUMBER 
MIGRATION_COMPRISED_OF_DESCRIPTION 
SCOPE_TYPE 
SEED_STATUS

MIGRATION MIGRATION_COMPRISED_OF MIGRATION_COMPRISED_OF Properties: 
SEQUENCE_NUMBER 
MIGRATION_COMPRISED_OF_DESCRIPTION 
SCOPE_TYPE 
SEED_STATUS

MIGRATION MIGRATION_COMPRISED_OF MIGRATION_COMPRISED_OF Properties: 
SEQUENCE_NUMBER 
MIGRATION_COMPRISED_OF_DESCRIPTION 
SCOPE_TYPE 
SEED_STATUS

MIGRATION MIGRATION_COMPRISED_OF MIGRATION_COMPRISED_OF Properties: 
SEQUENCE_NUMBER 
MIGRATION_COMPRISED_OF_DESCRIPTION 
SCOPE_TYPE 
SEED_STATUS

MIGRATION MIGRATION_COMPRISED_OF MIGRATION_COMPRISED_OF Properties: 
SEQUENCE_NUMBER 
MIGRATION_COMPRISED_OF_DESCRIPTION 
SCOPE_TYPE 
SEED_STATUS

MIGRATION MIGRATION_COMPRISED_OF MIGRATION_COMPRISED_OF Properties: 
SEQUENCE_NUMBER 
MIGRATION_COMPRISED_OF_DESCRIPTION 
SCOPE_TYPE 
SEED_STATUS

MIGRATION MIGRATION_COMPRISED_OF MIGRATION_COMPRISED_OF Properties: 
SEQUENCE_NUMBER 
MIGRATION_COMPRISED_OF_DESCRIPTION 
SCOPE_TYPE 
SEED_STATUS

MIGRATION MIGRATION_COMPRISED_OF MIGRATION_COMPRISED_OF Properties: 
SEQUENCE_NUMBER 
MIGRATION_COMPRISED_OF_DESCRIPTION 
SCOPE_TYPE 
SEED_STATUS

MIGRATION MIGRATION_COMPRISED_OF MIGRATION_COMPRISED_OF Properties: 
SEQUENCE_NUMBER 
MIGRATION_COMPRISED_OF_DESCRIPTION 
SCOPE_TYPE 
SEED_STATUS



MIGRATION MIGRATION_COMPRISED_OF MIGRATION_COMPRISED_OF Properties: 
SEQUENCE_NUMBER 
MIGRATION_COMPRISED_OF_DESCRIPTION 
SCOPE_TYPE 
SEED_STATUS

MIGRATION MIGRATION_COMPRISED_OF MIGRATION_COMPRISED_OF Properties: 
SEQUENCE_NUMBER 
MIGRATION_COMPRISED_OF_DESCRIPTION 
SCOPE_TYPE 
SEED_STATUS

MIGRATION MIGRATION_COMPRISED_OF MIGRATION_COMPRISED_OF Properties: 
SEQUENCE_NUMBER 
MIGRATION_COMPRISED_OF_DESCRIPTION 
SCOPE_TYPE 
SEED_STATUS

MIGRATION MIGRATION_COMPRISED_OF MIGRATION_COMPRISED_OF Properties: 
SEQUENCE_NUMBER 
MIGRATION_COMPRISED_OF_DESCRIPTION 
SCOPE_TYPE 
SEED_STATUS

MIGRATION MIGRATION_COMPRISED_OF MIGRATION_COMPRISED_OF Properties: 
SEQUENCE_NUMBER 
MIGRATION_COMPRISED_OF_DESCRIPTION 
SCOPE_TYPE 
SEED_STATUS

MIGRATION MIGRATION_COMPRISED_OF MIGRATION_COMPRISED_OF Properties: 
SEQUENCE_NUMBER 
MIGRATION_COMPRISED_OF_DESCRIPTION 
SCOPE_TYPE 
SEED_STATUS

MIGRATION MIGRATION_COMPRISED_OF MIGRATION_COMPRISED_OF Properties: 
SEQUENCE_NUMBER 
MIGRATION_COMPRISED_OF_DESCRIPTION 
SCOPE_TYPE 
SEED_STATUS

MIGRATION MIGRATION_COMPRISED_OF MIGRATION_COMPRISED_OF Properties: 
SEQUENCE_NUMBER 
MIGRATION_COMPRISED_OF_DESCRIPTION 
SCOPE_TYPE 
SEED_STATUS

MIGRATION MIGRATION_COMPRISED_OF MIGRATION_COMPRISED_OF Properties: 
SEQUENCE_NUMBER 
MIGRATION_COMPRISED_OF_DESCRIPTION 
SCOPE_TYPE 
SEED_STATUS

MIGRATION MIGRATION_COMPRISED_OF MIGRATION_COMPRISED_OF Properties: 
SEQUENCE_NUMBER 
MIGRATION_COMPRISED_OF_DESCRIPTION 
SCOPE_TYPE 
SEED_STATUS

MIGRATION MIGRATION_COMPRISED_OF MIGRATION_COMPRISED_OF Properties: 
SEQUENCE_NUMBER 
MIGRATION_COMPRISED_OF_DESCRIPTION 
SCOPE_TYPE 
SEED_STATUS

MIGRATION MIGRATION_COMPRISED_OF MIGRATION_COMPRISED_OF Properties: 
SEQUENCE_NUMBER 
MIGRATION_COMPRISED_OF_DESCRIPTION 
SCOPE_TYPE 
SEED_STATUS



MIGRATION MIGRATION_COMPRISED_OF MIGRATION_COMPRISED_OF Properties: 
SEQUENCE_NUMBER 
MIGRATION_COMPRISED_OF_DESCRIPTION 
SCOPE_TYPE 
SEED_STATUS

MIGRATION MIGRATION_COMPRISED_OF MIGRATION_COMPRISED_OF Properties: 
SEQUENCE_NUMBER 
MIGRATION_COMPRISED_OF_DESCRIPTION 
SCOPE_TYPE 
SEED_STATUS

MIGRATION MIGRATION_COMPRISED_OF MIGRATION_COMPRISED_OF Properties: 
SEQUENCE_NUMBER 
MIGRATION_COMPRISED_OF_DESCRIPTION 
SCOPE_TYPE 
SEED_STATUS

MIGRATION MIGRATION_COMPRISED_OF MIGRATION_COMPRISED_OF Properties: 
SEQUENCE_NUMBER 
MIGRATION_COMPRISED_OF_DESCRIPTION 
SCOPE_TYPE 
SEED_STATUS

MIGRATION MIGRATION_COMPRISED_OF MIGRATION_COMPRISED_OF Properties: 
SEQUENCE_NUMBER 
MIGRATION_COMPRISED_OF_DESCRIPTION 
SCOPE_TYPE 
SEED_STATUS

MIGRATION MIGRATION_COMPRISED_OF MIGRATION_COMPRISED_OF Properties: 
SEQUENCE_NUMBER 
MIGRATION_COMPRISED_OF_DESCRIPTION 
SCOPE_TYPE 
SEED_STATUS

MIGRATION MIGRATION_COMPRISED_OF MIGRATION_COMPRISED_OF Properties: 
SEQUENCE_NUMBER 
MIGRATION_COMPRISED_OF_DESCRIPTION 
SCOPE_TYPE 
SEED_STATUS

MIGRATION MIGRATION_COMPRISED_OF MIGRATION_COMPRISED_OF Properties: 
SEQUENCE_NUMBER 
MIGRATION_COMPRISED_OF_DESCRIPTION 
SCOPE_TYPE 
SEED_STATUS

MIGRATION MIGRATION_COMPRISED_OF MIGRATION_COMPRISED_OF Properties: 
SEQUENCE_NUMBER 
MIGRATION_COMPRISED_OF_DESCRIPTION 
SCOPE_TYPE 
SEED_STATUS

OPPORTUNITY OPPORTUNITY_CONTAINS OPPORTUNITY_CONTAINS Properties: 
SEQUENCE_NUMBER 
OBJECT_TEXT

ORGANIZATION ORGANIZATION_SUPPORTS_FUNCTION ORGANIZATION_SUPPORTS_FUNCTION Properties: 
SEQUENCE_NUMBER 
RESPONSIBLE 
MAJOR_INVOLVEMENT 
MINOR_INVOLVEMENT 
COMMENTS 
OBJECT_TEXT

ORGANIZATION ORGANIZATION_SUPPORTS_PROCESS ORGANIZATION_SUPPORTS_PROCESS Properties: 
SEQUENCE_NUMBER 
RESPONSIBLE 
MAJOR_INVOLVEMENT 
MINOR_INVOLVEMENT 
COMMENTS 
OBJECT_TEXT



ORGANIZATION ORGANIZATION_SUPPORTS_ENTITY ORGANIZATION_SUPPORTS_ENTITY Properties: 
SEQUENCE_NUMBER 
CREATES 
READS 
UPDATES 
DELETES 
COMMENTS 
OBJECT_TEXT

ORGANIZATION ORGANIZATION_CONTAINS ORGANIZATION_CONTAINS Properties: 
SEQUENCE_NUMBER 
OBJECT_TEXT

ORGANIZATION ORGANIZATION_INVOLVED_IN ORGANIZATION_INVOLVED_IN Properties: 
SEQUENCE_NUMBER 
RESPONSIBLE 
MAJOR_INV 
MINOR_INV 
COMMENTS 
OBJECT_TEXT

ORGANIZATION ORGANIZATION_INVOLVED_IN ORGANIZATION_INVOLVED_IN Properties: 
SEQUENCE_NUMBER 
RESPONSIBLE 
MAJOR_INV 
MINOR_INV 
COMMENTS 
OBJECT_TEXT

ORGANIZATION ORGANIZATION_GUIDED_BY ORGANIZATION_GUIDED_BY Properties: 
SEQUENCE_NUMBER 
OBJECT_TEXT

ORGANIZATION ORGANIZATION_CITES ORGANIZATION_CITES Properties: 
SEQUENCE_NUMBER 
OBJECT_TEXT

ORGANIZATION ORGANIZATION_CITES ORGANIZATION_CITES Properties: 
SEQUENCE_NUMBER 
OBJECT_TEXT

ORGANIZATION ORGANIZATION_CITES ORGANIZATION_CITES Properties: 
SEQUENCE_NUMBER 
OBJECT_TEXT

ORGANIZATION ORGANIZATION_CITES ORGANIZATION_CITES Properties: 
SEQUENCE_NUMBER 
OBJECT_TEXT

ORGANIZATION ORGANIZATION_CITES ORGANIZATION_CITES Properties: 
SEQUENCE_NUMBER 
OBJECT_TEXT

ORGANIZATION ORGANIZATION_CITES ORGANIZATION_CITES Properties: 
SEQUENCE_NUMBER 
OBJECT_TEXT

ORGANIZATION ORGANIZATION_CITES ORGANIZATION_CITES Properties: 
SEQUENCE_NUMBER 
OBJECT_TEXT

ORGANIZATION ORGANIZATION_CITES ORGANIZATION_CITES Properties: 
SEQUENCE_NUMBER 
OBJECT_TEXT

ORGANIZATION ORGANIZATION_CITES ORGANIZATION_CITES Properties: 
SEQUENCE_NUMBER 
OBJECT_TEXT

ORGANIZATION ORGANIZATION_CITES ORGANIZATION_CITES Properties: 
SEQUENCE_NUMBER 
OBJECT_TEXT

ORGANIZATION ORGANIZATION_CITES ORGANIZATION_CITES Properties: 
SEQUENCE_NUMBER 
OBJECT_TEXT



ORGANIZATION ORGANIZATION_CITES ORGANIZATION_CITES Properties: 
SEQUENCE_NUMBER 
OBJECT_TEXT

ORGANIZATION ORGANIZATION_CITES ORGANIZATION_CITES Properties: 
SEQUENCE_NUMBER 
OBJECT_TEXT

ORGANIZATION ORGANIZATION_CITES ORGANIZATION_CITES Properties: 
SEQUENCE_NUMBER 
OBJECT_TEXT

ORGANIZATION ORGANIZATION_RESPONSIBLE_FOR ORGANIZATION_RESPONSIBLE_FOR Properties: 
SEQUENCE_NUMBER 
OBJECT_TEXT

ORGANIZATION ORGANIZATION_RESPONSIBLE_FOR ORGANIZATION_RESPONSIBLE_FOR Properties: 
SEQUENCE_NUMBER 
OBJECT_TEXT

ORGANIZATION ORGANIZATION_RESPONSIBLE_FOR ORGANIZATION_RESPONSIBLE_FOR Properties: 
SEQUENCE_NUMBER 
OBJECT_TEXT

ORGANIZATION ORGANIZATION_RESPONSIBLE_FOR ORGANIZATION_RESPONSIBLE_FOR Properties: 
SEQUENCE_NUMBER 
OBJECT_TEXT

ORGANIZATION ORGANIZATION_RESPONSIBLE_FOR ORGANIZATION_RESPONSIBLE_FOR Properties: 
SEQUENCE_NUMBER 
OBJECT_TEXT

PANEL [none]  

PARTITION CONFIGURATION_UNIT_ENCAPSULATES CONFIGURATION_UNIT_ENCAPSULATES Properties: 
SEQUENCE_NUMBER 
PREPARE_TIME 
IMPLEMENTATION_NAME 
SERVICE_NAME 
SIGNIFICANT_TIME 
LINK_TYPE 
SERVER_OWNER 
QUALIFIER 
PLAN_NAME 
COLLECTION_ID 
VERSION_ID 
ISOLATION_MODE 
OBJECT_TEXT

PARTITION CONFIGURATION_UNIT_ENCAPSULATES CONFIGURATION_UNIT_ENCAPSULATES Properties: 
SEQUENCE_NUMBER 
PREPARE_TIME 
IMPLEMENTATION_NAME 
SERVICE_NAME 
SIGNIFICANT_TIME 
LINK_TYPE 
SERVER_OWNER 
QUALIFIER 
PLAN_NAME 
COLLECTION_ID 
VERSION_ID 
ISOLATION_MODE 
OBJECT_TEXT



PARTITION CONFIGURATION_UNIT_ENCAPSULATES CONFIGURATION_UNIT_ENCAPSULATES Properties: 
SEQUENCE_NUMBER 
PREPARE_TIME 
IMPLEMENTATION_NAME 
SERVICE_NAME 
SIGNIFICANT_TIME 
LINK_TYPE 
SERVER_OWNER 
QUALIFIER 
PLAN_NAME 
COLLECTION_ID 
VERSION_ID 
ISOLATION_MODE 
OBJECT_TEXT

PARTITION CONFIGURATION_UNIT_ENCAPSULATES CONFIGURATION_UNIT_ENCAPSULATES Properties: 
SEQUENCE_NUMBER 
PREPARE_TIME 
IMPLEMENTATION_NAME 
SERVICE_NAME 
SIGNIFICANT_TIME 
LINK_TYPE 
SERVER_OWNER 
QUALIFIER 
PLAN_NAME 
COLLECTION_ID 
VERSION_ID 
ISOLATION_MODE 
OBJECT_TEXT

PARTITION CONFIGURATION_UNIT_ENCAPSULATES CONFIGURATION_UNIT_ENCAPSULATES Properties: 
SEQUENCE_NUMBER 
PREPARE_TIME 
IMPLEMENTATION_NAME 
SERVICE_NAME 
SIGNIFICANT_TIME 
LINK_TYPE 
SERVER_OWNER 
QUALIFIER 
PLAN_NAME 
COLLECTION_ID 
VERSION_ID 
ISOLATION_MODE 
OBJECT_TEXT

PARTITION CONFIGURATION_UNIT_ENCAPSULATES CONFIGURATION_UNIT_ENCAPSULATES Properties: 
SEQUENCE_NUMBER 
PREPARE_TIME 
IMPLEMENTATION_NAME 
SERVICE_NAME 
SIGNIFICANT_TIME 
LINK_TYPE 
SERVER_OWNER 
QUALIFIER 
PLAN_NAME 
COLLECTION_ID 
VERSION_ID 
ISOLATION_MODE 
OBJECT_TEXT

PARTITION CONFIGURATION_UNIT_ENCAPSULATES CONFIGURATION_UNIT_ENCAPSULATES Properties: 
SEQUENCE_NUMBER 
PREPARE_TIME 
IMPLEMENTATION_NAME 
SERVICE_NAME 
SIGNIFICANT_TIME 
LINK_TYPE 
SERVER_OWNER 
QUALIFIER 
PLAN_NAME 
COLLECTION_ID 
VERSION_ID 
ISOLATION_MODE 
OBJECT_TEXT



PARTITION CONFIGURATION_UNIT_ENCAPSULATES CONFIGURATION_UNIT_ENCAPSULATES Properties: 
SEQUENCE_NUMBER 
PREPARE_TIME 
IMPLEMENTATION_NAME 
SERVICE_NAME 
SIGNIFICANT_TIME 
LINK_TYPE 
SERVER_OWNER 
QUALIFIER 
PLAN_NAME 
COLLECTION_ID 
VERSION_ID 
ISOLATION_MODE 
OBJECT_TEXT

PARTITION CONFIGURATION_UNIT_ENCAPSULATES CONFIGURATION_UNIT_ENCAPSULATES Properties: 
SEQUENCE_NUMBER 
PREPARE_TIME 
IMPLEMENTATION_NAME 
SERVICE_NAME 
SIGNIFICANT_TIME 
LINK_TYPE 
SERVER_OWNER 
QUALIFIER 
PLAN_NAME 
COLLECTION_ID 
VERSION_ID 
ISOLATION_MODE 
OBJECT_TEXT

PARTITION CONFIGURATION_UNIT_ENCAPSULATES CONFIGURATION_UNIT_ENCAPSULATES Properties: 
SEQUENCE_NUMBER 
PREPARE_TIME 
IMPLEMENTATION_NAME 
SERVICE_NAME 
SIGNIFICANT_TIME 
LINK_TYPE 
SERVER_OWNER 
QUALIFIER 
PLAN_NAME 
COLLECTION_ID 
VERSION_ID 
ISOLATION_MODE 
OBJECT_TEXT

PARTITION CONFIGURATION_UNIT_ENCAPSULATES CONFIGURATION_UNIT_ENCAPSULATES Properties: 
SEQUENCE_NUMBER 
PREPARE_TIME 
IMPLEMENTATION_NAME 
SERVICE_NAME 
SIGNIFICANT_TIME 
LINK_TYPE 
SERVER_OWNER 
QUALIFIER 
PLAN_NAME 
COLLECTION_ID 
VERSION_ID 
ISOLATION_MODE 
OBJECT_TEXT

PARTITION CONFIGURATION_UNIT_ENCAPSULATES CONFIGURATION_UNIT_ENCAPSULATES Properties: 
SEQUENCE_NUMBER 
PREPARE_TIME 
IMPLEMENTATION_NAME 
SERVICE_NAME 
SIGNIFICANT_TIME 
LINK_TYPE 
SERVER_OWNER 
QUALIFIER 
PLAN_NAME 
COLLECTION_ID 
VERSION_ID 
ISOLATION_MODE 
OBJECT_TEXT



PARTITION USES_LANGUAGE USES_LANGUAGE Properties: 
SEQUENCE_NUMBER 
VALUE_SHORT 
VALUE_LONG 
OBJECT_TEXT

PROCESS PROCESS_DEPENDS_ON_PROCESS PROCESS_DEPENDS_ON_PROCESS Properties: 
SEQUENCE NUMBER (1-999) 
PROCESS_DEPENDS_ON_PROCESS_DESCRIPTION 
INCLUSIVE_FLAG 
EXOR_SEQUENCE_NUMBER 
OBJECT_TEXT

PROCESS HAS_BITMAP HAS_BITMAP Properties: 
SEQUENCE_NUMBER 
OBJECT_TEXT

PROCESS IS_DEFINED_BY IS_DEFINED_BY Properties: 
SEQUENCE NUMBER (1-999) 
OBJECT_TEXT

PROCESS PROCESS_IS_CARRIED_OUT_AT_LOCATION PROCESS_IS_CARRIED_OUT_AT_LOCATION Properties: 
SEQUENCE NUMBER (1-999) 
OBJECT_TEXT

PROCESS PROCESS_REFINES_INTO_PROCESS PROCESS_REFINES_INTO_PROCESS Properties: 
SEQUENCE NUMBER (1-999) 
CONDITIONAL_FLAG 
OBJECT_TEXT

PROCESS USES_LANGUAGE USES_LANGUAGE Properties: 
SEQUENCE_NUMBER 
VALUE_SHORT 
VALUE_LONG 
OBJECT_TEXT

PROCESS PROCESS_REPLACES_SYSTEM PROCESS_REPLACES_SYSTEM Properties: 
SEQUENCE NUMBER (1-999) 
CONDITIONAL_FLAG 
OBJECT_TEXT

PROCESS PROCESS_IMPACTS_ENTITY PROCESS_IMPACTS_ENTITY Properties: 
SEQUENCE NUMBER (1-999) 
CREATES 
READS 
UPDATES 
DELETES 
COMMENTS 
OBJECT_TEXT

RELATIONSHIP IMPLEMENTED_BY IMPLEMENTED_BY Properties: 
SEQUENCE NUMBER (1-999) 
OBJECT_TEXT

RELATIONSHIP IMPLEMENTED_BY IMPLEMENTED_BY Properties: 
SEQUENCE NUMBER (1-999) 
OBJECT_TEXT

RELATIONSHIP IMPLEMENTED_BY IMPLEMENTED_BY Properties: 
SEQUENCE NUMBER (1-999) 
OBJECT_TEXT

RELATIONSHIP IMPLEMENTED_BY IMPLEMENTED_BY Properties: 
SEQUENCE NUMBER (1-999) 
OBJECT_TEXT

RELATIONSHIP IMPLEMENTED_BY IMPLEMENTED_BY Properties: 
SEQUENCE NUMBER (1-999) 
OBJECT_TEXT

RELATIONSHIP CONNECTS_TO CONNECTS_TO Properties: 
SEQUENCE NUMBER (1-999) 
OBJECT_TEXT



RELATIONSHIP CONNECTS_TO CONNECTS_TO Properties: 
SEQUENCE NUMBER (1-999) 
OBJECT_TEXT

RELATIONSHIP CONNECTS_TO CONNECTS_TO Properties: 
SEQUENCE NUMBER (1-999) 
OBJECT_TEXT

RELATIONSHIP CONNECTS_TO CONNECTS_TO Properties: 
SEQUENCE NUMBER (1-999) 
OBJECT_TEXT

RELATIONSHIP IS_DESCRIBED_BY IS_DESCRIBED_BY Properties: 
SEQUENCE_NUMBER 
OPTIONALITY 
MINIMUM_PER_SUBJECT 
MAXIMUM_PER_SUBJECT 
OBJECT_TEXT

RELATIONSHIP RELATION_IS_RELATED_VIA_RELATION RELATION_IS_RELATED_VIA_RELATION Properties: 
SEQUENCE NUMBER (1-999) 
BIG 
CARDINAL 
OPTION 
DEPENDENT 
ABSTRACT 
ROLE 
OBJECT_TEXT

REPORT OWNS_VIEW OWNS_VIEW Properties: 
SEQUENCE_NUMBER 
VIEW_USAGE 
OBJECT_TEXT

REPORT HAS_BITMAP HAS_BITMAP Properties: 
SEQUENCE_NUMBER 
OBJECT_TEXT

REPORT REFERS_TO REFERS_TO Properties: 
SEQUENCE_NUMBER 
OBJECT_TEXT

REPORT REPORT_CONTAINS_SECTION REPORT_CONTAINS_SECTION Properties: 
SEQUENCE_NUMBER 
SECTION_TYPE 
SEQUENCE_NUMBER_BREAK 
PAGE_PLACEMENT 
BREAK_FIELD 
BREAK_QUALIFIER 
LEFT_MARGIN 
PRINT_OPTIONS 
OBJECT_TEXT

REPORT REPORT_HAS_FORM REPORT_HAS_FORM Properties: 
SEQUENCE_NUMBER 
OBJECT_TEXT

REQUIREMENT [none]  

RULE OWNS_VIEW OWNS_VIEW Properties: 
SEQUENCE_NUMBER 
VIEW_USAGE 
OBJECT_TEXT

RULE HAS_BITMAP HAS_BITMAP Properties: 
SEQUENCE_NUMBER 
OBJECT_TEXT

RULE REFERS_TO REFERS_TO Properties: 
SEQUENCE_NUMBER 
OBJECT_TEXT

RULE ACCESSES ACCESSES Properties: 
SEQUENCE_NUMBER 
COMP_USAGE 
OBJECT_TEXT



RULE RULE_DEPENDS_ON_RULE RULE_DEPENDS_ON_RULE Properties: 
SEQUENCE NUMBER (1-999) 
RULE_DEPENDS_ON_RULE_DESCRIPTION 
INCLUSIVE_FLAG 
EXOR_SEQUENCE_NUMBER

RULE RULE_CONVERSES_REPORT RULE_CONVERSES_REPORT Properties: 
SEQUENCE_NUMBER 
OBJECT_TEXT

RULE USES_COMPONENT USES_COMPONENT Properties: 
SEQUENCE_NUMBER 
OBJECT_TEXT

RULE CONVERSES_WINDOW CONVERSES_WINDOW Properties: 
SEQUENCE_NUMBER 
OBJECT_TEXT

RULE USES_RULE USES_RULE Properties: 
SEQUENCE_NUMBER 
OBJECT_TEXT

RULE RULE_TRIGGERS_EVENT RULE_TRIGGERS_EVENT Properties: 
SEQUENCE_NUMBER 
TYPE 
CONDITION 
VIEW_MAPPING 
OBJECT_TEXT

SECTION OWNS_VIEW OWNS_VIEW Properties: 
SEQUENCE_NUMBER 
VIEW_USAGE 
OBJECT_TEXT

SECTION USES_LANGUAGE USES_LANGUAGE Properties: 
SEQUENCE_NUMBER 
VALUE_SHORT 
VALUE_LONG 
OBJECT_TEXT

SERVER SERVER_CONTAINS_RULE SERVER_CONTAINS_RULE Properties: 
SEQUENCE_NUMBER 
ENTRY_TYPE 
RULE_OBJ_NAME 
SERVICE_NAME 
OBJECT_TEXT

SET CONTAINS_VALUE CONTAINS_VALUE Properties: 
SEQUENCE_NUMBER 
SYMBOL 
OBJECT_TEXT

SET CONTAINS_SYMBOL CONTAINS_SYMBOL Properties: 
SEQUENCE_NUMBER 
OBJECT_TEXT

SOFTWARE_PACKAGE REBUILD_PACKAGE_CONTAINS REBULD_PACKAGE_CONTAINS Properties: 
SEQUENCE_NUMBER 
SCOPE_TYPE 
SEED_STATUS 
HAS_REUSE 
IS_A_ROOT 
IS_A_LEAF_PROCESS 
HAS_CHANGED 
EXCP_PROC 
APPLICATION_CONFIG 
OBJECT_TEXT



SOFTWARE_PACKAGE REBUILD_PACKAGE_CONTAINS EBULD_PACKAGE_CONTAINS Properties: 
SEQUENCE_NUMBER 
SCOPE_TYPE 
SEED_STATUS 
HAS_REUSE 
IS_A_ROOT 
IS_A_LEAF_PROCESS 
HAS_CHANGED 
EXCP_PROC 
APPLICATION_CONFIG 
OBJECT_TEXT

SOFTWARE_PACKAGE REBUILD_PACKAGE_CONTAINS EBULD_PACKAGE_CONTAINS Properties: 
SEQUENCE_NUMBER 
SCOPE_TYPE 
SEED_STATUS 
HAS_REUSE 
IS_A_ROOT 
IS_A_LEAF_PROCESS 
HAS_CHANGED 
EXCP_PROC 
APPLICATION_CONFIG 
OBJECT_TEXT

SOFTWARE_PACKAGE REBUILD_PACKAGE_PREPARED_BY REBUILD_PACKAGE_PREPARED_BY Properties: 
SEQUENCE_NUMBER 
SCOPE_TYPE 
SEED_STATUS 
HAS_REUSE 
PREPARE_PLATFORM 
OS_TYPE 
DBMS_TYPE 
CONFIG_UNIT 
ROWSELECTED 
START_TIME_STAMP 
STOP_TIME_STAMP 
RETURN_CODE 
OBJECT_TEXT

SOFTWARE_PACKAGE REBUILD_PACKAGE_PREPARED_BY REBUILD_PACKAGE_PREPARED_BY Properties: 
SEQUENCE_NUMBER 
SCOPE_TYPE 
SEED_STATUS 
HAS_REUSE 
PREPARE_PLATFORM 
OS_TYPE 
DBMS_TYPE 
CONFIG_UNIT 
ROWSELECTED 
START_TIME_STAMP 
STOP_TIME_STAMP 
RETURN_CODE 
OBJECT_TEXT

SOFTWARE_PACKAGE REBUILD_PACKAGE_PREPARED_BY REBUILD_PACKAGE_PREPARED_BY Properties: 
SEQUENCE_NUMBER 
SCOPE_TYPE 
SEED_STATUS 
HAS_REUSE 
PREPARE_PLATFORM 
OS_TYPE 
DBMS_TYPE 
CONFIG_UNIT 
ROWSELECTED 
START_TIME_STAMP 
STOP_TIME_STAMP 
RETURN_CODE 
OBJECT_TEXT



SOFTWARE_PACKAGE REBUILD_PACKAGE_PREPARED_BY REBUILD_PACKAGE_PREPARED_BY Properties: 
SEQUENCE_NUMBER 
SCOPE_TYPE 
SEED_STATUS 
HAS_REUSE 
PREPARE_PLATFORM 
OS_TYPE 
DBMS_TYPE 
CONFIG_UNIT 
ROWSELECTED 
START_TIME_STAMP 
STOP_TIME_STAMP 
RETURN_CODE 
OBJECT_TEXT

SOFTWARE_PACKAGE REBUILD_PACKAGE_PREPARED_BY REBUILD_PACKAGE_PREPARED_BY Properties: 
SEQUENCE_NUMBER 
SCOPE_TYPE 
SEED_STATUS 
HAS_REUSE 
PREPARE_PLATFORM 
OS_TYPE 
DBMS_TYPE 
CONFIG_UNIT 
ROWSELECTED 
START_TIME_STAMP 
STOP_TIME_STAMP 
RETURN_CODE 
OBJECT_TEXT

SOFTWARE_PACKAGE REBUILD_PACKAGE_PREPARED_BY REBUILD_PACKAGE_PREPARED_BY Properties: 
SEQUENCE_NUMBER 
SCOPE_TYPE 
SEED_STATUS 
HAS_REUSE 
PREPARE_PLATFORM 
OS_TYPE 
DBMS_TYPE 
CONFIG_UNIT 
ROWSELECTED 
START_TIME_STAMP 
STOP_TIME_STAMP 
RETURN_CODE 
OBJECT_TEXT

SOFTWARE_PACKAGE REBUILD_PACKAGE_PREPARED_BY REBUILD_PACKAGE_PREPARED_BY Properties: 
SEQUENCE_NUMBER 
SCOPE_TYPE 
SEED_STATUS 
HAS_REUSE 
PREPARE_PLATFORM 
OS_TYPE 
DBMS_TYPE 
CONFIG_UNIT 
ROWSELECTED 
START_TIME_STAMP 
STOP_TIME_STAMP 
RETURN_CODE 
OBJECT_TEXT

SOFTWARE_PACKAGE REBUILD_PACKAGE_PREPARED_BY REBUILD_PACKAGE_PREPARED_BY Properties: 
SEQUENCE_NUMBER 
SCOPE_TYPE 
SEED_STATUS 
HAS_REUSE 
PREPARE_PLATFORM 
OS_TYPE 
DBMS_TYPE 
CONFIG_UNIT 
ROWSELECTED 
START_TIME_STAMP 
STOP_TIME_STAMP 
RETURN_CODE 
OBJECT_TEXT



SOFTWARE_PACKAGE REBUILD_PACKAGE_PREPARED_BY REBUILD_PACKAGE_PREPARED_BY Properties: 
SEQUENCE_NUMBER 
SCOPE_TYPE 
SEED_STATUS 
HAS_REUSE 
PREPARE_PLATFORM 
OS_TYPE 
DBMS_TYPE 
CONFIG_UNIT 
ROWSELECTED 
START_TIME_STAMP 
STOP_TIME_STAMP 
RETURN_CODE 
OBJECT_TEXT

STATE HAS_STD_DRAWING HAS_STD_DRAWING Properties: 
SEQUENCE NUMBER (1-999) 
OBJECT_TEXT

SUCCESS_FACTOR SUCCESS_FACTOR_SUPPORTED_BY SUCCESS_FACTOR_SUPPORTED_BY Properties: 
SEQUENCE_NUMBER 
RESPONSIBLE 
MAJOR_INV 
MINOR_INV 
COMMENTS 
OBJECT_TEXT

SUCCESS_FACTOR SUCCESS_FACTOR_SUPPORTED_BY SUCCESS_FACTOR_SUPPORTED_BY Properties: 
SEQUENCE_NUMBER 
RESPONSIBLE 
MAJOR_INV 
MINOR_INV 
COMMENTS 
OBJECT_TEXT

SUCCESS_FACTOR SUCCESS_FACTOR_AFFECTS SUCCESS_FACTOR_AFFECTS Properties: 
SEQUENCE_NUMBER 
RESPONSIBLE 
MAJOR_INV 
MINOR_INV 
COMMENTS 
OBJECT_TEXT

SYMBOL USES_LANGUAGE USES_LANGUAGE Properties; 
SEQUENCE_NUMBER 
VALUE_SHORT 
VALUE_LONG 
OBJECT_TEXT

SYSTEM DATA_CONTENT_DEFINED_BY DATA_CONTENT_DEFINED_BY Properties: 
SEQUENCE_NUMBER 
OBJECT_TEXT

SYSTEM SYSTEM_AFFECTS_DATA_STORE SYSTEM_AFFECTS_DATA_STORE Properties: 
SEQUENCE_NUMBER 
CREATES 
READS 
UPDATES 
DELETES 
COMMENTS 
OBJECT_TEXT

SYSTEM IS_REPLACED_BY IS_REPLACED_BY Properties: 
SEQUENCE_NUMBER 
CURRENT 
PLANNED 
COMMENTS 
OBJECT_TEXT



SYSTEM SYSTEM_SUPPORTS SYSTEM_SUPPORTS Properties: 
SEQUENCE_NUMBER 
RESPONSIBLE 
MAJOR_INV 
MINOR_INV 
COMMENTS 
OBJECT_TEXT

SYSTEM SYSTEM_SUPPORTS SYSTEM_SUPPORTS Properties: 
SEQUENCE_NUMBER 
RESPONSIBLE 
MAJOR_INV 
MINOR_INV 
COMMENTS 
OBJECT_TEXT

SYSTEM SYSTEM_SUPPORTS SYSTEM_SUPPORTS Properties: 
SEQUENCE_NUMBER 
RESPONSIBLE 
MAJOR_INV 
MINOR_INV 
COMMENTS 
OBJECT_TEXT

SYSTEM SYSTEM_SUPPORTS SYSTEM_SUPPORTS Properties: 
SEQUENCE_NUMBER 
RESPONSIBLE 
MAJOR_INV 
MINOR_INV 
COMMENTS 
OBJECT_TEXT

SYSTEM SYSTEM_SUPPORTS SYSTEM_SUPPORTS Properties: 
SEQUENCE_NUMBER 
RESPONSIBLE 
MAJOR_INV 
MINOR_INV 
COMMENTS 
OBJECT_TEXT

SYSTEM SYSTEM_SUPPORTS SYSTEM_SUPPORTS Properties: 
SEQUENCE_NUMBER 
RESPONSIBLE 
MAJOR_INV 
MINOR_INV 
COMMENTS 
OBJECT_TEXT

SYSTEM SYSTEM_SUPPORTS SYSTEM_SUPPORTS Properties: 
SEQUENCE_NUMBER 
RESPONSIBLE 
MAJOR_INV 
MINOR_INV 
COMMENTS 
OBJECT_TEXT

SYSTEM SYSTEM_REPLACES SYSTEM_REPLACES Properties: 
SEQUENCE_NUMBER 
OBJECT_TEXT

SYSTEM SYSTEM_CONTAINS SYSTEM_CONTAINS Properties: 
SEQUENCE_NUMBER 
OBJECT_TEXT

TABLE IMPLEMENTED_BY IMPLEMENTED_BY Properties: 
SEQUENCE NUMBER (1-999) 
OBJECT_TEXT

TABLE IMPLEMENTED_BY IMPLEMENTED_BY Properties: 
SEQUENCE NUMBER (1-999) 
OBJECT_TEXT

TABLE IMPLEMENTED_BY IMPLEMENTED_BY Properties: 
SEQUENCE NUMBER (1-999) 
OBJECT_TEXT



TABLE IMPLEMENTED_BY IMPLEMENTED_BY Properties: 
SEQUENCE NUMBER (1-999) 
OBJECT_TEXT

TABLE IMPLEMENTED_BY IMPLEMENTED_BY Properties: 
SEQUENCE NUMBER (1-999) 
OBJECT_TEXT

TABLE TABLE_IS_BASED_ON_TABLE TABLE_IS_BASED_ON_TABLE Properties: 
SEQUENCE_NUMBER 
OBJECT_TEXT

TABLE TABLE_HAS_COLUMN TABLE_HAS_COLUMN Properties: 
SEQUENCE_NUMBER 
NULL_INDICATOR 
DISTINCT 
DISTINCT_TYPE 
UPDATE_PCT 
OBJECT_TEXT

TABLE TABLE_HAS_KEY TABLE_HAS_KEY Properties: 
SEQUENCE_NUMBER 
OBJECT_TEXT

TABLE TABLE_REFERRED_BY_KEY TABLE_REFERRED_BY_KEY Properties: 
SEQUENCE_NUMBER 
REFERENTIAL_INTEGRITY 
OBJECT_TEXT

TRANSITION TRIGGERS_LOGICAL_PROCESS TRIGGERS_LOGICAL_PROCESS Properties: 
SEQUENCE_NUMBER 
TRIGGERS_LOGICAL_PROCESS_DESCRIPTION 
OBJECT_TEXT

TRANSITION RESULTS_IN_STATE RESULTS_IN_STATE Properties: 
SEQUENCE_NUMBER 
RESULTS_IN_STATE_DESCRIPTION 
OBJECT_TEXT

TRANSITION IS_PRECONDITIONED_BY_STATE IS_PRECONDITIONED_BY_STATE Properties: 
SEQUENCE_NUMBER 
IS_PRECONDITIONED_BY_STATE_DESCRIPTION 
OBJECT_TEXT

VALUE [none]  

VERSION [none]  

VIEW VIEW_INCLUDES VIEW_INCLUDES Properties: 
SEQUENCE_NUMBER 
OCCURS 
NULL_INDICATOR 
OBJECT_TEXT

VIEW VIEW_INCLUDES VIEW_INCLUDES Properties: 
SEQUENCE_NUMBER 
OCCURS 
NULL_INDICATOR 
OBJECT_TEXT

WINDOW OWNS_VIEW OWNS_VIEW Properties: 
SEQUENCE_NUMBER 
VIEW_USAGE 
OBJECT_TEXT

WINDOW HAS_BITMAP HAS_BITMAP Properties: 
SEQUENCE_NUMBER 
OBJECT_TEXT

WINDOW REFERS_TO REFERS_TO Properties: 
SEQUENCE_NUMBER 
OBJECT_TEXT

WINDOW WINDOW_HAS_WINDOW_CONTENT WINDOW_HAS_WINDOW_CONTENT Properties: 
SEQUENCE_NUMBER 
OBJECT_TEXT



WINDOW HAS_HELP_TEXT HAS_HELP_TEXT Properties: 
SEQUENCE_NUMBER 
OBJECT_TEXT

WINDOW WINDOW_CONTENT_HAS_HELP WINDOW_CONTENT_HAS_HELP Properties: 
SEQUENCE_NUMBER 
OBJECT_TEXT

WINDOW WINDOW_CONTENT_HAS_PANEL WINDOW_CONTENT_HAS_PANEL Properties: 
SEQUENCE_NUMBER 
OBJECT_TEXT

WINDOW_CONTENT WINDOW_CONTENT_HAS_HELP WINDOW_CONTENT_HAS_HELP Properties: 
SEQUENCE_NUMBER 
OBJECT_TEXT

WINDOW_CONTENT WINDOW_PANEL_HAS_HELP WINDOW_PANEL_HAS_HELP Properties: 
SEQUENCE_NUMBER 
OBJECT_TEXT

Relationship Types and Properties

Relationship types have properties that you can set or query. In , the properties of the relationship type areRelationship Types and Properties
described after the relationship. If a property has a domain of values, it follows the property description.

Relationship Types and Properties

ACCESSES IS_RELATED_VIA

APPLICATION_CONFIGURATION_HAS_CONFIGURATION_UNIT IS_REPLACED_BY

BITMAP_HAS_BITMAP_IMPLEMENTATION IS_TYPED_BY

BUSINESS_OBJECT_OWNS KEY_HAS_COLUMN

BUSINESS_OBJECT_REFINES_INTO_BUSINESS_OBJECT LOGICAL_PROCESS_AFFECTS

CELL_CONTAINS LOGICAL_PROCESS_IMPLEMENTED_BY

COMPONENT_USES_COMPONENT MACHINE_CAN_ACCESS_MACHINE

CONFIGURATION_UNIT_ENCAPSULATES ORGANIZATION_SUPPORTS_ENTITY

CONNECTS_TO ORGANIZATION_SUPPORTS_FUNCTION

CONTAINS_VALUE ORGANIZATION_SUPPORTS_PROCESS

CONVERSES_WINDOW OWNS_VIEW

DATABASE_HAS_TABLE PROCESS_DEPENDS_ON_PROCESS

DATATYPE_IS_COMPOSED_OF_DATATYPE PROCESS_IMPACTS_ENTITY

DATATYPE_IS_CONSTRAINED_BY_SET PROCESS_IS_CARRIED_OUT_AT_LOCATION

DATA_STORE_IS_REPLACED_BY_ENTITY PROCESS_REFINES_INTO_PROCESS

DEPENDS_ON_LOGICAL_PROCESS PROCESS_REPLACES_SYSTEM

ENTITY_IS_DISTRIBUTED_AT REFERS_TO

ENTITY_IS_MODIFIED_AT_LOCATION REFINES_INTO

EVENT_CAUSES RELATION_IS_RELATED_VIA_RELATION

EVENT_HAS_RULE REPORT_CONTAINS_SECTION

EVENT_INFLUENCES_BUSINESS_OBJECT RESULTS_IN_STATE

EVENT_TRIGGERS RULE_CONVERSES_REPORT

FILE_IS_FORWARDED_TO_FILE RULE_DEPENDS_ON_RULE



FSDM_SCHEMA_HAS_FSDM_VALUE RULE_TRIGGERS_EVENT

FSDM_VALUE_CLASSIFIES_FSDM_SCHEMA SERVER_CONTAINS_RULE

FUNCTION_INTERSECTS_WITH_ENTITY SERVER_DERIVES_SERVER

FUNCTION_IS_CARRIED_OUT_AT_LOCATION SYSTEM_AFFECTS_DATA_STORE

HAS_IDENTIFIER TABLE_HAS_COLUMN

HAS_STATE TABLE_HAS_KEY

IDENTIFIER_IS_COMPOSED_OF TABLE_IS_BASED_ON_TABLE

IMPLEMENTED_BY TABLE_REFERRED_BY_KEY

INITIATES_EVENT TRIGGERS_LOGICAL_PROCESS

IS_COMPOSED_OF_ATTRIBUTE USES_COMPONENT

IS_COMPOSED_OF_EVENT USES_RULE

IS_COMPOSED_OF_LOGICAL_PROCESS VIEW_INCLUDES

IS_DEFINED_BY WINDOW_CONTENT_HAS_HELP

IS_DESCRIBED_BY WINDOW_CONTENT_HAS_PANEL

IS_KEYED_BY WINDOW_HAS_BITMAP531

IS_PRECONDITIONED_BY_STATE WINDOW_HAS_WINDOW_CONTENT

ACCESSES

ACCESSES properties

SEQUENCE_NUMBER

APPLICATION_CONFIGURATION_HAS_CONFIGURATION_UNIT

APPLICATION_CONFIGURATION_HAS_CONFIGURATION_UNIT properties

SEQUENCE_NUMBER

BITMAP_HAS_BITMAP_IMPLEMENTATION

BITMAP_HAS_BITMAP_IMPLEMENTATION properties

SEQUENCE_NUMBER

BUSINESS_OBJECT_OWNS

BUSINESS_OBJECT_OWNS properties

SEQUENCE_NUMBER

BUSINESS_OBJECT_REFINES_INTO_BUSINESS_OBJECT

BUSINESS_OBJECT_REFINES_INTO_BUSINESS_OBJECT properties

SEQUENCE_NUMBER

CELL_CONTAINS

CELL_CONTAINS properties



APPLICATION_SERVER_FLAG COMMUNICATION_GATEWAY_FLAG

MACHINE_IMPLEMENTATION_NAME MANAGER_FLAG

NETWORK_ID SEQUENCE_NUMBER

COMPONENT_USES_COMPONENT

COMPONENT_USES_COMPONENT properties

SEQUENCE_NUMBER

CONFIGURATION_UNIT_ENCAPSULATES

CONFIGURATION_UNIT_ENCAPSULATES properties

SEQUENCE_NUMBER

CONNECTS_TO

CONNECTS_TO properties

SEQUENCE_NUMBER

CONTAINS_VALUE

CONTAINS_VALUE properties

SEQUENCE_NUMBER SYMBOL

CONVERSES_WINDOW

CONVERSES_WINDOW properties

SEQUENCE_NUMBER

DATABASE_HAS_TABLE

DATABASE_HAS_TABLE properties

ACTIVATION_PERIOD: Duration AVE_DELETES

AVE_INSERTS AVE_UPDATES

DONE_FLAG: Boolean DO_FLAG: Boolean

MAXIMUM_ROWS MINIMUM_ROWS

SEQUENCE_NUMBER  

DATATYPE_IS_COMPOSED_OF_DATATYPE

DATATYPE_IS_COMPOSED_OF_DATATYPE properties

OCCURS SEQUENCE_NUMBER

DATATYPE_IS_CONSTRAINED_BY_SET

DATATYPE_IS_CONSTRAINED_BY_SET properties

SEQUENCE_NUMBER



DATA_STORE_IS_REPLACED_BY_ENTITY

DATA_STORE_IS_REPLACED_BY_ENTITY properties

COMMENTS SEQUENCE_NUMBER

DEPENDS_ON_LOGICAL_PROCESS

DEPENDS_ON_LOGICAL_PROCESS properties

DEPENDS_ON_LOGICAL_PROCESS_DESCRIPTION SEQUENCE_NUMBER

ENTITY_IS_DISTRIBUTED_AT

ENTITY_IS_DISTRIBUTED_AT properties

COMMENTS MASTER: Boolean

PARTITIONED: Boolean REORGANIZED: Boolean

REPLICATED: Boolean SEQUENCE_NUMBER

SUBSET: Boolean TELEPROC: Boolean

VARIANT: Boolean  

ENTITY_IS_MODIFIED_AT_LOCATION

ENTITY_IS_MODIFIED_AT_LOCATION properties

COMMENTS CREATE: Boolean

DELETE: Boolean READ: Boolean

UPDATE: Boolean  

EVENT_CAUSES

EVENT_CAUSES properties

EVENT_CAUSES_DESCRIPTION SEQUENCE_NUMBER

EVENT_HAS_RULE

EVENT_HAS_RULE properties

ACTION_HOST ACTION_TYPE: ActionType

SEQUENCE_NUMBER VIEW_MAPPING

EVENT_INFLUENCES_BUSINESS_OBJECT

EVENT_INFLUENCES_BUSINESS_OBJECT properties

EVENT_INFLUENCES_BUSINESS_OBJECT_DESCRIPTION SEQUENCE_NUMBER

EVENT_TRIGGERS

EVENT_TRIGGERS properties

EVENT_TRIGGERS_DESCRIPTION EXOR_SEQUENCE_NUMBER

INCLUSIVE_FLAG: InclusiveFlag SEQUENCE_NUMBER



FILE_IS_FORWARDED_TO_FILE

FILE_IS_FORWARDED_TO_FILE properties

DELETE_RULE INSERT_RULE

SEQUENCE_NUMBER UPDATE_RULE

FSDM_SCHEMA_HAS_FSDM_VALUE

FSDM_SCHEMA_HAS_FSDM_VALUE properties

SEQUENCE_NUMBER

FSDM_VALUE_CLASSIFIES_FSDM_SCHEMA

FSDM_VALUE_CLASSIFIES_FSDM_SCHEMA properties

SEQUENCE_NUMBER

FUNCTION_INTERSECTS_WITH_ENTITY

FUNCTION_INTERSECTS_WITH_ENTITY properties

COMMENTS CREATE: Boolean

DELETE: Boolean READ: Boolean

SEQUENCE_NUMBER UPDATE: Boolean

FUNCTION_IS_CARRIED_OUT_AT_LOCATION

FUNCTION_IS_CARRIED_OUT_AT_LOCATION properties

COMMENTS MAJOR_INV: Boolean

MINOR_INV: Boolean SEQUENCE_NUMBER

HAS_IDENTIFIER

HAS_IDENTIFIER properties

SEQUENCE_NUMBER

HAS_STATE

HAS_STATE properties

SEQUENCE_NUMBER

IDENTIFIER_IS_COMPOSED_OF

IDENTIFIER_IS_COMPOSED_OF properties

SEQUENCE_NUMBER

IMPLEMENTED_BY

IMPLEMENTED_BY properties

SEQUENCE_NUMBER



INITIATES_EVENT

INITIATES_EVENT properties

INITIATES_EVENT_DESCRIPTION SEQUENCE_NUMBER

IS_COMPOSED_OF_ATTRIBUTE

IS_COMPOSED_OF_ATTRIBUTE properties

OCCURS SEQUENCE_NUMBER

IS_COMPOSED_OF_EVENT

IS_COMPOSED_OF_EVENT properties

SEQUENCE_NUMBER

IS_COMPOSED_OF_LOGICAL_PROCESS

IS_COMPOSED_OF_LOGICAL_PROCESS properties

SEQUENCE_NUMBER

IS_DEFINED_BY

IS_DEFINED_BY properties

SEQUENCE_NUMBER

IS_DESCRIBED_BY

IS_DESCRIBED_BY properties

SEQUENCE_NUMBER OPTIONALITY: Boolean

IS_KEYED_BY

IS_KEYED_BY properties

SEQUENCE_NUMBER TYPE: KeyType

IS_PRECONDITIONED_BY_STATE

IS_PRECONDITIONED_BY_STATE properties

IS_PRECONDITIONED_BY_STATE_DESCRIPTION SEQUENCE_NUMBER  

IS_RELATED_VIA

IS_RELATED_VIA properties

ABSTRACT: Boolean CARDINALITY: Cardinal

CONTROLLING: Boolean DEPENDENT: Boolean

MAXIMUM_CARDINALITY MINIMUM_CARDINALITY

OPTIONALITY: Boolean ROLE

SEQUENCE_NUMBER  



IS_REPLACED_BY

IS_REPLACED_BY properties

COMMENTS CURRENT: Boolean

PLANNED: Boolean SEQUENCE_NUMBER

IS_TYPED_BY

IS_TYPED_BY properties

SEQUENCE_NUMBER

KEY_HAS_COLUMN

KEY_HAS_COLUMN properties

SEQUENCE_NUMBER

LOGICAL_PROCESS_AFFECTS

LOGICAL_PROCESS_AFFECTS properties

COMMENTS CREATES: Boolean

DELETES: Boolean READS: Boolean

SEQUENCE_NUMBER UPDATES: Boolean

LOGICAL_PROCESS_IMPLEMENTED_BY

LOGICAL_PROCESS_IMPLEMENTED_BY properties

SEQUENCE_NUMBER

MACHINE_CAN_ACCESS_MACHINE

MACHINE_CAN_ACCESS_MACHINE properties

SEQUENCE_NUMBER

ORGANIZATION_SUPPORTS_ENTITY

ORGANIZATION_SUPPORTS_ENTITY properties

COMMENTS CREATE: Boolean

DELETE: Boolean READ: Boolean

SEQUENCE_NUMBER UPDATE: Boolean

ORGANIZATION_SUPPORTS_FUNCTION

ORGANIZATION_SUPPORTS_FUNCTION properties

COMMENTS MAJOR_INVOLVEMENT: Boolean

MINOR_INVOLVEMENT: Boolean RESPONSIBLE

SEQUENCE_NUMBER  



ORGANIZATION_SUPPORTS_PROCESS

ORGANIZATION_SUPPORTS_PROCESS properties

COMMENTS MAJOR_INVOLVEMENT: Boolean

MINOR_INVOLVEMENT: Boolean RESPONSIBLE: Boolean

SEQUENCE_NUMBER  

OWNS_VIEW

OWNS_VIEW properties

SEQUENCE_NUMBER VIEW_USAGE: ViewUsage

PROCESS_DEPENDS_ON_PROCESS

PROCESS_DEPENDS_ON_PROCESS properties

PROCESS_DEPENDS_ON_PROCESS_DESCRIPTION EXOR_SEQUENCE_NUMBER

INCLUSIVE_FLAG: InclusiveFlag SEQUENCE_NUMBER

PROCESS_IMPACTS_ENTITY

PROCESS_IMPACTS_ENTITY properties

COMMENTS CREATE: Boolean

DELETE: Boolean READ: Boolean

SEQUENCE_NUMBER UPDATE: Boolean

PROCESS_IS_CARRIED_OUT_AT_LOCATION

PROCESS_IS_CARRIED_OUT_AT_LOCATION properties | |

COMMENTS MAJOR_INVOLVEMENT: Boolean

MINOR_INVOLVEMENT: Boolean SEQUENCE_NUMBER

PROCESS_REFINES_INTO_PROCESS

PROCESS_REFINES_INTO_PROCESS properties

CONDITIONAL_FLAG SEQUENCE_NUMBER

PROCESS_REPLACES_SYSTEM

PROCESS_REPLACES_SYSTEM properties

SEQUENCE_NUMBER

REFERS_TO

REFERS_TO properties

SEQUENCE_NUMBER

REFINES_INTO



REFINES_INTO properties

SEQUENCE_NUMBER

RELATION_IS_RELATED_VIA_RELATION

RELATION_IS_RELATED_VIA_RELATION properties

SEQUENCE_NUMBER

REPORT_CONTAINS_SECTION

REPORT_CONTAINS_SECTION properties

BREAK_FIELD BREAK_QUALIFIER

LEFT_MARGIN PAGE_PLACEMENT: PagePlace

PRINT_OPTIONS: PrintOpt SECTION_TYPE: SectionType

SEQUENCE_NUMBER SEQUENCE_NUMBER_BREAK

RESULTS_IN_STATE

RESULTS_IN_STATE properties

RESULTS_IN_STATE_DESCRIPTION SEQUENCE_NUMBER

RULE_CONVERSES_REPORT

RULE_CONVERSES_REPORT properties

SEQUENCE_NUMBER

RULE_DEPENDS_ON_RULE

RULE_DEPENDS_ON_RULE properties

RULE_DEPENDS_ON_RULE_DESCRIPTION EXOR_SEQUENCE_NUMBER

INCLUSIVE_FLAG SEQUENCE_NUMBER

RULE_TRIGGERS_EVENT

RULE_TRIGGERS_EVENT properties

CONDITION SEQUENCE_NUMBER

TYPE: RuleTriggerType VIEW_MAPPING

SERVER_CONTAINS_RULE

SERVER_CONTAINS_RULE properties

ENTRY_TYPE: EntryType RULE_OBJ_NAME

SEQUENCE_NUMBER SERVICE_NAME

SERVER_DERIVES_SERVER

SERVER_DERIVES_SERVER properties



SEQUENCE_NUMBER

SYSTEM_AFFECTS_DATA_STORE

SYSTEM_AFFECTS_DATA_STORE properties

COMMENTS CREATE: Boolean

DELETE: Boolean READ: Boolean

SEQUENCE_NUMBER UPDATE: Boolean

TABLE_HAS_COLUMN

TABLE_HAS_COLUMN properties

DISTINCT DISTINCT_TYPE: DistinctType

NULL_INDICATOR: Null SEQUENCE_NUMBER

TABLE_HAS_KEY

TABLE_HAS_KEY properties

SEQUENCE_NUMBER

TABLE_IS_BASED_ON_TABLE

TABLE_IS_BASED_ON_TABLE properties

SEQUENCE_NUMBER

TABLE_REFERRED_BY_KEY

TABLE_REFERRED_BY_KEY properties

REFERENTIAL_INTEGRITY: Boolean SEQUENCE_NUMBER

TRIGGERS_LOGICAL_PROCESS

TRIGGERS_LOGICAL_PROCESS properties

TRIGGERS_LOGICAL_PROCESS_DESCRIPTION SEQUENCE_NUMBER

USES_COMPONENT

USES_COMPONENT properties

SEQUENCE_NUMBER

USES_RULE

USES_RULE properties

SEQUENCE_NUMBER

VIEW_INCLUDES

VIEW_INCLUDES properties



NULL_INDICATOR: NullInd OCCURS

SEQUENCE_NUMBER  

WINDOW_CONTENT_HAS_HELP

WINDOW_CONTENT_HAS_HELP properties

SEQUENCE_NUMBER

WINDOW_CONTENT_HAS_PANEL

WINDOW_CONTENT_HAS_PANEL properties

SEQUENCE_NUMBER

WINDOW_HAS_BITMAP531

WINDOW_HAS_BITMAP properties

SEQUENCE_NUMBER

WINDOW_HAS_WINDOW_CONTENT

WINDOW_HAS_WINDOW_CONTENT properties

SEQUENCE_NUMBER

TurboCycler Window Controls

Controls are the visual elements in a window with which an end user can interact. Windows Controls provides instructions for coding window
blocks and supplies the reference data to complete the window control definitions in .TurboCycler Template Language

Window Statement Control Types
Window Control Properties
Property Types and Property Values
Window Properties Matrix

To design a window using the TurboCycler template language, create controls and arrange them in a window. In addition to controls, a window
can have a menu bar with pull-down menus.

Creating Controls

When you create a control with a MAKE statement, you also set its properties. Controls generally require positioning properties such as LEFT,
BOTTOM, WIDTH, and HEIGHT. Any property not explicitly set defaults to settings similar to those in Window Painter.
Specify colors by either of two methods. The first is to set the RGB color value explicitly; the other is to set a property to a color listed under
colortype. The first example uses the three RGB colors:

MAKE STATIC_TEXT
HAVING [ HPSID = ,"ID_TEXT_1"
BGCOLOR_RED = 255,
BGCOLOR_GREEN = 0,
BGCOLOR_BLUE = 0 ]
ENDMAKE

The second example uses an explicit color type definition that produces the same result.



1.  
2.  

MAKE STATIC_TEXT

HAVING [ HPSID = ,"ID_TEXT_2"
BGCOLOR =  ]"RED"
ENDMAKE

However, you cannot use both methods to set the same color property. For example, you can set the background color of a control with the three
RGB properties BGCOLOR_RED, BGCOLOR_GREEN, and BGCOLOR_BLUE, or you can set it with the single colortype property BGCOLOR.
To establish a relationship between a SPREADSHEET and its CELLs, complete the following steps:

Create your spreadsheet with a MAKE statement.
Associate each of its cells with the spreadsheet through the CONTAIN statement, as shown.

MAKE SPREADSHEET Spreadsheet
HAVING [BOTTOM = 40,
LEFT = 20,
HEIGHT = 155,
WIDTH = 200,
HPSID =  ]"ID_SPREADSHEET"
LINKED TO MyDataView
ENDMAKE

CONTAIN CELL IN Spreadsheet
HAVING [WIDTH = CellWidth,
HEIGHT = 22,
HPSID = (QUERY NAME OF MyDataFields(I)),
CONTROL_TEXT = (QUERY SCREEN_LITERAL OF
MyDataFields(I)),
IMMEDIATE_RETURN =  ]"TRUE"
LINKED TO MyDataFields(I)
ENDCONTAIN

You need the same relationship for LB_COLUMN (which must be in a LISTBOX) and CHART_X_AXIS and CHART_Y_AXIS (which must be in a
CHART_WINDOW).

    3. When TABSTOP is TRUE, the tabbing order for controls is the same order as they are created in the window block.

The following sections list control types and their properties of the window statement. Also see  for a summary of all the controlWindow Properties
types and properties.

Property Types and Property Values

This section details the contents of each of the window block properties in TurboCycler, as listed in . The supportedWindow Block Property Types
values for each property type are listed in the tables under each subheading. Refer to  for cross-reference of supportWindow Control Properties
for properties and controls.

Window Block Property Types

boolean fonttype

charformattype funckeytype

charttype justificationtype

colortype modifiertype

drawlinestype selectmodetype

fieldtype  

boolean

boolean Property Types



FALSE false

NO no

TRUE true

YES yes

0 1

charformattype

charformattype Property Types

ALLFIRSTUPPER FIRSTUPPER

LOWER UPPER

charttype

charttype Property Types

AREACHART2D AREACHART3D

BARCHART2D BARCHART3D

BARLINECHART2D BARLINECHART3D

CANDLE2D COLUMNCHART2D

COLUMNCHART3D HILOCLOSE2D

LINECHART2D LINECHART3D

PERBARCHART3D PIECHART2D

PIECHART3D POINTANDFIG2D

SMOOTHLINECHART2D SCATTERCHART2D

STACKEDBARCHART2D STACKEDBARCHART3D

colortype

colortype Property Types

BLACK BLUE

BROWN CYAN

DARK_BLUE DARK_CYAN

DARK_GRAY DARK_GREEN

DARK_MAGENTA DARK_RED

DARK_YELLOW GRAY

GREEN MAGENTA

PINK RED

WHITE YELLOW

drawlinestype

drawslinestype Properties

HLINES NOLINES



VHLINES VLINES

fieldtype

fieldtype Properties

EDIT PROTECTED

CONTROL_TEXT  

fonttype

fonttype Properties

MODERN8 MODERN10

MODERN12 ROMAN8

ROMAN10 ROMAN12

ROMAN14 ROMAN18

ROMAN24 SWISS8

SWISS10 SWISS12

SWISS14 SWISS18

SWISS24 SYSTEMFONT8

funckeytype

funckeytype Properties

F1 F2

F3 F4

F5 F6

F7 F8

F9 F10

F11 F12

justificationtype

justificationtype Properties

CENTER LEFT

RIGHT  

modifiertype

Modifiertype Properties

ALT CTRL  

SHIFT    

selectmodetype

Selectmodetype properties



EXTENDED MULTIPLE

SINGLE  

Window Control Properties

Window Control Properties lists all the properties and the property types for window block controls. The linked subtopics describe each property in
alphabetical order. Refer to  for more details. For a cross-referenced chart of all window controls andProperty Types and Property Values
properties, refer to the .Window Properties Matrix
The window control properties in TurboCycler are listed in the following table:

Window Control Properties

A I-J-K-L

B M-N-O-P

C-D-E R

F S through Z

G-H  

A

ASCII_KEY string

Specifies an ASCII character to be used as the shortcut key for a control. If you specify ASCII_KEY, set MODIFIER to CTRL. (Refer to MODIFIER
 and .)modifiertype FUNC_KEY funckeytype

AUTO_CALL boolean

If AUTO_CALL is TRUE for a LISTBOX or SPREADSHEET, control returns to the invoking rule when the end user tries to scroll beyond the first
or last occurrence defined in the view data structure associated with the list box. The rule can then retrieve more data. Set AUTO_CALL only if
you do not use the component SET_VIRTUAL_LISTBOX_SIZE described in the AppBuilder documentation for your system.

AUTO_SELECT boolean

If AUTO_SELECT is TRUE, the end user can put the cursor on an item in a SPREADSHEET to select it. Any selected item is deselected. If
AUTO_SELECT is FALSE, the end user can move the cursor without changing the selection. AUTO_SELECT does not apply when
SELECT_MODE is set to MULTIPLE. (See .)SELECT_MODE selectmodetype

B

BDCOLOR colortype

Sets the border color of the control to one of the colors listed for colortype.

BDCOLOR_RED integer

Sets the border color RGB red value. Assign an integer value between 0 and 255.

BDCOLOR_GREEN integer

Sets the border color RGB green value. Assign an integer value between 0 and 255.

BDCOLOR_BLUE integer

Sets the border color RGB blue value. Assign an integer value between 0 and 255.

BGCOLOR colortype

Sets the background color of the control to one of the colors listed for colortype.

BGCOLOR_RED integer



Sets the background color RGB red value. Assign an integer value between 0 and 255.

BGCOLOR_GREEN integer

Sets the background color RGB green value. Assign an integer value between 0 and 255.

BGCOLOR_BLUE integer

Sets the background color RGB blue value. Assign an integer value between 0 and 255.

BLUE integer

Sets the control color RGB blue value. Assign an integer value between 0 and 255.

BOTTOM integer

Sets the vertical position of the bottom edge of the control.

C-D-E

CELL_HEIGHT integer

Sets the vertical size of a CELL in a SPREADSHEET.

CHARFORMAT charformattype

Sets the case of text in the control.

CHART_TYPE charttype

Sets the type of chart displayed in a CHART_WINDOW control to one of the types listed under charttype.

CHECK_MANDATORY_FIELDS boolean

If TRUE, all controls that have their MANDATORY property set to TRUE must contain valid entries when the end user selects the
PUSH_BUTTON. If a control does not contain a valid entry, a message box is displayed and the first control containing an invalid entry receives
the input focus. (See .)MANDATORY boolean

COLOR colortype

Sets the control color to one of the colors listed for colortype.

CONTROL_TEXT string

Specifies the label that appears on CELL, CHART_WINDOW, CHECKBOX, GROUPBOX, PUSH_BUTTON, RADIO_BUTTON, or STATIC_TEXT
controls. To define a mnemonic key, precede the character with an ampersand (&) or a tilde (~).

DRAW_LINES drawlinestype

Determines whether a SPREADSHEET is displayed with horizontal and vertical lines, horizontal lines only, vertical lines only, or no lines at all.

F

FGCOLOR colortype

Sets the foreground color of the control to one of the colors listed for colortype.

FGCOLOR_RED integer

Sets the foreground color RGB red value. Assign an integer value between 0 and 255.

FGCOLOR_GREEN integer

Sets the foreground color RGB green value. Assign an integer value between 0 and 255.

FGCOLOR_BLUE integer

Sets the foreground color RGB blue value. Assign an integer value between 0 and 255.



FIELD_TEXT string

If the FIELD_TYPE property of a CELL were CONTROL_TEXT, specifies the text to be displayed. If the FIELD_TYPE is not CONTROL_TEXT,
do not set this property.

FIELD_TYPE fieldtype

Specifies the type of field displayed in a CELL: text, edit, or protected edit.

FILE string

For a BITMAP, identifies the bit map file associated with the control; for a DROPDOWN_COMBOBOX, specifies the Reference Table Name of the
field entity linked to the DROPDOWN_COMBOBOX with a .REF extension. The Reference Table Name attribute should be the system ID of the
online validation set associated with the field entity in the hierarchy.

FONT fonttype

Sets the font of labels and input text. Use the default font where possible to make the windows device independent. Not all controls support all
fonts. Selecting a font can cause the HEIGHT property to be ignored for EDIT_FIELD, PROTECTED_EDIT_FIELD, RADIO_BUTTON, and
CHECKBOX controls.

FOOTING string

Sets the footing text displayed in a CHART_WINDOW.

FOOTING_COLOR colortype

Sets the color of the FOOTING text displayed in a CHART_WINDOW.

FOOTING_COLOR_RED integer

Sets the RGB color red value of the FOOTING text displayed in a CHART_WINDOW. Assign an integer value between 0 and 255.

FOOTING_COLOR_GREEN integer

Sets the RGB color green value of the FOOTING text displayed in a CHART_WINDOW. Assign an integer value between 0 and 255.

FOOTING_COLOR_BLUE integer

Sets the RGB color blue value of the FOOTING text displayed in a CHART_WINDOW. Assign an integer value between 0 and 255.

FUNC_KEY funckeytype

Sets the function key to be used as a shortcut key for the control. (See .)ASCII_KEY string

G-H

GREEN integer

Sets the control color RGB green value. Assign an integer value in the range of 0 to 255.

GROUPSTART boolean

If TRUE, specifies that the control starts a group. Do not set this property for other controls in the group. Create all controls in the group in
sequence so that the tab order will be correct.

HEADER_BOTTOM integer

Specifies the vertical position of the column headings in a SPREADSHEET control.

HEADER_HEIGHT integer

Specifies the height of the column headings in a SPREADSHEET control.

HEADER_HPSID string

Specifies the HPSID for static text in a multicolumn list box header.



HEADING string

Sets heading text displayed in a CHART_WINDOW.

HEADING_COLOR colortype

Sets the color of the HEADING text displayed in a CHART_WINDOW.

HEADING_COLOR_RED integer

Sets the RGB color red value of the HEADING text displayed in a CHART_WINDOW. Assign an integer value between 0 and 255.

HEADING_COLOR_GREEN integer

Sets the RGB color green value of the HEADING text displayed in a CHART_WINDOW. Assign an integer value between 0 and 255.

HEADING_COLOR_BLUE integer

Sets the RGB color blue value of the HEADING text displayed in a CHART_WINDOW. Assign an integer value between 0 and 255.

HEIGHT integer

Sets the vertical size of the control.

HPSID string

Contains the text that uniquely identifies the control to the system. Every HPSID must be unique for the generated application to work correctly at
run time.

I-J-K-L

IMMEDIATE_RETURN boolean

If TRUE, this control returns control to the invoking rule when the end user navigates away from the control. For a read-only control, double-click
the control to return program control to the invoking rule.

JUSTIFICATION justificationtype

This property formats control text as right justified, left justified, or centered. This property applies to all the field types: text, numeric, date, and
time.

LEFT integer

Sets the horizontal position of the control.

LEFTLABEL string

Sets the text displayed on the left side of a CHART_WINDOW.

LEFTLABEL_COLOR colortype

Sets the color of the LEFTLABEL text displayed in a CHART_WINDOW.

LEFTLABEL_COLOR_RED integer

Sets the RGB color red value of the LEFTLABEL text displayed in a CHART_WINDOW. Assign an integer value between 0 and 255.

LEFTLABEL_COLOR_GREEN integer

Sets the RGB color green value of the LEFTLABEL text displayed in a CHART_WINDOW. Assign an integer value between 0 and 255.

LEFTLABEL_COLOR_BLUE integer

Sets the RGB color blue value of the LEFTLABEL text displayed in a CHART_WINDOW. Assign an integer value between 0 and 255.

LEGEND string

Specifies the legend label for a CHART_Y_AXIS control in a CHART_WINDOW.



M-N-O-P

MANDATORY boolean

If TRUE, requires that the control contain valid input when the end user selects a PUSH_BUTTON having CHECK_MANDATORY_FIELDS set to
TRUE. (See .)CHECK_MANDATORY_FIELDS boolean

MAXIMIZE boolean

If TRUE, a maximize arrow appears on the window of a CHART_WINDOW.

MAXIMUM decimal

Sets the maximum value allowed for numeric fields.

MINIMIZE boolean

If TRUE, a minimize arrow appears on the window of a CHART_WINDOW.

MINIMUM decimal

Sets the minimum value allowed for numeric fields.

MODIFIER modifiertype

Specifies that the Ctrl, Alt, or Shift keys must be pressed with a FUNC_KEY or ASCII_KEY to activate a shortcut key for a control. You can use
only one modifier. For a ASCII_KEY, set the MODIFIER to CTRL. (See  and .)ASCII_KEY string FUNC_KEY funckeytype

NUMBERING_RECORD boolean

When TRUE, the rows of a SPREADSHEET control are numbered on the left side of the control.

PICTURE string

Sets the display format of fields. The string consists of literal text and format specifiers that control the appearance of date, time, and numeric
fields, as shown in  through . For the date and time fields, the picture can combine literalDate Specifiers Numeric and Replacement Characters
text with the specifiers, as shown in  and .Standard Date Formats Standard Time Formats

Date Specifiers

Specifier Description

%c Century

%D Day of the month, with suffix

%d Day of the month

%j Julian day

%M Month of the year, text

%m Month of the year

%W Day of the week, text

%Y Year

%y Years since 1900

Standard Date Formats

Date Example

%m/%d/%y 1/5/95

%0m/%0d/%0y 01/05/95



%m-%d 1-5

%m-%y 1-95

%0c%0y%0m%0d 19950105

%W, %M %D, %Y Thursday, January 5th, 1995

Today is %W. Today is Thursday

%d/%m/%y 1/5/95

%0d/%0m/%y 01/05/95

%d-%m 5-1

%j 5

%c 19

For time fields, the picture can contain literal text alone and in combination with the specifiers, as shown in  and Time Format Specifiers Standard
.Time Formats

Time Format Specifiers

Specifier Description

%H Hour, text (24-hour clock)

%h Hour (12-hour clock)

%M Minutes, text

%m Minutes

%s Seconds

%t Hour (24-hour clock)

%x AM/PM indicator

Standard Time Formats

Time display picture Example

%0h:%0m:%0s %x 01:22:03 PM

%0h:%0m:%0s 13:22:03

%h-%m-%s %x 1-22-3 PM

%t-%m-%s 13-22-3

%h %x 1 PM

%H %M Thirteen Twenty_Two

Time is %H Time is Thirteen

The time is %h-%m-%s %x. The time is 1-22-3 PM.

For numeric fields, valid replacement characters are: 9 . , $ Z * S + - cr db, as shown in . The countryNumeric and Replacement Characters
setting determines the replacement of the characters: . , $ S.

Numeric and Replacement Characters

Character Description  

9 Numeric character  

. Decimal separator  



, Thousands separator  

$ Currency symbol  

Z Suppress leading zeroes  

* Pad left with asterisks  

S Sign character  

+ Sign character, printed only if positive  

- Sign character, printed only if negative  

cr Credit symbol, printed only if negative  

db Debit symbol, printed only if negative  

R

READ_ONLY boolean

If TRUE, the end user cannot change the text in the control.

RED integer

Sets the control color RGB red value. Assign an integer value between 0 and 255.

RESIZE boolean

If TRUE, end users can grab the border of a CHART_WINDOW to resize the chart.

RIGHTLABEL string

Sets the text displayed on the right side of a CHART_WINDOW.

RIGHTLABEL_COLOR colortype

Sets the color of the RIGHTLABEL text displayed in a CHART_WINDOW.

RIGHTLABEL_COLOR_RED integer

Sets the RGB color red value of the RIGHTLABEL text displayed in a CHART_WINDOW. Assign an integer value between 0 and 255.

RIGHTLABEL_COLOR_GREEN integer

Sets the RGB color green value of the RIGHTLABEL text displayed in a CHART_WINDOW. Assign an integer value between 0 and 255.

RIGHTLABEL_COLOR_BLUE integer

Sets the RGB color blue value of the RIGHTLABEL text displayed in a CHART_WINDOW. Assign an integer value between 0 and 255.

ROW_SELECT boolean

If TRUE, the end user can select an entire row in a SPREADSHEET by clicking a cell in a row. Otherwise, only the clicked cell is selected.

S through Z

SCROLL_LOCK boolean

If TRUE, the end user can tab to the next row in a SPREADSHEET when reaching the end of the current row; also, the end user must press
Ctrl+Tab to shift the input focus to the next control in the window. If FALSE, the end user's tabbing at the end of a row shifts the input focus to the
next control in the window.

SELECT_MODE selectmodetype

Specifies in a SPREADSHEET whether the end user can select only one item (SINGLE), zero or more items (MULTIPLE), or one or more items
(EXTENDED).



TABSTOP boolean

If TRUE, the end user can tab to the control. The order that you specify objects in the window block determines the tabbing order of window
controls in the completed window.

VISIBLE boolean

If TRUE, the control is visible to the end user.

WIDTH integer

Sets the horizontal width of the control. For a CELL, this is the width of the column in the SPREADSHEET.

WORDWRAP boolean

If TRUE, automatically wraps text displayed in a MULTILINE_EDIT to a new line, based on the size of the control. If FALSE, the end user must
scroll horizontally to see hidden text.

Window Properties Matrix

The following table provides a comprehensive matrix indicating supported properties and controls for windows:

Window Properties

Properties Controls:          

  STATIC_TEXT SPREADSHEET RECTANGLE RADIO_BUTTON PUSH_BUTTON PROTECTED_EDIT_FIELD

AUTO_CALL   x        

AUTO_SELECT   x        

BDCOLOR x x   x x x

BDCOLOR_RED x x   x x x

BDCOLOR_GREEN x x   x x x

BDCOLOR_BLUE x x   x x x

BGCOLOR x x   x x x

BGCOLOR_RED x x   x x x

BGCOLOR_GREEN x x   x x x

BGCOLOR_BLUE x x   x x x

BLUE     x      

BOTTOM x x x x x x

CELL_HEIGHT   x        

CHARFORMAT           x

CHART_TYPE            

CHECK_MANDATORY_FIELDS         x  

COLOR     x      

DRAW_LINES   x        

FGCOLOR x x   x x x

FGCOLOR_RED x x   x x x

FGCOLOR_GREEN x x   x x x

FGCOLOR_BLUE x x   x x x



FIELD_TEXT            

FIELD_TYPE            

FILE            

FONT x x   x x x

FOOTING            

FOOTING_COLOR            

FOOTING_COLOR_RED            

FOOTING_COLOR_GREEN            

FOOTING_COLOR_BLUE            

FUNC_KEY         x  

GREEN     x      

GROUPSTART   x   x x x

HEADER_BOTTOM            

HEADER_HEIGHT   x        

HEADER_HPSID   x        

HEADING            

HEADING_COLOR            

HEADING_COLOR_RED            

HEADING_COLOR_GREEN            

HEADING_COLOR_BLUE            

HEIGHT x x x x x x

HPSID x x x x x x

IMMEDIATE_RETURN       x   x

JUSTIFICATION           x

ASCII_KEY         x  

LEFT x x x x x x

LEFTLABEL            

LEFTLABEL_COLOR            

LEFTLABEL_COLOR_RED            

LEFTLABEL_COLOR_GREEN            

LEFTLABEL_COLOR_BLUE            

LEGEND            

MANDATORY            

MAXIMIZE            

MAXIMUM           x

MINIMIZE            

MINIMUM           x

MODIFIER         x  

NUMBERING_RECORD   x        



PICTURE           x

READ_ONLY            

RED     x      

RESIZE            

RIGHTLABEL            

RIGHTLABEL_COLOR            

RIGHTLABEL_COLOR_RED            

RIGHTLABEL_COLOR_GREEN            

RIGHTLABEL_COLOR_BLUE            

ROW_SELECT   x        

SCROLL_LOCK   x        

SELECT_MODE   x        

TABSTOP   x   x x x

CONTROL_TEXT x     x x  

VISIBLE x x   x x x

WIDTH x x x x x x

WORDWRAP            

Window Statement Control Types

Window controls are the visual elements in a window with which the end user interacts. The window control types and their properties are
described in this topic. Refer to  for a cross-referenced list of all window controls and properties.Window Properties Matrix
The window controls in TurboCycler are listed in the following table:

TurboCycler Window Controls

BITMAP GROUPBOX

CELL HOTSPOT

CHART_WINDOW LB_COLUMN

CHART_X_AXIS LISTBOX

CHART_Y_AXIS MULTILINE_EDIT

CHECKBOX PROTECTED_EDIT_FIELD

DROPDOWN_COMBOBOX PUSH_BUTTON

DROPDOWN_LISTBOX RADIO_BUTTON

EDIT_FIELD RECTANGLE

ELLIPSE SPREADSHEET

FILE_EDITOR STATIC_TEXT

BITMAP

A special type of static control that displays a bitmap from a file. It cannot be linked to a repository object. Its properties are as follows:

BITMAP Control Properties

BOTTOM FILE



HEIGHT HPSID

LEFT VISIBLE

WIDTH  

CELL

A CELL represents a column in a SPREADSHEET. It is not a visual control. The linked-to field must be in a multiply-occurring logical view. A
CELL can be created only by a CONTAIN statement. Its properties are as follows:

CELL Properties

CHARFORMAT FIELD_TEXT

FIELD_TYPE HEADER_BOTTOM

HEIGHT HPSID

IMMEDIATE_RETURN JUSTIFICATION

MANDATORY MAXIMUM

MINIMUM PICTURE

CONTROL_TEXT WIDTH

CHART_WINDOW

Displays data graphically in one of thirteen different formats. End users cannot tab to a chart. The CHART_WINDOW must be linked to a
multiply-occurring view. Data to be displayed is specified by creating CHART_X_AXIS and CHART_Y_AXIS controls using the CONTAIN
statement. A window can contain no more than ten CHART_WINDOW controls. Its properties are as follows:

CHART_WINDOW Properties

BOTTOM CHART_TYPE

FOOTING FOOTING_COLOR

FOOTING_COLOR_RED FOOTING_COLOR_GREEN

FOOTING_COLOR_BLUE HEADING

HEADING_COLOR HEADING_COLOR_RED

HEADING_COLOR_GREEN HEADING_COLOR_BLUE

HEIGHT HPSID

LEFT LEFTLABEL

LEFTLABEL_COLOR LEFTLABEL_COLOR_RED

LEFTLABEL_COLOR_BLUE LEFTLABEL_COLOR_GREEN

MAXIMIZE MINIMIZE

RESIZE RIGHTLABEL

RIGHTLABEL_COLOR RIGHTLABEL_COLOR_RED

RIGHTLABEL_COLOR_GREEN RIGHTLABEL_COLOR_BLUE

CONTROL_TEXT WIDTH

CHART_X_AXIS

CHART_X_AXIS represents an x-axis variable in a CHART_WINDOW. It is not really a visual control. This control must be created with the
CONTAIN statement. The linked-to field must be in a multiply-occurring view and can be of any type. Only one CHART_X_AXIS control is created
per CHART_WINDOW. Its property is as follows:

CHART_X_AXIS Properties



HPSID

CHART_Y_AXIS

CHART_Y_AXIS represents a y-axis variable in a CHART_WINDOW. It is not really a visual control. This control must be created with the
CONTAIN statement. The linked-to field must be in a multiply-occurring view and must be of numeric type. A CHART_WINDOW can contain up to
eight CHART_Y_AXIS controls. Its properties are as follows:

CHART_y_AXIS Properties

HPSID LEGEND

CHECKBOX

A toggle switch you can use when its setting is independent of any other control. The linked-to field type is character, and its length must be one.
You can specify a mnemonic key with the CONTROL_TEXT property. Its properties are:

CONTROL_TEXT Properties

BDCOLOR BDCOLOR_RED

BDCOLOR_GREEN BDCOLOR_BLUE

BGCOLOR BGCOLOR_RED

BGCOLOR_GREEN BGCOLOR_BLUE

BOTTOM FGCOLOR

FGCOLOR_RED FGCOLOR_GREEN

FGCOLOR_BLUE FONT

GROUPSTART HEIGHT

HPSID IMMEDIATE_RETURN

LEFT TABSTOP

CONTROL_TEXT VISIBLE

WIDTH  

DROPDOWN_COMBOBOX

DROPDOWN_COMBOBOX combines an EDIT_FIELD and a LISTBOX. The user can type a value in the control or select a value from a
scrollable list. The linked-to field must have its Reference Table Name attribute set to the System ID of the online validation set associated with
the field entity in the hierarchy. Its properties are as follows:

DROPDOWN_COMBOBOX Properties

BDCOLOR BDCOLOR_RED

BDCOLOR_GREEN BDCOLOR_BLUE

BGCOLOR BGCOLOR_RED

BGCOLOR_GREEN BGCOLOR_BLUE

BOTTOM FGCOLOR

FGCOLOR_RED FGCOLOR_GREEN

FGCOLOR_BLUE FILE

FONT GROUPSTART

HEIGHT HPSID

IMMEDIATE_RETURN LEFT

MANDATORY TABSTOP



VISIBLE WIDTH

DROPDOWN_LISTBOX

DROPDOWN_LISTBOX behaves like the DROPDOWN_COMBOBOX except that the user can type values only from the set referenced by the
Reference Table Name attribute of the linked-to field. Its properties are as follows:

DROPDOWN_LISTBOX Properties

BDCOLOR BDCOLOR_RED

BDCOLOR_GREEN BDCOLOR_BLUE

BGCOLOR BGCOLOR_RED

BGCOLOR_GREEN BGCOLOR_BLUE

BOTTOM FGCOLOR

FGCOLOR_RED FGCOLOR_GREEN

FGCOLOR_BLUE FILE

FONT GROUPSTART

HEIGHT HPSID

IMMEDIATE_RETURN LEFT

MANDATORY TABSTOP

VISIBLE WIDTH

EDIT_FIELD

Defines an entry field in which the end user can type and edit data associated with the linked-to field, which can be a single occurrence field of
any type except TIMESTAMP. Its properties are as follows:

EDIT_FIELD Properties

BDCOLOR BDCOLOR_RED

BDCOLOR_GREEN BDCOLOR_BLUE

BGCOLOR BGCOLOR_RED

BGCOLOR_GREEN BGCOLOR_BLUE

BOTTOM CHARFORMAT

FGCOLOR FGCOLOR_RED

FGCOLOR_GREEN FGCOLOR_BLUE

FONT GROUPSTART

HEIGHT HPSID

IMMEDIATE_RETURN JUSTIFICATION

LEFT MANDATORY

MAXIMUM MINIMUM

PICTURE TABSTOP

VISIBLE WIDTH

ELLIPSE

A special type of static control that displays a filled ellipse in the window. It cannot be linked to a repository object. Its properties are as follows:

ELLIPSE Properties



BLUE BOTTOM

COLOR GREEN

HEIGHT HPSID

LEFT RED

WIDTH  

FILE_EDITOR

End users can view the contents of a text file, but they cannot edit it. The linked-to field must be of type character or variable character and must
contain the complete path name of the file to display at run time. Its properties are:

FILE_EDITOR Properties

BDCOLOR BDCOLOR_RED

BDCOLOR_GREEN BDCOLOR_BLUE

BGCOLOR BGCOLOR_RED

BGCOLOR_GREEN BGCOLOR_BLUE

BOTTOM FGCOLOR

FGCOLOR_RED FGCOLOR_GREEN

FGCOLOR_BLUE FONT

GROUPSTART HEIGHT

HPSID LEFT

TABSTOP VISIBLE

WIDTH WORDWRAP

GROUPBOX

Associates related controls, usually RADIO_BUTTONs. Within the group, the end user can use the arrow keys rather than Tab to navigate among
controls. A GROUPBOX cannot be linked to a repository object. Its properties are:

GROUPBOX Properties

BOTTOM CONTROL_TEXT

FGCOLOR FGCOLOR_RED

FGCOLOR_GREEN FGCOLOR_BLUE

FONT HEIGHT

HPSID LEFT

VISIBLE WIDTH

HOTSPOT

Behaves like a PUSH_BUTTON but is not displayed at run time. Usually, a HOTSPOT is positioned behind a BITMAP to create what appears to
end users as a bitmap push button. Like a PUSH_BUTTON, a HOTSPOT cannot be linked to a repository object. Its properties are:

HOTSPOT Properties

BOTTOM HEIGHT

HPSID LEFT

WIDTH  



LB_COLUMN

LB_COLUMN represents a column in a LISTBOX. It is not really a visual control. The linked-to field must be in a multiply-occurring logical view.
You must create one LB_COLUMN for each LISTBOX using the CONTAIN statement. Its properties are as follows:

LB_COLUMN Properties

CHARFORMAT JUSTIFICATION

MAXIMUM MINIMUM

PICTURE  

LISTBOX

Displays a list of choices in a vertically scrolling window. A LISTBOX is linked to a multiply-occurring view. The field entity is specified by creating
a LB_COLUMN in a CONTAIN statement. Its properties are as follows:

LISTBOX Properties

AUTO_CALL BDCOLOR

BDCOLOR_RED BDCOLOR_GREEN

BDCOLOR_BLUE BGCOLOR

BGCOLOR_RED BGCOLOR_GREEN

BGCOLOR_BLUE BOTTOM

FGCOLOR FGCOLOR_RED

FGCOLOR_GREEN FGCOLOR_BLUE

FONT GROUPSTART

HEIGHT HPSID

IMMEDIATE_RETURN LEFT

SELECT_MODE TABSTOP

VISIBLE WIDTH

MULTILINE_EDIT

Defines an entry field in which the user can enter text on multiple lines. The linked-to field must be of the type character or variable character. Its
properties are as follows:

MULTILINE_EDIT Properties

BDCOLOR BDCOLOR_RED

BDCOLOR_GREEN BDCOLOR_BLUE

BGCOLOR BGCOLOR_RED

BGCOLOR_GREEN BGCOLOR_BLUE

BOTTOM FGCOLOR

FGCOLOR_RED FGCOLOR_GREEN

FGCOLOR_BLUE FONT

GROUPSTART HEIGHT

HPSID IMMEDIATE_RETURN

LEFT MANDATORY

READ_ONLY TABSTOP



VISIBLE WIDTH

WORDWRAP  

PROTECTED_EDIT_FIELD

Behaves like an EDIT_FIELD except that the end user cannot edit the displayed data. Its properties are as follows:

PROTECTED_EDIT_FIELD Properties

BDCOLOR BDCOLOR_RED

BDCOLOR_GREEN BDCOLOR_BLUE

BGCOLOR BGCOLOR_RED

BGCOLOR_GREEN BGCOLOR_BLUE

BOTTOM CHARFORMAT

FGCOLOR FGCOLOR_RED

FGCOLOR_GREEN FGCOLOR_BLUE

FONT GROUPSTART

HEIGHT HPSID

IMMEDIATE_RETURN JUSTIFICATION

LEFT MAXIMUM

MINIMUM PICTURE

TABSTOP VISIBLE

WIDTH  

PUSH_BUTTON

PUSH_BUTOON usually completes an end user's interaction with the window. When the end user selects a PUSH_BUTTON, its HPSID is
returned to the invoking rule. You cannot link a PUSH_BUTTON to a repository object.
There are two methods used to associate push buttons with shortcut keys:

Specify the key as an ASCII character using the ASCII_KEY property.
Use the function keys listed under the funckeytype property domain with the FUNC_KEY property.

You cannot specify the same button with both methods. However, you can use one method for one button and the other method for a different
button.
You can also set the MODIFIER property to require that the Ctrl, Alt, or Shift key be pressed simultaneously with the ASCII_KEY or FUNC_KEY
property. For Window Painter compatibility, you must set MODIFIER to CTRL if the shortcut is an ASCII_KEY. You can use only one modifier, so,
for example, attempting to combine the Ctrl+Tab keys is an error. You can specify a PUSH_BUTTON mnemonic by the CONTROL_TEXT
property.
The PUSH_BUTTON properties are listed in .PUSH_BUTTON Properties

PUSH_BUTTON Properties

ASCII_KEY FGCOLOR_GREEN

BDCOLOR FGCOLOR_RED

BDCOLOR_BLUE FONT

BDCOLOR_GREEN FUNC_KEY

BDCOLOR_RED GROUPSTART

BGCOLOR HEIGHT

BGCOLOR_BLUE HPSID

BGCOLOR_GREEN LEFT



BGCOLOR_RED MODIFIER

BOTTOM TABSTOP

CONTROL_TEXT VISIBLE

FGCOLOR WIDTH

FGCOLOR_BLUE  

RADIO_BUTTON

A toggle switch that indicates one of a mutually exclusive set of choices. The linked-to field has type character and a length sufficient to hold the
longest HPSID of the RADIO_BUTTONs in the group. You can specify a mnemonic key with the CONTROL_TEXT property. Its properties are
listed in the following table:

RADIO_BUTTON Properties

BDCOLOR FGCOLOR_GREEN

BDCOLOR_BLUE FGCOLOR_RED

BDCOLOR_GREEN FONT

BDCOLOR_RED GROUPSTART

BGCOLOR HEIGHT

BGCOLOR_BLUE HPSID

BGCOLOR_GREEN IMMEDIATE_RETURN

BGCOLOR_RED LEFT

BOTTOM TABSTOP

CONTROL_TEXT VISIBLE

FGCOLOR WIDTH

FGCOLOR_BLUE  

RECTANGLE

A special type of static control that displays a filled rectangle on the window. It cannot be linked to a repository object. Its properties are listed in
the following table:

RECTANGLE Properties

BLUE HPSID

BOTTOM LEFT

COLOR RED

GREEN WIDTH

HEIGHT  

SPREADSHEET

Contains columns that represent linked fields and rows that represent each field occurrence. The end user can edit cells thus formed. The
SPREADSHEET must be linked to a multiply-occurring logical view. Specify the fields displayed in each column by creating a CELL control using
the CONTAIN statement for each field. This control only supports the following fonts: SYSTEMFONT8, SWISS8, ROMAN8, MODERN8,
MODERN10, and MODERN12. Its properties are listed in the following table:

SPREADSHEET Properties

AUTO_CALL FGCOLOR_RED

AUTO_SELECT FONT



BDCOLOR GROUPSTART

BDCOLOR_BLUE HEADER_HEIGHT

BDCOLOR_GREEN HEADER_HPSID

BDCOLOR_RED HEIGHT

BGCOLOR HPSID

BGCOLOR_BLUE LEFT

BGCOLOR_GREEN NUMBERING_RECORD

BGCOLOR_RED ROW_SELECT

BOTTOM SCROLL_LOCK

CELL_HEIGHT SELECT_MODE

DRAW_LINES TABSTOP

FGCOLOR VISIBLE

FGCOLOR_BLUE WIDTH

FGCOLOR_GREEN  

STATIC_TEXT

Displays labels or instructions. A STATIC_TEXT cannot be linked to a repository object. Its properties are listed in the following table:

STATIC_TEXT Properties

BDCOLOR FGCOLOR

BDCOLOR_BLUE FGCOLOR_BLUE

BDCOLOR_GREEN FGCOLOR_GREEN

BDCOLOR_RED FGCOLOR_RED

BGCOLOR FONT

BGCOLOR_BLUE HEIGHT

BGCOLOR_GREEN HPSID

BGCOLOR_RED LEFT

BOTTOM VISIBLE

CONTROL_TEXT WIDTH

Build Scripts
In addition to the TurboScripter objects described , the following objects are also available for the buildTurboScripter Object's Model Reference
scripts.

BuildFramework Object
ApplicationConfiguration Object
PartitionConfiguration Object
BuildConfiguration Object

The new AppBuilder Object Oriented Development

The build framework uses build scripts to build an entity. It uses the AppBuilder's TurboScripting host as a scripting engine. The Turbo scripting
engine supports two scripting languages, Javascript (JScript) and Visual Basic (VB) script. Build Framework also supports XSLT scripts.
You can define your own build passes for a type in the build configuration file and then write the steps required to execute the pass in Javascript.

Example: ODF Generation for an Entity



The following is a sample build script to generate ODF for an Entity at build time.

//file odfgen.js
//Repository  APPCFGObject
var objAppCfg = InputObject(0);

//Repository object PARTITION
 objPartition = InputObject(1);var

//Current Object
 curObject = InputObject(2);var

//The main configuration object
 BuildAppConfig = BuildFramework.GetApplicationConfiguration();var

//The  to partition odf propertiesinterface
 BuildPartConfig = BuildAppConfig.GetPartitionConfiguration(objPartition.GetProperty( ));var "ShortName"

 genLanguage = BuildPartConfig.GetProperty( );var "GeneratedLanguage"
 LogSubDir = BuildConfig.GetProperty(genLanguage, ); var "LogDir" //log
 odfSubDir = BuildConfig.GetProperty(genLanguage, );var "OdfDir"
 workDir = BuildPartConfig.GetWorkingDirectory();var

 odfPath = workDir\+ "var
\\
" \+odfSubDir;

 objShortName = curObject.GetProperty( );var "ShortName"

 logFile = workDir + "var
\\
" +LogSubDir+"
\\
OdfGen.out";
Trace.OutFile = logFile;

Trace.Log( , );"OdfGen.js :%s\n" "Entering"

 msg = curObject.GetProperty( );var "Name"
msg \+= ;":"
msg \+= objShortName;
msg \+= ;".odf.xml"
Trace.Log( , msg);"OdfGen.js :generating ODF - %s\n"

//extract ODf  current for Object
curObject.ExtractODF(odfPath);

 result = 0; var //???
 fso =  ActiveXObject( );var new "Scripting.FileSystemObject"

WriteResult(fso, workDir, LogSubDir, result);

Trace.Log( , );"OdfGen.js :%s\n" "Exiting"

function WriteResult(fso, workingDir, logDir, rslt)
\{

 ForWriting = 2;var
 outfile2 = workingDir;var

outfile2 \+= "
\\
";
outfile2 \+= logDir;
outfile2 \+= "
\\
OdfGen.js.out";



Trace.Log( , outfile2);"Writing Results :%s\n"

 odfResult = fso.OpenTextFile(outfile2, ForWriting, , \-2);var true
odfResult .Write(rslt);



odfResult .Close();

\}

BuildFramework Object

This object implements the ITSBuildFramework interface. BuildFramework object represents the OO Development build/preparation framework.
Users who write build scripts can access this object from the build scripts. This object's properties are defined below.

GetWorkingDirectory(String partition_short_name)

This method returns the root build directory for a partition, given its shortname.
Example:

var work_dir = BuildFramework.GetWorkingDirectory( )"ZBADGJFT"

GetApplicationConfiguration()

This method returns the application configuration object.

ApplicationConfiguration Object

This object represents the Build application configuration object. It implements the ITSBuildFramework. For building/preparing an application, you
have to configure the application using the Application configuration, which can contain multiple partitions. The script can access this object and
the following properties.

GetPartitionConfiguration(String partition_short_name)

This method returns the Partition configuration object.

IsRemoteRule(String rulename)

Returns true if the given rule is a remote rule in the application.

PartitionConfiguration Object

This object represents the partition in the OO development build framework. The script can access the following properties of this object.

GetWorkingDirectory()

This method gets the current build directory.

GetProperty(String PropName)

This method gets any property of the PARTITION object.

GetDistributionDirectory()

Gets the distribution directory for the application (distribution directory is the directory where the binary distributables are copied to when building
an application).

BuildConfiguration Object

This object represents the build configuration. The configuration is loaded from the BuildConfig.xml file.
The build script can get the properties defined in the build configuration file. The build configuration defines how to build an AppBuilder type.
There is one set of configuration options for a build target language such as Java, C#.

GetProperty(PropName)

This method gets the named property of the current configuration, from the build configuration xml file.
Here is a list of the properties supported for Java:

RootDir
DataDir
ScriptDir



LogDir
OutputDir
CodeGenerator
CodegenOptions
MaxCodegenInput
SourceExtension
Compiler
CompilerOptions
OutputExtension
Classpath
MaxCompilerInput
OdfDir
BinDir
MiscDir
Archiver
ArchiverOptions
ArchiverOutputExtension
WsGen
WsdlOutDir
WsImport
WsdlFile
DestDir
BuildDir
WsArchive
WsArchiveExtn
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